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Notice
While reasonable efforts were made to ensure that the information in this 
document was complete and accurate at the time of printing, Avaya Inc. 
can assume no liability for any errors. Changes and corrections to the 
information in this document may be incorporated in future releases.

Preventing toll fraud
"Toll fraud" is the unauthorized use of your telecommunications system 
by an unauthorized party (for example, anyone who is not a corporate 
employee, agent, subcontractor, or person working on your company's 
behalf). Be aware that there may be a risk of toll fraud associated with 
your system and that, if toll fraud occurs, it can result in substantial 
additional charges for your telecommunications services.

Avaya fraud intervention
If you suspect that you are being victimized by toll fraud and you need 
technical assistance or support, call Technical Service Center Toll Fraud 
Intervention Hotline at +1-800-643-2353 for the United States and 
Canada. For additional support telephone numbers, see the Avaya Web 
site:
http://www.avaya.com 
Select Support, then select Escalation Lists. This Web site includes 
telephone numbers for escalation within the United States. For escalation 
telephone numbers outside the United States, select Global Escalation 
List.

Providing telecommunications security
Telecommunications security (of voice, data, and video communications) 
is the prevention of any type of intrusion to (that is, either unauthorized or 
malicious access to or use of) your company's telecommunications 
equipment by some party.
Your company's "telecommunications equipment" includes both this 
Avaya product and any other voice/data/video equipment that could be 
accessed via this Avaya product (that is, "networked equipment").
An "outside party" is anyone who is not a corporate employee, agent, 
subcontractor, or person working on your company's behalf. Whereas, a 
"malicious party" is anyone (including someone who may be otherwise 
authorized) who accesses your telecommunications equipment with 
either malicious or mischievous intent.
Such intrusions may be either to/through synchronous (time-multiplexed 
and/or circuit-based) or asynchronous (character-, message-, or 
packet-based) equipment or interfaces for reasons of:

� Use (of capabilities special to the accessed equipment)
� Theft (such as, of intellectual property, financial assets, or 

toll-facility access)
� Eavesdropping (privacy invasions to humans)
� Mischief (troubling, but apparently innocuous, tampering)
� Harm (such as harmful tampering, data loss or alteration, 

regardless of motive or intent)
Be aware that there may be a risk of unauthorized intrusions associated 
with your system and/or its networked equipment. Also realize that, if 
such an intrusion should occur, it could result in a variety of losses to your 
company (including, but not limited to, human and data privacy, 
intellectual property, material assets, financial resources, labor costs, and 
legal costs).

Your responsibility for your company's telecommunications 
security
The final responsibility for securing both this system and its networked 
equipment rests with you, an Avaya customer's system administrator, 
your telecommunications peers, and your managers. Base the fulfillment 
of your responsibility on acquired knowledge and resources from a 
variety of sources, including, but not limited to:

� Installation documents
� System administration documents
� Security documents
� Hardware-/software-based security tools
� Shared information between you and your peers
� Telecommunications security experts

To prevent intrusions to your telecommunications equipment, you and 
your peers should carefully program and configure:

� Your Avaya-provided telecommunications systems and their 
interfaces

� Your Avaya-provided software applications, as well as their 
underlying hardware/software platforms and interfaces

� Any other equipment networked to your Avaya products.

Warranty
Avaya Inc. provides a limited warranty on this product. Refer to your 
sales agreement to establish the terms of the limited warranty. In 
addition, Avaya�s standard warranty language, as well as information 
regarding support for this product, while under warranty, is available 
through the following Web site:
http://www.avaya.com/support 

Link disclaimer
Avaya Inc. is not responsible for the contents or reliability of any linked 
Web sites and does not necessarily endorse the products, services, or 
information described or offered within them. We cannot guarantee that 
these links will work all of the time and we have no control over the 
availability of the linked pages.

Trademarks
Avaya is a trademark of Avaya Inc.
All trademarks identified by the ® or � are registered trademarks or 
trademarks, respectively, of Avaya Inc. All other trademarks are the 
property of their respective owners.

Ordering information: Avaya Publications Center
Voice: +1-207-866-6701

1-800-457-1764 (Toll-free, U.S. and Canada only)

Fax: +1-207-626-7269
1-800-457-1764 (Toll-free, U.S. and Canada only)

Write: Globalware Solutions
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Haverhill, MA 01835 USA
Attention: Avaya Account Manager

Web: http://www.avayadocs.com 
E-mail: totalware@gwsmail.com 
Order: Document No. 585-248-120, Issue 1.0

August 2003

Avaya Training
Avaya provides training for Avaya Operational Analyst. For more 
information, contact Avaya University at:

Web site: http://www.avaya-learning.com/logon_form.asp 
E-mail address: avaya.u.helpdesk@accenture.com 
US telephone: 1-800-288-5327
Outside US telephone: +1-303-406-6089

Avaya support
Avaya provides a telephone number for you to use to report problems or 
to ask questions about your contact center. The support telephone 
number is 1-800-242-2121 in the United States. For additional support 
telephone numbers, see the Avaya Web site:
http://www.avaya.com 
Select Support, then select Escalation Lists. This Web site includes 
telephone numbers for escalation within the United States. For escalation 
telephone numbers outside the United States, select Global Escalation 
List.

Comments
To comment on this document, send e-mail to crminfodev@avaya.com.
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Preface

Avaya Operational Analyst Release 6.1 Maintenance and Troubleshooting describes the 
maintenance and troubleshooting procedures for Avaya Operational Analyst (OA).

This section includes the following:

● Product description on page 9

● Intended users on page 10

● Reasons for reissue on page 10

● Organization on page 10

● Related information on page 11

Product description
Avaya OA allows businesses to perform operational reporting for a multimedia contact 
center, smoothly growing from single channel analysis, to full interaction, multi-channel 
analysis with a common data model and common user interfaces across the contact center 
systems.

Avaya OA is a required component of Avaya Interaction Center (Avaya IC), functioning as 
its operational data store and contact center performance analysis system. Avaya OA 
replaces and significantly upgrades the reporting capabilities of previous Avaya IC 
products. 

Avaya OA is also an optional add-on to Avaya Call Management System (CMS) for 
extended, online historical data storage and multi-site analysis, receiving External Call 
History (ECH) data and historical interval data from up to 30 CMS servers and up to 240 
ACDs.
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Intended users
This information is intended for customer administrators and IT personnel.

Reasons for reissue
This is the first issue of this information. When this information is reissued, the reasons for 
reissue will be listed here.

Organization
This document includes the following information:

● Maintaining the historical database on page 13 describes how to maintain the historical 
database.

● Troubleshooting overview on page 29 describes how to begin your troubleshooting.

● Troubleshooting tools on page 37 describes tools used to troubleshoot OA.

● Troubleshooting OA components on page 65 describes troubleshooting related to the 
OA components.

● Troubleshooting the Administration client on page 121 describes troubleshooting related 
to the Administration client.

● Troubleshooting basic reports and the report server on page 165 describes 
troubleshooting related to the basic reports and the report server.

● Glossary on page 261.
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Related information
The following table lists all of the Avaya OA information, both documents and online help 
systems:

The following table lists Avaya IC information that may be helpful:

Title Number Compas 
ID

Avaya Operational Analyst Release 6.1 What�s New in Operational 
Analyst R6.1

585-248-401 96547

Avaya Operational Analyst Release 6.1 Installation Planning and 
Prerequisites

585-248-118 96430

Avaya Operational Analyst Release 6.1 Installation and Configuration 585-248-119 96431

Avaya Operational Analyst Release 6.1 Maintenance and 
Troubleshooting

585-248-120 96432

Avaya Operational Analyst Release 6.1 Reports Reference 585-248-506 96546

Avaya Operational Analyst Release 6.1 Administration Client Online 
Help

See Administration client 
help or library CD-ROM

Avaya Operational Analyst Release 6.1 Basic Reports Online Help See Report client help

Data Model Help See product CD-ROM

Security Guide See product CD-ROM

Title Number Compas 
ID

Avaya Interaction Center Release 6.1 Installation Planning and 
Prerequisites

585-248-001 96781

Avaya Interaction Center Release 6.1 Installation and Configuration 585-248-102 96791

Avaya Interaction Center Release 6.1 Business Advocate 
Configuration and Administration

585-248-501 96821
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The release_notes.pdf file contains the latest notes about installation of OA 
components. It is recommended that you read these notes before installation. 

After installation, you can view the release notes at:

● %PABASE%\doc\release_notes.pdf (Windows)

● $PABASE/doc/release_notes.pdf (Solaris and AIX)

The default installation directories that represent %PABASE% and $PABASE are:

● c:\Program Files\Avaya\BI (Windows)

● /export/home/biadmin/BI (Solaris)

● /home/biadmin/BI (AIX)

The database operations explained in this document require the services of either a 
qualified database administrator or a systems integrator who possesses in-depth 
knowledge of database fundamentals and of the operating system. Some suggested 
reference materials include:

● For Oracle databases:

- Oracle8i 8.1.7 Installation Guide for Windows

- Oracle8i 8.1.7 Client Installation Guide for Windows

- Oracle8i Administrator's Reference Release 3 (8.1.7) for Sun SPARC Solaris

- Oracle8i Installation Guide Release 3 (8.1.7) for Sun SPARC Solaris

- Oracle9i Database Installation Guide (Windows)

- Oracle9i Client Installation Guide Release 2 (9.2.0.1.0) for Windows

- Oracle9i Installation Guide Release 2 for UNIX Systems

- Oracle9i Administrator's Reference for UNIX Systems

● For Microsoft SQL databases:

- Microsoft SQL Server 2000 Books Online

- Microsoft database documentation

● For DB2 databases, the DB2 documentation, which is available online after you install 
the database software.

● For TimesTen databases, the TimesTen documentation, which is available online after 
you install the Real-time subsystem. The documentation is copied to the following 
location:

- C:\TimesTen\TimesTen4.5\32\Doc (Windows)

- $PABASE/TimesTen4.5/doc (Solaris and AIX)

For detailed information about how to install operating system software, refer to the 
documentation that accompanies the operating system software. 
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Maintaining the historical database

To keep OA running smoothly, follow the procedures in this section to maintain the 
historical database.

This section includes the following topics:

● Backing up the historical database on page 14

● Changing the user or system administration password on page 25

● Other maintenance procedures on page 26

! Important:! Important:
Important: The database operations used with Avaya OA require the services of either 

a qualified database administrator or a systems integrator who possesses 
an in-depth knowledge of database fundamentals on the installed operating 
system. It should not be done by personnel that are not familiar with the 
database software.
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Backing up the historical database
Avaya recommends that you back up the historical database on a regular basis. This 
section describes the requirements for database backup, both in general terms for backup 
requirements and in specific terms for the different database software packages. 

This section includes the following topics:

● General backup requirements on page 14

● Backup requirements specific to Microsoft SQL on page 16

● Backup requirements specific to Oracle on page 17

● Backup requirements specific to DB2 on page 23

General backup requirements
This section describes general requirements for database backup, regardless of the 
database software being used.

This section includes the following topics:

● Responsibilities of the database administrator on page 14

● Types of backups on page 14

● Frequency of backups on page 15

● Recommended backup strategies on page 15

Responsibilities of the database administrator

A trained database administrator or other qualified person should be available to 
customize and perform all of your backup operations. This includes management of tape 
backups, so that the tapes for both historical and system data are backed up and labeled 
correctly.

Types of backups

Part of your backup strategy should be defining the type of backup to be done, either full or 
incremental. A full backup captures a snapshot of a database at a point in time. It provides 
a copy of the entire data structure from which the database could be restored in the event 
the database is lost or corrupted.

An incremental backup captures only the changes that have occurred in the data since the 
last backup, either full or incremental. To restore from incremental backups requires a full 
backup and all prior incremental backups since the last full backup.
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Since a full backup captures the entire data structure, it takes considerably more time to 
complete than an incremental backup, especially on large databases. Therefore, your 
backup strategy should include both types of backup.

Frequency of backups

You should back up your OA historical database on a regular basis. Avaya recommends at 
a minimum that you do a full backup once a week and an incremental backup every day. 
Do not schedule your full backup or incremental backup to run while system-scheduled 
jobs (such as Purge or Aggregation recovery) are running. You should do the backups 
during non-business hours. If your business runs 24-by-7, schedule your backups to run 
during low traffic periods.

Recommended backup strategies

Depending on the amount of database activity your installation requires, select one of a 
variety of backup strategies. The following table summarizes these strategies:

You should analyze your particular business situation and design an appropriate backup 
strategy that affords your data the greatest protection from loss. A minimum strategy 
requires weekly full backup of OA databases and hourly transaction log or archive log 
backup.

Database activity Type and frequency of backup

Small ● Full backup of OA databases daily
● Transaction log backups every 30 minutes for SQL and DB2
● Archive log backups every 30 minutes for Oracle

Medium ● Full backup of OA databases weekly
● Incremental backups of OA databases daily
● Transaction log backups every 30 minutes for SQL and DB2
● Archive log backups every 30 minutes for Oracle

Large ● Full backups of OA databases weekly
● Incremental backups of OA databases daily
● Transaction log backups every 30 minutes for SQL and DB2
● Archive log backups every hour for Oracle
or
● Backup of detailed data first night
● Backup of other filegroups second night
● Incremental backups of all data the rest of the week
● Transaction log backups every 30 minutes for SQL and DB2
● Archive log backups every 30 minutes for Oracle
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Backup requirements specific to Microsoft SQL
This section lists the backup requirements that are specific to Microsoft SQL databases.

This section includes the following topics:

● Checking the integrity of the SQL Server database on page 16

● DBCheck on page 16

● Periodic maintenance on page 16

● Restoring the SQL Server database on page 17

● Related documents on page 17

Checking the integrity of the SQL Server database

Use the Query Analyzer tool to execute the DBCC command SQL Server database server 
to check the consistency of the database and database objects. If you need to correct or 
repair errors you must put the database into single user mode. 

Refer to SQL Server Books Online for more information on using the DBCC command.

DBCheck 

DBCheck is an audit process that runs once a day. DBCheck can be called by other 
components or run independently. It logs all of its actions into an activity log (%PABASE%\
data\log\dbcheck\dbchecktrc.log). You can set the start time for DBCheck using 
the Administration client. The default time to run is after the system backup.

DBCheck performs the following actions:

1. Establishes database connection as the owner of the OA database.

2. Calls MetadataSanityRun to check the inconsistent metadata.

3. Scans the SQL Server Logs for noteworthy events.

The DBCheck command does not initiate alarms and runs as userid administrator.

Periodic maintenance 

Some periodic maintenance tasks are run by DBCheck nightly. You should perform the 
others as instructed below.

● Look at the Event Log and SQL Server Logs to see if any errors have been detected by 
DBCheck or SQL Server.

● In general, the indexes on the OA historical table should be rebuilt after you delete more 
than 30% of the records in the table. If you do so, you should watch the growth of the 
Tempdb database.
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● Maintain a clean transaction log destination for optimum OA operation. If the transaction 
log destination becomes full, SQL Server issues a warning and the database hangs until 
you free up some space in the destination log location. View SQL Server Books Online 
for details about transaction log maintenance.

● Back up the transaction logs to tape every 30 minutes. Then clean the destination so it 
can receive more transaction log files. You may use SQL Server Enterprise Manager 
Backup or write your own scripts to accomplish this task. 

● Monitor the OA historical filegroup on a weekly basis. As the historical database tables 
grow, you must add more datafiles to a filegroup whenever they have less than 20% free 
space or the amount of space needed for the next week of data.

Restoring the SQL Server database

Please refer to SQL Server Books Online, Administering SQL Server, for more detailed 
information on restoring your database.

Related documents

Consult the SQL Server Books Online, Administering SQL Server, when doing SQL 
backups.

Backup requirements specific to Oracle
This section lists the backup requirements that are specific to Oracle databases.

This section includes the following topics:

● Required software configurations when using pabackup (optional Avaya utility) on 
page 17

● Backup using pabackup (optional Avaya utility) on page 18

● Recovering the Oracle database when using pabackup (optional Avaya utility) on 
page 19

● Location of files on page 21

● DBCheck on page 21

● Periodic maintenance on page 22

● Related documents on page 23

Required software configurations when using pabackup (optional Avaya utility)

During software installation, database setup must initialize the historical database 
parameter files with the parameters that the backup strategy needs if it is to operate. 
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To use the OA backup utility, you must do the following: 

1. Install and configure Oracle Enterprise Edition on the OA historical server.

2. Put the historical database in ARCHIVELOG mode.

3. Set the Oracle Recovery Manager (RMAN) environment variables. The environment 
variables are:

NLS_LANG = AMERICAN_AMERICA.UTF8

NLS_DATE_FORMAT = ‘Mon DD YYYY HH24:MI:SS’

Note:
Note: The NLS_LANG variable shown here is the default. For other languages see 

the Oracle documentation. The national character set should always be 
UTF-8.

Backup using pabackup (optional Avaya utility)

In most cases, the standard Oracle backup commands should be used when backing up 
the historical database. As an option, Avaya has developed a script called pabackup that 
will back up the Oracle databases. This section describes the steps for doing a full and 
incremental backup of the OA Oracle historical database using pabackup.

To back up an Oracle database using pabackup:

1. Bring up LSM and insure a tape drive has been configured and a tape has been 
labeled. Use the following commands:

● For Windows, select Start > Programs > NetWorkerGroup > NetWorker 
Administrator

● For Solaris, enter:

nwadmin

2. Change to the directory containing the backup scripts:

● For Windows, %PABASE%\data\admin\backup

● For Solaris, cd $PABASE/data/admin/backup

3. Execute one of the following backup commands:

● pabackup -f reg for a full backup 

● pabackup -i reg for an incremental backup

Note:
Note: An incremental backup can be done only if a full backup has already been 

done at least one time. 
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4. Monitor the backup with the LSM by selecting the Monitor tab for the server that is 
performing the backup. 

The Messages window indicates what is being backed up and when the backup is 
finished. A backup of the database can take several hours, depending on the amount 
of data to back up and the type of tape device to which the backup is being made. 

5. Check the backup log file. 

If a backup seems to fail, or seems to be taking too long, the status of the backup, from 
Oracle's point of view, can be seen in the log file. The backup log file can be found at:

● %PABASE%\data\log\backup (Windows)

● $PABASE/data/log/backup (Solaris)

For a full backup, the Oracle log file is backup_db_level_0.log. For an 
incremental backup, the Oracle log file is backup_db_level_1.log. 

6. Validate the backup using the Oracle tool RMAN. 

After the database has been backed up, all archive log files are automatically deleted. A 
copy of the database control file is kept at:

● %PABASE%\data\admin\backup\sys\BACKUP_CF.BK (Windows)

● $PABASE/data/admin/backup/sys/BACKUP_CF.BK (Solaris)

This file should be saved to a permanent place if a point-in-time restore of the database is 
required in the future. 

Recovering the Oracle database when using pabackup (optional Avaya utility)

If you use the pabackup script to back up the historical database, the instructions in this 
section will help you recover the database if it fails. If you use standard Oracle tools to 
create database backups, refer to the Oracle Backup and Recovery Guide to recover the 
database. 

Note:
Note: To recover to a point that is earlier than the latest full backup, you must have 

a copy of the Oracle database control file earlier than the full backup.

To recover the historical database to a point just before the failure, refer to the Oracle 
RMAN sample script restore_db_cp.rcv in %PABASE%\data\admin\backup 
(Windows) or $PABASE/data/admin/backup (Solaris). Be sure you also have all the 
incremental backups until the failure point and the redo log files generated after the latest 
incremental backup. 

For other kinds of Oracle recoveries (for example, system tablespace recovery or open 
database recovery), refer to the Oracle Backup and Recovery Guide.

To restore the Oracle historical database. 

1. Bring up the LSM and insure that the tape that contains the backup of the database to 
be restored is mounted.
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● For Windows, select Start > Programs > NetWorkerGroup > NetWorker 
Administrator.

● For Solaris, enter:

nwadmin

2. Change to the directory containing the backup scripts:

● For Windows, %PABASE%\data\admin\backup

● For Solaris, cd $PABASE/data/admin/backup

3. Open a command window and run: 

● For Windows:

set NLS_LANG=NLS_LANGUAGE_NLS_TERRITORY.NLS_CHARACTERSET

● For Solaris:

export NLS_LANG=NLS_LANGUAGE_NLS_TERRITORY.NLS_CHARACTERSET

For example, AMERICAN_AMERICA.UTF8 is the correct value for NLS_LANG in the 
English version of OA.

4. If the Oracle control file is available, run the following commands in the command 
window: 

● For Windows:

rman target sys/sys password nocatalog cmdfile

"\"%PABASE%\data\admin\backup\restore_db_cp.rcv"\" log

"\"%PABASE%\data\log\backup\restore_db.log"\"

● For Solaris:

rman target sys/sys password nocatalog cmdfile

"$PABASE/data/admin/backup/restore_db_cp.rcv" log

"$PABASE/data/log/backup/restore_db.log"

5. Monitor the restore with the LSM by selecting the Monitor tab for the server that is 
performing the restore. 

The Messages window indicates when a restore is finished. A restore of the database 
can take several hours, depending on the amount of data to restore and the type of 
tape device from which the restore is being made. 

6. Check the restore log file. 

If a restore seems to fail, or seems to be taking to long, the status of the restore, from 
Oracle's point of view, can be seen in the log file. The restore log file can be found at:

● %PABASE%\data\log\backup (Windows)
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● $PABASE/data/log/backup (Solaris)

For a complete restore, the Oracle log file is restore_db_cp.log. 

Location of files 

The OA backup strategy writes its log files to:

● %PABASE%\data\log\backup (Windows)

● $PABASE/data/log/backup (Solaris)

It writes the backup of the database control file to:

● %PABASE%\data\log\backup\sys (Windows)

● $PABASE/data/log/backup/sys (Solaris)

All of the OA backup strategy RMAN command files are stored in:

● %PABASE%\data\log\backup (Windows)

● $PABASE/data/log/backup (Solaris)

The Backup application for the historical database uses the db.properties file to get 
information on the database server and the database user id.

The Backup application for the historical database uses the historical database to get 
information on the tablespace names. 

DBCheck

DBCheck is an audit process that runs once a day. DBCheck can be called by other 
components or run independently. It logs all of its actions into an activity log located at 
%PABASE%\data\log\dbcheck\dbchecktrc.log (Windows) or $PABASE/data/
log/dbcheck/dbchecktrc.log (Solaris). You can set the start time for DBCheck using 
the Administration client. The default time to run is after the system backup.

DBCheck performs the following actions:

1. Establish database connection as the owner of the OA database.

2. Run Analyze Table on OA database tables.

3. Call MetadataSanityRun to check the inconsistent metadata.

4. Scan the Oracle Alert Log for noteworthy events (only on a database coresident with 
the Historical subsystem).

5. If the Oracle Alert Log is too large, roll it over for backup (only on a database 
coresident with the Historical subsystem).

DBCheck does not initiate alarms. DBCheck runs as the administrator user ID.

DBCheck can be reconfigured for checking database integrity and to gathers statistics for 
the Oracle cost-based optimizer. Currently, the default optimization level is used, but this 
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can be changed by editing %PABASE%\data\admin\dbcheck.tables (Windows) or 
$PABASE/data/admin/dbcheck.tables (Solaris) and changing the percentage.

Periodic maintenance

Some periodic maintenance tasks are run by DBCheck nightly. You should perform the 
others as instructed below.

● Look at the Event Log in Windows or the $PABASE/data/log/CentralError/
CentralErrorLog.log file on Solaris to see if any errors have been detected by 
DBCheck.

● In general, the indexes on the OA historical table should be rebuilt after you delete more 
than 30% of the records in the table. If you do so, you should watch the growth of the 
Oracle TEMP tablespace. If the used space in the TEMP tablespace is greater than 95%, 
extend the TEMP tablespace. For details about extending the TEMP tablespace, refer to 
the Oracle Administrator Guide.

● Monitor the Oracle rollback segment tablespace daily to be sure it has at least 30% free 
space. Purging many records will cause the rollback segment to grow rapidly. For 
example, purging over a million rows from the table can cause a rollback segment to 
reach up to 4 GB.

● Remove inactive Oracle rollback segments so that no more than 20 rollback segments 
exist at any time. Refer to the Oracle Administrator Guide for details about removing 
inactive rollback segments.

● Tune your redo logfiles. OA requires 50MB for each Oracle redo logfile to make sure 
checkpoints occur normally. If the checkpoint interval becomes less than 30 seconds, 
increase the logfile size to 100MB. An Oracle warning that Oracle failed to allocate redo 
logs indicates that heavy database activity requires more redo logs. Add more redo log 
groups to the Oracle database to resolve this problem. Please refer to the Oracle 
Administrator Guide and Oracle Tuning documentation for details on these tasks.

● Maintain a "clean" archive log destination for optimum OA operation. If the archive log 
destination becomes full, Oracle issues a warning and the database will hang until you 
free up some space in the archive log destination. The Oracle Administrator Guide 
contains details about archive log destination maintenance. 

● Back up the archived logs to tape every 30 minutes. Then clean the destination so it can 
receive more archived log files. You may use pabackup or write your own scripts to 
accomplish this task. Refer to the Oracle Backup and Recovery documentation for 
details about writing a backup script.

● Monitor the OA historical tablespace on a weekly basis. As the historical database 
tables grow, you must extend the tablespaces whenever they have less than 20% free 
space or the amount of space needed for the next week of data.
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Related documents

Consult the following documents when doing Oracle backups:

● Oracle Backup and Recovery Guide

● Oracle Database Administrator Guide

● Oracle Administrator Guide

● Oracle Tuning

Backup requirements specific to DB2
This section lists the backup requirements that are specific to DB2 databases.

This section includes the following topics:

● DBCheck on page 23

● Periodic maintenance on page 23

● Related documents on page 24

DBCheck

DBCheck is an audit process that runs once a day. DBCheck can be called by other 
components or run independently. It logs all of its actions into an activity log located at 
$PABASE/data/log/dbcheck/dbchecktrc.log. You can set the start time for 
DBCheck using the Administration client. The default time to run is after the system 
backup.

DBCheck performs the following actions:

1. Establish database connection as the owner of the OA database.

2. Run Update Statistic on OA database tables.

3. Call MetadataSanityRun to check the inconsistent metadata.

DBCheck does not initiate alarms. DBCheck runs as the administrator user ID.

DBCheck can be reconfigured for checking database integrity. Currently, the default 
optimization level is used, but this can be changed by editing $PABASE/data/admin/
dbcheck.tables and changing the percentage.

Periodic maintenance

Some periodic maintenance tasks are run by DBCheck nightly. You should perform the 
others as instructed below.
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● Look at the $PABASE/data/log/CentralError/CentralErrorLog.log file to 
see if any errors have been detected by DBCheck.

● In general, the indexes on the OA historical table should be rebuilt after you delete more 
than 30% of the records in the table. 

● Back up the transaction logs to tape every 30 minutes. Then clean the destination so it 
can receive more archived log files. 

● Monitor the OA historical tablespace on a weekly basis. As the historical database 
tables grow, you must extend the tablespaces whenever they have less than 20% free 
space or the amount of space needed for the next week of data.

Related documents

Consult IBM DB2 Universal Database Administration Guide: Implementation when doing 
DB2 backups:
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Changing the user or system administration 
password

If you want to change the password of the database user or system admin user in the 
historical database, do not modify it in the database directly. Use the OA commands 
ChangeDBPWD or ChangeDBSYSPWD located at %PABASE%\bin for Windows, or 
$PABASE/bin for Solaris and AIX.

Run the following command from a command window to change the password of the 
database user login:

ChangeDBPWD -s (Windows)

ChangeDBPWD.sh -s (Solaris and AIX)

If you want to change the OA database user password, you must know the database 
administrator password.

Run the following command from a command window to change the password of the 
system admin user login.

ChangeDBSYSPWD -s (Windows)

ChangeDBSYSPWD.sh -s (Solaris and AIX)

The command asks you enter in the new password in the historical database and to 
confirm the password. After successfully running this command, you can use the new 
password to connect to the database. 

On SQL Server, you can confirm that you changed the password correctly by logging into 
SQL Server using the Query Analyzer and the new password. 

On Oracle, you can use the sqlplus command to verify your passwords.

On DB2, you must also use the passwd command to change the password at the OS level 
for the database user ID or the system administrator user ID.
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Other maintenance procedures
The following monitoring procedures should be used daily to verify that the system is 
running properly and to verify that the data is being collected and archived as expected.

This section includes the following topics:

● Checking SQL Server log files on page 26

● Container status on page 26

● Scheduled jobs on page 27

● Interface services on page 27

● Event logs on page 27

● Avaya IC alarm monitor on page 27

Checking SQL Server log files
Part of routine maintenance should be checking the SQL Server logs files to make sure 
they are not getting too large.

To check log files:

1. Open Enterprise Manager.
2. Click SQL Server Group.

3. Click local host\instance name.

4. Click Management.
5. Click SQL Server Logs.

Container status
Use the Container Status window of the Administration client to verify that the OA 
historical system is receiving the expected data. Status for aggregated and archived data 
can be viewed from this window. Therefore, this is the window that would be accessed to 
view the status of daily archived data each day, weekly archived data each week, and 
monthly archived data each month. In addition, the status of base interval data can be 
viewed daily as well.
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Scheduled jobs 
Use the Scheduled Jobs window of the Administration client to view the status of jobs. 
These status views can be views of system scheduled jobs, as well as on-demand and 
external jobs that may have been added. These status views can be used to determine if 
particular processes, such as aggregation or purge, have completed successfully.

If aggregation fails, go to Container Status and determine which job failed. If the job is 
recoverable, aggregation recovery may have already cleaned up the job, so you may not 
see any failed jobs in the Container Status.

Interface services
The Interface Services window of the Administration client can be used to view the status 
of OA services such as Data manager, Forwarder, Recorder, Forwarder-Recorder, Report 
data server, and the Report subsystem. This window indicates whether a process is 
currently enabled or not. If data is missing, then possibly the associated service has 
become disabled and needs to be enabled again. These services can be enabled from the 
Interface Services window as well.

Refer to the Administration client online help for more detailed information on monitoring 
and maintaining the system through these windows. From the Administration client, select 
Help > Screen Help.

Event logs
Monitor the Application Event Log on Windows and the $PABASE/data/log/
CentralError/CentralErrorLog.log file on Solaris and AIX every day in order to 
keep informed of error conditions that may have occurred. 

Avaya IC alarm monitor
Critical alarm conditions can be monitored and detected with the Avaya IC Alarm Monitor. 
See Alarm messages on page 70 for further information.
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Troubleshooting overview

This section presents a suggested map for troubleshooting an OA system and information 
about how Avaya Customer Support can assist your troubleshooting efforts remotely. 

Follow the troubleshooting map to help narrow the point of difficulty from broad, 
system-related areas to more specific targets like individual processes. The map contains 
references to other sections of the Troubleshooting Guide for more detailed information. 

This section includes the following topics:

● Path definitions on page 30

● Troubleshooting map on page 33

● Remote access on page 35
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Path definitions
It is important to understand the path definitions for the different operating systems:

● Windows path definitions on page 30

● Solaris path definitions on page 30

● AIX path definitions on page 31

Windows path definitions
The following variable is used in this document to represent the installation path for most 
OA software on Windows:

%PABASE%

For example, the location for a file in that path is shown as follows:

%PABASE%\stumbras\tomcat\work\localhost_8080

The following is the default installation path OA uses on a Windows server:

c:\Program Files\Avaya\BI

Note:
Note: When installing OA, the BI portion of the path is not displayed when the 

default path is shown in the Destination dialog box. This is added as part of 
the installation.

The following variable is used in this document to represent the installation path for EC 
Server and EC Bridge software on Windows:

%AVAYA_IC61_HOME%\bin

Solaris path definitions
The following variable is used in this document to represent the installation path for most 
OA software on Solaris:

$PABASE

For example, the location for a directory in that path is shown as follows:

$PABASE/data/log
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Depending on how the OS was installed and how the filesystems were created, the 
following is the default installation path OA uses on a Solaris server:

/export/home/biadmin/BI

Note:
Note: When installing OA, the BI portion of the path is not displayed when the 

default path is shown in the Destination dialog box. This is added as part of 
the installation.

The following variables are used in this document to represent the installation path for the 
Sun ONE Web Server software on Solaris:

$SUN_ONE_HOME

The following variables are used in this document to represent the installation path for EC 
Server software and libraries on Solaris:

$AVAYA_IC61_HOME/bin

$AVAYA_IC61_HOME/lib

AIX path definitions
The following variable is used in this document to represent the installation path for most 
OA software on AIX:

$PABASE

For example, the location for a directory in that path is shown as follows:

$PABASE/data/log

Depending on how the OS was installed and how the filesystems were created, the 
following is the default installation path OA uses on an AIX server:

/home/biadmin/BI

Note:
Note: When installing OA, the BI portion of the path is not displayed when the 

default path is shown in the Destination dialog box. This is added as part of 
the installation.

The following variables are used in this document to represent the installation path for the 
WebSphere software on AIX:

$WEBSPHERE_HOME
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The following variables are used in this document to represent the installation path for EC 
Server software and libraries on AIX:

$AVAYA_IC61_HOME/bin

$AVAYA_IC61_HOME/lib
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Troubleshooting map
To begin troubleshooting a problem with OA:

1. Log in using the appropriate user ID and password (see Creating users and setting OS 
parameters on page 105 in Avaya Operational Analyst Release 6.1 Installation 
Planning and Prerequisites).

2. Check the Event Log (Windows) or $PABASE/data/log/CentralError/
CentralErrorLog.log file (Solaris and AIX) for messages that indicate particular 
problems. See Error messages on page 94 for details about locating and reading the 
logs.

3. Verify Avaya Business Intelligence Service and ORBacus Naming Service are 
running.

● On Windows: Start > Programs > Administrative Tools > Services.

If the services are not running, start them. If they do not start, use the Event Viewer 
to debug the system.

● On Solaris or AIX: From the command line enter:

ps -ef | grep initsrv

ps -ef | grep nameserv

If the services are not running, log in as root (su - root) and check the /etc/
inittab settings and verify initsrv and nameserv are set to respawn. Write the 
file and enter init q to restart the services. When finished, log out of root.

If the services do not start, use the trace files to debug the system. See Trace 
files on page 67 for more information.

4. Once Avaya Business Intelligence Service and ORBacus Naming Service are 
running, verify Master Operations Manager (MOM) is running. From the command line, 
enter:

. /opt/BI/.profile (Solaris and AIX only)

pa list

5. If a list of processes is displayed, MOM is running. If the message mom is not
active is displayed, enter pa start all.

See Avaya OA processes on page 41 for more information about MOM.

6. When MOM is running, verify other OA processes and services are running.

● Enter the following commands to see which OA components have been installed:

oalist

● Verify the base OA services are running via the pa or amui command: 
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- admb, adm0, ams, and schd for all servers.

- aut for the historical server. 

Note:
Note: The ams process will not be listed when the amui command is used. If 

amui runs successfully, then the ams process is running.

● Verify other processes are running based on values in the server.properties 
file. For example, the dm and dsvr processes should be running if the real-time 
system is installed. Use the pa command to enable a process if it is not running. 
See Avaya OA processes on page 41 for more information on processes and the pa 
command.

● Verify that any previously administered forwarders, recorders, or 
forwarder-recorders are running (and which server they are running on) using the 
Interface Services screen of the Administration client. If not running, enable the 
services through this same screen. Refer to the Administration Client Help for more 
information about using the Interface Services screen.

● If a process does not start, check the Windows Event Log or Solaris and AIX 
$PABASE/data/log/CentralError/CentralErrorLog.log for messages 
indicating particular problems. You may need to view the trace files to locate the 
problem. See Trace files on page 67 for more information.

7. Check log files at the following locations:

%PABASE%\data\admin\logs\reports (Windows)

$PABASE/data/admin/logs/reports (Solaris and AIX)

8. For the Administration client and Report client, check the Java console for any 
messages that may have been logged. To open the Java console, double-click the 
Java console icon in the system tray.

9. If you cannot find a process that you think should be running, verify the administration 
of the system through the Administration client Subsystems and Interface Services 
screens. Refer to the Administration Client Help for more information about using the 
Administration client Subsystems and Interface Services screens.

10. See the Avaya support site for possible solutions to common problems.

http://support.avaya.com/qq/ 

http://support.avaya.com/qq/
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Remote access
Avaya customer support representatives can access your OA system remotely to assist 
with troubleshooting if you are running on Windows. To enable this service, you must install 
pcAnywhere software, version 10.5 or later, on the systems requiring remote access.

To install pcAnywhere:

1. Install a standard modem and its associated driver. Verify the modem is accessible to 
the system via the Control Panel. Set the modem parameters according to this table:

Refer to the modem documentation for details on configuring these parameters.

2. Install pcAnywhere using the pcAnywhere documentation for installation instructions.

Modem parameter Value

Data Terminal Ready On

Carrier Detect On

Auto Answer On

Display Result Codes Off



Troubleshooting overview

36 Avaya Operational Analyst R6.1 Maintenance and Troubleshooting



Issue 1.0 August 2003 37

Troubleshooting tools

This section describes the various tools you have available to you while troubleshooting 
problems with OA components.

This section includes the following topics:

● Using the oalist command on page 38

● Starting and stopping OA-related processes on page 39

● Data collection status for forwarders and recorders on page 53

● Monitoring the TimesTen database on page 56

● Event collector troubleshooting tools on page 59

● Event Collector Bridge troubleshooting tools on page 61

● Viewing load level on a host on page 62

● Diagnosing the Historical Delivery System files on page 62

● Other troubleshooting commands on page 63

! Important:! Important:
Important: The commands described in this section should be executed using the OA 

user ID created in Creating users and setting OS parameters on page 105 in 
Avaya Operational Analyst Release 6.1 Installation Planning and 
Prerequisites.
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Using the oalist command
The oalist command displays the components, server names, and user IDs currently 
installed on an OA server.

To use the oalist command:

1. Enter the following commands:

. /opt/BI/.profile (Solaris and AIX only)

oalist

A message similar to the following is displayed:

Subsystems installed
Historical
Real Time
Reports
Data Export Utility

Server Names
Historical: pez
Historical Database: pez

Database information
Type: DB2
UserID: biadmin
Instance Name: db2inst1
OA DB Name: oadb
OA DB Schema Name: oaschema
IC UserID: icuser
IC Repository DB Name: icschema
CMS Historical Tables created
IC Historical Tables created
DB2 Path: /home/db2inst1
DB2 Library Path: /home/db2inst1/sqllib

User information
OA User ID: biadmin
Group ID: oaadmin

Reports information
WebSphere Root: /usr/WebSphere/AppServer
HTTP Root: /usr/IBMHttpServer
WebSphere Application Server: server1
WebSphere Admin Console User: biadmin

Admin Client Locale

OA Software information
Version Installed: 6.1.0.58
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Starting and stopping OA-related processes
Under most circumstances, OA processes running on the historical and real-time servers 
are controlled behind the scenes or from the Administration client. When troubleshooting, it 
may be necessary to start and stop these processes directly. Avaya OA provides tools that 
allow access to these processes. 

This section includes the following topics:

● Overview on page 39

● Avaya OA processes on page 41

● Listing managed processes on page 44

● Using the pa command on page 44

● Process state definitions on page 47

● Forwarders and recorders on page 48

● Other OA services and processes on page 49

Overview
The Master Operations Manager (MOM), shown below, is the behind-the-scenes controller 
of OA processes. On Windows, the MOM is started by the OA Service, under the control of 
the Service Control Manager (see the Services icon in the Computer Management menu 
under Start > Programs > Administrative Tools > Services menu). On Solaris and AIX, 
the MOM is started during system boot up via the /etc/inittab file. The OA Service is 
always running and does not need to be stopped or restarted. 

A user may start and stop processes using either the Administration client or the pa utility. 
Both of these provide access to the MOM, which performs the actual work. The 
configuration of processes varies depending on your system configuration. The diagram 
below shows the OA startup and shutdown interaction. 

The MOM receives input from an Administration client graphical user interface or from the 
command pa. From the Administration client Interface Services window, you can elect to 
disable or enable the forwarder, data manager, and data server processes on an OA 
server that has the Real-time subsystem, the recorder on an OA server that has the 
Historical subsystem, and the forwarder-recorder on a server that has both the Historical 
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and Real-time subsystems). Using the pa command, you can elect to enable or disable 
these and other OA processes, or stop and start all OA processes.

The MOM maintains a list of all processes under MOM control. Upon stopping and 
re-starting the OA service (as during a reboot), the MOM remembers which processes 
where disabled and does not restart those processes.
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Avaya OA processes
This table shows the processes controlled by the MOM and the respective servers on 
which they run.

Process MOM process ID OA server

Historical Real-time Report CMS

admin mgr admb x x x x

adm0 x x x x

application 
management 
server

ams x x x x

central report 
data server

crds x

data 
manager

dm x

data server dsvr x
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forwarder fwdagent x

fwdagentcomp x

fwdagentjob x

fwdagentstate x

fwdcmscallhistory x

fwdcmssynonyms x

fwdcmsagent x

fwdcmscwc x

fwdcmsskill x

fwdcmsvdn x

fwddisplaynames x

fwdjob x

fwdserviceclass x

fwdservicestate x

fwdsyscomp x

MOM N/A x x x x

Process MOM process ID OA server

Historical Real-time Report CMS
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Note:
Note: MOM processes have process ID numbers as do other processes (see the 

pa list command described in Using the pa command on page 44). 
However, they are not used by MOM. MOM uses words such as admb. 

recorder recagent x

recagentcomp x

recagentjob x

recagentstate x

reccmsagent x

reccmscallhistory x

reccmscwc x

reccmsskill x

reccmssynonyms x

reccmsvdn x

recdisplaynames x

recjob x

recserviceclass x

recservicestate x

recsyscomp x

scheduler schd x

security aut x

Process MOM process ID OA server

Historical Real-time Report CMS
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Listing managed processes
To list the managed CORBA processes, use the following command:

amui [host hostname] list

This displays the list of managed processes running on the server hostname, or on the 
local server if hostname is not specified. These process names can be used to change 
the tracing level.

Using the pa command
This section describes how to use the pa command.

! CAUTION:
CAUTION: Do not use the pa command logged in as root. If you use the pa command 

logged in as root, permissions for some commands may be changed and 
will not operate properly.

! Important:! Important:
Important: If you try to use a pa command on Solaris or AIX and you get the message 

libOB.so.4.0.5 library not found, it means that you are using the 
command with a user ID that is not assigned to the primary group ID. 
Reassign the user ID to the primary group ID.

Command line options - The pa command allows the enabling, starting, and stopping of 
OA processes. This interface allows a user with the proper permissions to shut down all 
processes at once or start all OA processes. Options used with pa are described below. 
Once executed, all commands indicate whether or not they executed successfully.

Note:
Note: The process IDs are the MOM process IDs listed in the table in Avaya OA 

processes on page 41. They are not the operating system process IDs. 

pa active processId

Determines if a process is currently running. 

pa cat

Displays the MOM list of processes and their characteristics as contained in the 
momtab file. The output of the command for a historical server on Windows is 
shown below:



Starting and stopping OA-related processes

Issue 1.0 August 2003 45

This file should not normally be edited. If it is edited, the only option that should be 
changed is the debug level (the -v option, which can be set to 10, 20, or 30). 

pa disable processId

Disables a process.

pa enable processId

Enables a process. 

pa list

Displays the list of processes activated by the MOM and their current state. The 
output shown below is for a server that has the Historical subsystem. In this 
example:

● The date column indicates when an individual process was started.

● The fourth column displays when the status of the file was last changed. A period 
(.) means that the status of the file changed in the last 60 seconds. A time stamp 
is displayed when the status of the file was changed from 60 seconds to 24 hours 
ago. The word old is displayed if the status of the file changed more than 24 
hours ago.

● The second to the last column shows its process ID as tracked by the operating 
system.

id:4:initdefault:
admb:234:respawn:{}java -Xrs
com.avaya.cc.cvx.adminmgr.AdminMgrSrv.AdminMgrSrvBaseServer -v 30
adm0:234:respawn:{}java -Xrs com.avaya.cc.cvx.adminmgr.AdminMgrSrv.AdminMgrSrvServer
-i 0 -v 30
ams:1234:respawn:{}java -Xrs com.avaya.cc.cvx.appmanserver.AppManServer -v 10
aut:234:respawn:{umask=07}java -Xrs com.avaya.cc.cvx.autserver.main -v 10
schd:34:respawn:{}java -Xrs com.avaya.cc.cvx.scheduler.Scheduler -v 30
reccmscallhistory:34:respawn:{}$PABASE/bin/recorder -n cmscallhistory -v 10
reccmssynonyms:34:respawn:{}$PABASE/bin/recorder -n cmssynonyms -v 10
reccmsagent:34:respawn:{}$PABASE/bin/recorder -n cmsagent -v 10
reccmsskill:34:respawn:{}$PABASE/bin/recorder -n cmsskill -v 10
reccmsvdn:34:respawn:{}$PABASE/bin/recorder -n cmsvdn -v 10
reccmscwc:34:respawn:{}$PABASE/bin/recorder -n cmscwc -v 10
recworkitem:34:off:{}$PABASE/bin/recorder -n workitem -v 10
recdisplaynames:34:respawn:{}$PABASE/bin/recorder -n displaynames -v 10
recagentstate:34:respawn:{}$PABASE/bin/recorder -n agentstate -v 10
recagent:34:respawn:{}$PABASE/bin/recorder -n agent -v 10
recservicestate:34:respawn:{}$PABASE/bin/recorder -n servicestate -v 10
recserviceclass:34:respawn:{}$PABASE/bin/recorder -n serviceclass -v 10
recprocess:34:off:{}$PABASE/bin/recorder -n process -v 10
recivrport:34:off:{}$PABASE/bin/recorder -n ivrport -v 10
recagentcomp:34:respawn:{}$PABASE/bin/recorder -n agentcomp -v 10
recagentjob:34:respawn:{}$PABASE/bin/recorder -n agentjob -v 10
recjob:34:respawn:{}$PABASE/bin/recorder -n job -v 10
recsyscomp:34:respawn:{}$PABASE/bin/recorder -n syscomp -v 10
<< END OF INITTAB >>



Troubleshooting tools

46 Avaya Operational Analyst R6.1 Maintenance and Troubleshooting

● The last column shows its process ID as tracked by the MOM. If the process 
display also includes the words exit or term, the process is not running. Unless 
the process has been stopped intentionally for troubleshooting, use pa start to 
restart the process.

pa off processId

Turns off forwarders or recorders using a process ID name shown in Avaya OA 
processes on page 41.

pa on processId

Turns on forwarders or recorders using a process ID name shown in Avaya OA 
processes on page 41.

pa start all

Starts the MOM and all the processes. 

pa state processId

Displays whether the process is enabled or disabled.

pa stop all

Stops the MOM and all the processes.

. system boot Dec 20 07:54

. run-level 4 Dec 31 10:23 4 0 @
java . Dec 20 07:54 . 292 id=admb
java . Dec 20 07:54 . 52 id=adm0
java . Jan 02 16:16 . 995 id=ams
java . Dec 20 07:54 . 295 id=aut
java . Dec 20 07:54 . 296 id=schd
recorder . Dec 20 08:00 . 551 id=reccmsagent
recorder . Dec 20 08:00 . 405 id=reccmscwc
recorder . Dec 20 08:00 . 607 id=reccmsskill
recorder . Dec 20 08:00 . 406 id=reccmsvdn
recorder . Dec 20 08:00 . 625 id=reccmscallhistory
recorder . Dec 20 08:00 . 434 id=reccmssynonyms
recorder . Dec 31 10:23 . 576 id=recagent
recorder . Dec 31 10:23 . 700 id=recagentcomp
recorder . Dec 31 10:23 . 577 id=recagentjob
recorder . Dec 31 10:23 . 769 id=recagentstate
recorder . Dec 31 10:23 . 655 id=recjob
recorder . Dec 31 10:23 . 780 id=recserviceclass
recorder . Dec 31 10:23 . 686 id=recservicestate
recorder . Dec 31 10:23 . 220 id=recsyscomp
recorder . Dec 31 10:23 . 669 id=recdisplaynames
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Process state definitions
Processes may be enabled or disabled individually and all processes (including MOM 
itself) may be started and stopped together. If the MOM is stopped, processes may not be 
started from the Administration client.

Enable

You may enable any OA process using the pa command line utility. From the 
Administration client Interface Services window, you can elect to enable the recorder, 
forwarder, data manager, and data server. Each request to enable a process is logged if 
tracing is enabled. To enable scheduler, enter the following at a command prompt:

pa enable schd

Disable

You may disable any OA process using the pa command line utility. You can disable the 
recorder, forwarder, data manager, and data server, from the Administration client. Each 
request to disable a process is logged if tracing is enabled. To disable the first 
administration manager on a historical server, enter the following at a command prompt:

pa disable adm1

Start

You may request to start all processes. This also starts the MOM. To start all of the 
processes, enter the following at a command prompt:

pa start all

Stop 

You may request to stop all processes. This also stops the MOM. Therefore, once pa
stop is executed, Administration client requests to enable individual processes will fail. To 
stop all of the processes, enter the following at a command prompt:

pa stop all
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Forwarders and recorders
Forwarders are programs on CMS servers and Real-time servers used to send data to OA 
for collection and processing. Recorders are programs on the historical server to collect 
the data sent from CMS and Real-time servers.

To verify that forwarders or recorders are running, use the pa list command. Compare 
the list of forwarders and recorders displayed with the list shown in Avaya OA 
processes on page 41. You can also use the pa active or pa state commands to see 
if a particular forwarder or recorder is running.

If the forwarders are not running on the server, enter the following command using a 
forwarder process ID name shown in Avaya OA processes on page 41:

pa on processID

If the recorders are not running on the OA Historical server, enter the following command 
using a recorder process ID name shown in Avaya OA processes on page 41:

pa on processID

Note:
Note: If you need to stop the forwarders or recorders, use the pa stop command.

You must manually start forwarders and recorders in the following situations:

● The database server goes out of service. When the server is back in service, you must 
restart the recorders.

● The CMS server goes out of service. When the server is back in service, you must 
restart the forwarders, and possibly the recorders.

● The server where the Historical subsystem is installed goes out of service. When the 
server is back in service, you must restart the recorders.
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Other OA services and processes
In addition to the processes described in the previous sections, OA is dependent upon 
other services and processes that are not under the control of MOM.

This section includes the following topics:

● Stopping and starting the Report subsystem and Web services on page 49

● Starting ORBacus Naming Service on page 51

● Stopping and starting TimesTen database services on page 52

● Starting Database services on page 52

● Stopping and starting the Event Collector and Event Collector Bridge on page 52

Stopping and starting the Report subsystem and Web services

The section describes how to stop and start the Report subsystem and Web services.

To stop the Report subsystem and Web services on Windows
1. Log in using the appropriate user ID and password (see Creating user IDs and group 

IDs on Windows servers on page 106 in Avaya Operational Analyst Release 6.1 
Installation Planning and Prerequisites).

2. Select Start > Programs > Administrative Tools > Services. 

3. Stop the Stumbras-Tomcat service.

To start the Report subsystem and Web services on Windows
1. Log in using the appropriate user ID and password (see Creating user IDs and group 

IDs on Windows servers on page 106 in Avaya Operational Analyst Release 6.1 
Installation Planning and Prerequisites).

2. Select Start > Programs > Administrative Tools > Services. 

3. Start the Stumbras-Tomcat service.

To stop the Report subsystem and Web services on Solaris
1. Log in using the appropriate user ID and password (see Creating user IDs and group 

IDs on Solaris servers on page 108 in Avaya Operational Analyst Release 6.1 
Installation Planning and Prerequisites).

2. Enter the following commands:

cd install_location/https-stumbras

./stop
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To start the Report subsystem and Web services on Solaris
1. Log in using the appropriate user ID and password (see Creating user IDs and group 

IDs on Solaris servers on page 108 in Avaya Operational Analyst Release 6.1 
Installation Planning and Prerequisites).

2. Enter the following commands:

cd install_location/https-stumbras

./start

To stop the Report subsystem and Web services on AIX
1. Log in using the appropriate user ID and password (see Creating user IDs and group 

IDs on AIX servers on page 113 in Avaya Operational Analyst Release 6.1 Installation 
Planning and Prerequisites).

2. Enter:

stopWebSphere -u userID -p userpassword

where userID is the user ID administered for Global Security on WebSphere and 
userpassword is the password for that user ID. If a Global Security user ID has not 
been administered, do not use the user and password options.

Note:
Note: If this command is not found, it was not installed properly during OA 

installation. Use the following alternative commands:

. /opt/BI/.profile

cd $WEBSPHERE_HOME/bin

./stopServer.sh -user userID -password userpassword server1

where userID is the user ID administered for Global Security on WebSphere 
and userpassword is the password for that user ID. If a Global Security user ID 
has not been administered, do not use the user and password options.

To start the Report subsystem and Web services on AIX
1. Log in using the appropriate user ID and password (see Creating user IDs and group 

IDs on AIX servers on page 113 in Avaya Operational Analyst Release 6.1 Installation 
Planning and Prerequisites).



Starting and stopping OA-related processes

Issue 1.0 August 2003 51

2. Enter:

startWebSphere -u userID -p userpassword

where userID is the user ID administered for Global Security on WebSphere and 
userpassword is the password for that user ID. If a Global Security user ID has not 
been administered, do not use the user and password options.

The following message is displayed.

Note:
Note: If this command is not found, it was not installed properly during OA 

installation. Use the following alternative commands:

. /opt/BI/.profile

cd $WEBSPHERE_HOME/bin

./startServer.sh -user userID -password userpassword server1

where userID is the user ID administered for Global Security on WebSphere 
and userpassword is the password for that user ID. If a Global Security user ID 
has not been administered, do not use the user and password options.

Starting ORBacus Naming Service

The ORBacus Naming Service must be running on all servers. To verify the service is 
running:

On Windows - Select Start > Programs > Administrative Tools > Services.

Look for ORBacus Naming Service and verify that it has a status of Started. If not, 
start it from this Services window.

On Solaris and AIX - From the command line enter ps -ef | grep nameserv.

If the service is running, a line containing the service name nameserv, UID, GID and 
other information about the service is displayed. If the service is not running a line 
containing only grep nameserv is displayed.

If the service is not running, as root, or with root privileges, edit /etc/inittab to 
see if nameserv is set to respawn. 

● If nameserv is not currently set to respawn:

i. Set nameserv to respawn
ii. Write the file

.

.

.
ADMU3000I: Server server1 open for e-business; process id is XXXXX



Troubleshooting tools

52 Avaya Operational Analyst R6.1 Maintenance and Troubleshooting

iii. Execute init q.

● If nameserv is currently set to respawn:

i. Set nameserv to off.
ii. Write the file.

iii. Execute init q.

iv. Set nameserv to respawn.

v. Write the file.

vi. Execute init q again.

Stopping and starting TimesTen database services

Services associated with the TimesTen database must be running on the real-time server. 
See Stopping and starting TimesTen on page 56 for information on starting TimesTen 
services.

Starting Database services

Services associated with the historical database must be running on the server containing 
the database. Please refer to the database documentation for details about its particular 
service requirements.

Stopping and starting the Event Collector and Event Collector Bridge

Use the IC Manager to stop and start the Event Collector and Event Collector Bridge.
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Data collection status for forwarders and recorders
Forwarders and recorders are responsible for feeding data to OA and making sure it is 
appropriately placed in the data stores. If data is missing from historical or real-time stores, 
or seems to be inaccurate compared to known IC or CMS activity, check to be sure the 
forwarders and recorders are correctly administered. Refer to the Administration Client 
Help for more information.

The dcstat (data collection status) command displays status and statistics of forwarders 
and recorders. The dcstat command uses the following syntax:

dcstat -n [fwd|rec]datastore [-a | -l | -c | -b | -r]
[-h <host>] [-i] [-v 0|10|20|30] [-z]

dcstat -n dm [-h <host>] [-i] -s <source>

dcstat -n [db|<table>]

-a Display all status. This is equivalent to -l -c -b -r.

-b Display status of data buffering.

-c Display status of data collection.

-h The service is on the specified host.

-i Display the supported CORBA interface objects of the forwarder or 
recorder. Display the supported tables of the dm.

-l Display status of data listening.

-n The name of a service, database, or database table. For a forwarder or 
recorder, the prefix indicates the type and the suffice is an historical data 
store. For example: fwdcmscallhistory. For a dm, the name is "dm." for a 
database, the name is "db." Anything else is assumed to be a table in 
the database.

-r Display status of data recording.

-s Source id that identifies a dm.

-v Acivate/deactivate the trace by hanging the verbosity level. For 
example, 0 means off, 10 means trace events, 20 means trace 
interfaces, 30 means trace low-level functions.

-z Reset all statistical counters to zero.
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For example, if you want to view all status of the forwarder for the agent data store, enter:

dcstat -n fwdagent -a

If you want to change the trace level for the recorder for the cmsskill data store to a debug 
level enter:

dcstat -n reccmsskill -v 30

When troubleshooting data collection from a CMS server, the following example shows the 
output for the command dcstat -n fwdcmsagent -a before data collection has been 
scheduled and run:

The following example shows the output for the command dcstat -n fwdcmsagent -a 
after data collection has been scheduled and run:

CRM_BI.root/collect.pkg/fwdcmsagent.obj @ leopard

Process: pid=12471 forwarder -n cmsagent -v 10
Status: 01/15/03 12:50:14 through 01/15/03 12:51:25
Trace: event
*:Listener:

0 processData
hagent:CMSCollector:

OK: 01/15/03 12:51:23
0 queries

0 collected
hCmsAgent@hawkeye:Sender:

OK: 01/15/03 12:51:19
0 processData

0 delivered

CRM_BI.root/collect.pkg/fwdcmsagent.obj @ leopard

Process: pid=12471 forwarder -n cmsagent -v 10
Status: 01/15/03 12:50:14 through 01/15/03 12:55:06
Trace: event
*:Listener:

1 processData - last at 01/15/03 12:54:15
hagent:CMSCollector:

OK: 01/15/03 12:51:23
1 queries - last at 01/15/03 12:50:17

640 collected
hCmsAgent@hawkeye:Sender:

OK: 01/15/03 12:51:19
4 processData - last at 01/15/03 12:54:20

640 delivered (1 intervals)
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The dcrun (data collection run) command allows you to start and stop an entire set of 
forwarders or recorders. The dcrun command uses the following syntax:

dcrun [on|off] [cms|ic|sd] [fwd|rec]

For example, if you want to turn on all forwarders for CMS, enter:

dcrun on cms fwd

on Turn on the forwarders or recorders.

off Turn off the forwarders or recorders.

cms CMS forwarders or recorders.

ic IC forwarders or recorders.

sd Outbound call (soft dialer) forwarders or recorders.

fwd Forwarders

rec Recorders
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Monitoring the TimesTen database
This section describes the documentation and monitoring tools you can use to 
troubleshoot the TimesTen database.

This section includes the following topics:

● Message logs on page 56

● TimesTen documentation on page 56

● Stopping and starting TimesTen on page 56

● Increasing TimesTen verbosity level on page 57

● Monitoring TimesTen memory usage on page 57

Message logs
The TimesTen message logs are located in the Event Log for Windows and are located in 
$PABASE/TimesTen4.5/32/logs for Solaris and AIX.

TimesTen documentation
TimesTen documentation is included on the OA distribution media. During the installation 
process the documentation is place in these locations:

● Windows: C:\TimesTen\TimesTen4.5\32\Doc

● Solaris and AIX: $PABASE/TimesTen4.5/doc

Note:
Note: To view the documentation you must have Adobe Acrobat Reader 5.0 or 

later installed.

Stopping and starting TimesTen
Information about the procedure for starting or stopping TimesTen is located in TimesTen 
Reference Guide Release 4.5, Chapter 5 Working with the TimesTen Data Manager 
Daemon. This manual is in file tt_ref.pdf in the documentation directories defined 
above.
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Increasing TimesTen verbosity level
To assist in debugging TimesTen problems, increase the verbosity level:

1. Edit the following file:

● c:\TimesTen\TimesTen4.5\32\srv\info\ttendaemon.options 
(Windows)

● /var/TimesTen/TT4.5/32/ttendaemon.options (Solaris and AIX)

These paths are default installation locations.

2. Remove the # symbol from the #verbose line.

3. Stop and restart the TimesTen services as described in Stopping and starting 
TimesTen on page 56.

4. When debugging is complete, replace the # symbol.

Note:
Note: Be sure the # is in place in the file during normal operation.

Monitoring TimesTen memory usage
The best way to monitor memory usage in TimesTen is to use ttIsql and the dssize 
stored procedure. There is no explicit logging done in TimesTen or OA to notify users that a 
memory threshold setting has been exceeded. 

If you see TimesTen-related errors logged by OA, and the associated TimesTen error 
numbers are 802 or 6220 through 6223, TimesTen is notifying OA of memory related 
issues. 802 is an "out-of-memory" error, and the others are "threshold exceeded" 
warnings.

TimesTen error and warning messages can be viewed in the TimesTen Reference Guide. It 
is available in file tt_ref.pdf in the documentation directory described in TimesTen 
documentation on page 56. There are several other good documents in there as well, 
including more info on ttIsql and dssize.

To run dssize:

1. At the command line type ttIsql -connStr "dsn=dss128". 

2. At the Command> prompt, type dssize m; 
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The dssize command displays the memory usage (in MB) similar to this:

where:

DS_MAX_SIZE: 33
DS_ALLOCATED_SIZE: 33
DS_IN_USE_SIZE: 2
PERM_ALLOCATED_SIZE: 25
PERM_IN_USE_SIZE: 1
PERM_IN_USE_HIGH_WATER: 1
TEMP_ALLOCATED_SIZE: 8
TEMP_IN_USE_SIZE: 1
TEMP_IN_USE_HIGH_WATER: 1

Parameter Represents

DS_MAX_SIZE: Overall maximum size of the datastore. This includes 
perm and temp sizes.

DS_ALLOCATED_SIZE: Allocated memory

DS_IN_USE_SIZE: Memory in use out of the total allocation

PERM_ALLOCATED_SIZE: Size of the permanent memory segment. This is 
where OA tables are stored.

PERM_IN_USE_SIZE: Out of the allocation, how much is actually in use.

PERM_IN_USE_HIGH_WATER: High water mark. This may be higher than in_use.

TEMP_ALLOCATED_SIZE: Size of the temporary memory segment. This 
segment is used byTimesTen for temporary tables.

TEMP_IN_USE_SIZE: Out of the temporary memory allocation, how much 
is actually in use.

TEMP_IN_USE_HIGH_WATER: High water mark of the temporary memory segment. 
This may be higher than in_use.
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Event collector troubleshooting tools
The event collector (EC or Source-EC server) captures real-time events from the IC 
system and forwards them to the data manager. If EC is not administered correctly, or is 
not operating, no new contact center information is available for real-time reporting or for 
aggregation and reporting in the historical database. Check EC administration and status 
via the IC Manager application. See Administering the Source-EC (Event Collector) 
server on page 124 in Avaya Operational Analyst Release 6.1 Installation and 
Configuration for details on how to configure the EC.

EC log files can be found in %AVAYA_IC61_HOME%\logs\ecServerName.log 
(Windows) or $AVAYA_IC61_HOME/logs/ecServerName.log (Solaris and AIX) where 
ecServerName is the name of the EC instance configured in IC Manager.

The logging flags are set in IC Manager. Select the Server tab and the ECServer process. 
In the resulting dialog select the Debug tab, then click Trace Levels. The Trace Levels 
dialog box appears with the following options:

Flag Definition

usr1- General EC server logging enabled. Logs EC startup and shutdown messages.

usr2 - ICServerProxy package logging 
enabled.

Logs interactions with IC servers.

usr3 - EventMapper package logging 
enabled.

Logs data transformation performed in 
preparation for forwarding to the 
datamanager.

usr4 - ECCommon package logging 
enabled.

Logs general EC services messages.

usr5 - EC/OA IDL package logging 
enabled.

Logs high level interactions between EC 
and data manager.

usr6 - RTProxy package logging enabled. Logs detailed data sent from EC to data 
manager.

usr7 - General debug tracing logging 
enabled.

Debug logging in EC enabled. Do not use 
unless directed by Avaya support.

usr8 - Function entry and exit logging 
enabled.

Detailed EC function tracing enabled. Do 
not use unless directed by Avaya support.
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Other non-EC specific logging flags of interest include:

EC can also record incoming and outgoing events. This can be very useful for replicating 
problems. Recording is enabled via configuration variables that are defined in the EC 
server configuration dialog described above for the logging flags. Instead of opening the 
Debug tab, open the Configuration tab. On this tab, the following parameters control 
recording:

Note:
Note: Do not enable recording via the ECR* flags listed above unless directed to 

do so by Avaya customer support.

Flag Description

msg Incoming/outgoing messages from/to IC 
servers.

flush Immediately flushes I/0 to disk.

Parameter Values

ECR_ENABLED=y             enables recording, default is n 

ECR_ROLLOVER_BYTES=bytes  0 disables file size limits, default is 1MB 

ECR_ROLLOVER_FILES=num  0 disables limits, default is 10 

ECR_ROLLOVER_SECONDS=num  0 disables, default is 0; 1800 is useful for 1/2 
hour snapshots
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Event Collector Bridge troubleshooting tools
The Event Collector Bridge captures real-time events from the Avaya Business Advocate 
system and forwards them to the Event Collector. If ECB is not administered correctly, or is 
not operating, the Event Collector will not be able to PumpUp. Check ECB administration 
and status via the IC Manager application.

ECB log files can be found at:

● %AVAYA_IC61_HOME%\logs\ecbServerName.log (Windows)

● $AVAYA_IC61_HOME/logs/ecbServerName.log (Solaris and AIX)

where ecbServerName is the name of the ECB instance configured in IC Manager.

The logging flags are set in IC Manager. To set the trace levels:

1. Select the Server tab and the Event Collector Bridge process.

2. In the resulting dialog select the Debug tab, then click Trace Levels.

The Trace Levels dialog box appears with the following options: 

Flag Definition

usr1 - General ECB server logging 
enabled.

Must be turned on to enable general 
ECB trace logging.

usr2 Not used.

usr3 Not used.

usr4 Not used.

usr5 Not used.

usr6 Not used.

usr7 Not used.

usr8 - Function entry and exit logging 
enabled.

Detailed ECB function tracing 
enabled. Do not use unless directed 
by Avaya support.
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Viewing load level on a host
To view the CPU load level on a host, use the following command:

amui [host hostname] load

With this command, you can display the load level of the CPU on server hostname, or on 
the local server if hostname is not specified.

Diagnosing the Historical Delivery System files
The Historical Delivery System (HDS) files are created whenever the system first initializes 
or when the Real-time database forwards data to the historical database using the 
fwddisplaynames command.

These files are located in the following directory:

● %PABASE%\add_on\data\hds (Windows)

● $PABASE/add_on/data/hds (Solaris and AIX)

The files in this directory are in the form dbtable.dat where dbtable is the name of a 
database table. You can use these files to determine if the correct table data is being 
forwarded to the historical database.
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Other troubleshooting commands
This section describes various other troubleshooting commands that can be used to track 
problems with OA.

This section includes the following topics:

● testalarms on page 63

● TraceConv on page 63

● Whattime on page 64

testalarms
The testalarms command tests the configuration and interface for forwarding of alarms. 
The test alarms are recorded in the $PABASE/data/log/CentralError/
CentralErrorLog.log file. The command displays the following information:

TraceConv
The TraceConv command takes the information in a log file, converts the time stamps into 
a more understandable format, and orders the entries from oldest to newest.

Beginning testalarms...
Alarms forwarded to server vtex-6.dr.avaya.com which is of type IC.

Raising emergency priority alarm.
Raising high priority alarm.
Raising low priority alarm.
Raising informational priority alarm.
Clearing emergency priority alarm.
Clearing high priority alarm.
Clearing low priority alarm.
Clearing informational priority alarm.

See CentralErrorLog to verify status of this test.
Problems encountered are documented there.
If alarms processed successfully, then view the alarms for
vtex-6.dr.avaya.com on the Alarm Monitor to verify the
test alarms were received.
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Whattime
The Whattime command converts the time stamp in a log file into a more understandable 
format.
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Troubleshooting OA components

This section presents monitoring and troubleshooting information about core OA 
components. This information will help you determine possible sources of difficulty in 
various portions of OA, like historical or real-time databases, OA subsystems, and various 
data and user interfaces. Trace files, alarm messages and error messages are valuable 
tools, and this section helps to clarify the information they provide.

This section includes the following topics:

● General OA troubleshooting on page 66

● Trace files on page 67

● Alarm messages on page 70

● Error messages on page 94

● Troubleshooting the TimesTen database on page 99

● Troubleshooting the historical database on page 102

● Data manager, report data server, and central report data server on page 111

● Troubleshooting data collection problems on page 115



Troubleshooting OA components

66 Avaya Operational Analyst R6.1 Maintenance and Troubleshooting

General OA troubleshooting
This section describes solutions to general OA problems.

This section includes the following topics:

● Order of starting Avaya IC and OA servers on page 66

● Power failures on Avaya IC and OA servers on page 66

Order of starting Avaya IC and OA servers
When returning servers into operation after maintenance, adding, repairing, or upgrading, 
use the following sequence:

1. Start all Avaya IC servers. See Avaya Interaction Center Release 6.1 Installation and 
Configuration for more information.

2. Verify that the Avaya IC servers can communicate with other Avaya IC servers.

3. Start processes and services on all OA servers. See Starting and stopping OA-related 
processes on page 39 for more information.

4. Verify that the OA servers can communicate to all other servers in the configuration.

Power failures on Avaya IC and OA servers
Since power failures can randomly affect servers, the servers may power-up and restart in 
random order. Use the following sequence to bring the servers back up in proper order:

1. Stop processes and services on all OA servers. See Starting and stopping OA-related 
processes on page 39 for more information.

2. Start all Avaya IC servers. See Avaya Interaction Center Release 6.1 Installation and 
Configuration for more information.

3. Verify that the Avaya IC servers can communicate with other Avaya IC servers.

4. Start processes and services on all OA servers. See Starting and stopping OA-related 
processes on page 39 for more information.

5. Verify that the OA servers can communicate to all other servers in the configuration.
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Trace files 
Trace files allows you to isolate and diagnose problems within a process as well as 
problems between communicating processes. 

Note:
Note: Trace files are not intended for customer use, but rather for Avaya customer 

support representatives, system verification engineers, or development 
engineers who are engaged in troubleshooting OA problems.

This section includes the following topics:

● Loginfo file on page 67

● Locating trace files on page 67

● Trace levels on page 68

Loginfo file
The loginfo file contains the trace log parameters used by the Logger to determine the 
name, location, size, and number of rollover files associated with each component. The 
loginfo file is located at:

● %PABASE%\data\admin\loginfo (Windows)

● $PABASE/data/admin/loginfo (Solaris and AIX)

The loginfo file specifies information for OA server and the OA Administration client. The 
following is an example of some entries in this file:

The first two items of each entry should not be changed (slashes or backslashes are 
required). The third item specifies the maximum size of the trace file in bytes and can be 
changed to a value of 100000 to 10000000. The fourth item specifies the maximum 
number of rollover files and can be changed to a value of 3 to 99. If you need larger or 
more log files, you can modify these two items. However, if you increase these values, be 
sure to verify that there is enough disk space on the machine to save the larger log files.

Locating trace files
Most of the trace files are located in directories under the %PABASE%\data\log 
(Windows) or $PABASE/data/log (Solaris and AIX) directory. To locate a particular 

dbchecktrc data/log/dbcheck/dbchecktrc 150000 10
reccmsagent data/log/recorder/cmsagentTrc 500000 3
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server trace file, edit the loginfo file described above and find the path and filename (the 
second item in the entry) associated with the process of interest.

Some of the trace directories include the following:

● appman

● forwarder

● dataserver

● scheduler

Trace levels
Note:

Note: The Report subsystem does not use this trace level scheme.

Trace files contain trace information that results from the trace level you set. There are 
three levels of tracing available: Event level (10), Interface level (20), and Debug level (30). 
The Event level tracing provides the least amount of information, Interface level provides 
more detailed trace information, and the Debug level provides the most detailed trace 
information.

Trace levels above Event level (10) produce a large volume of data and should be used 
sparingly, especially the Debug level (30). The large amount of data logged can affect the 
overall performance and throughput of OA. 

Note:
Note: If anti-virus software is running on a system where a high level of tracing is 

enabled, performance may be further impacted. This is especially noticed 
when the trace levels are increased for Data Manager and Aggregation. 
While troubleshooting at this level, be sure to configure the anti-virus 
software so that is does not scan the trace files. If the system performance is 
still impaired, you may consider turning off the anti-virus software while 
capturing the trace information needed.

Trace levels can be changed dynamically or statically. Dynamic changes apply only to the 
currently running processes. If the trace level must be maintained on an on-going basis 
even after stopping and restarting a process, the trace level must be changed statically.

This section includes the following topics:

● Dynamic trace level changes on page 69

● Static trace level changes on page 69

● Administration client trace levels on page 69



Trace files

Issue 1.0 August 2003 69

Dynamic trace level changes

The Application Management Framework provides the capability to dynamically change 
the tracing level for all of the OA CORBA servers. With this functionality, you do not need to 
stop processes to change the tracing level. Keep in mind that the level that you set is only 
valid as long as the current instance of the process is running. It will be reset to the values 
in MOM if the process restarts. 

The command-line tool syntax is: 

amui [host hostname] process processname tlevel level

where 

● hostname is the IP or DNS name of the host where the CORBA process is running, 
localhost is used if not specified.

● processname is the name of the CORBA process. 

● level is a valid trace level of 0,10,20, or 30.

For example:

amui host oalab process recagentstate tlevel 30

sets the trace level of the recagentstate process to the highest debug level.

Static trace level changes

If it becomes necessary to permanently change the tracing level for a process, edit the 
%PABASE%\data\admin\mom\etc\momtab (Windows) or $PABASE/data/admin/
mom/etc/momtab (Solaris and AIX) file. This file contains entries for each of the 
processes that MOM controls. The line associated with the process of interest must be 
modified, then the process must be stopped and restarted for the change to take effect

For example, consider this excerpt from a momtab file:

To permanently increase the trace level for the admb process to the highest debug level, 
change -v 10 to -v 30. Then stop and restart the admb process via the pa command. (See 
Using the pa command on page 44 for more information.)

Note:
Note: Do not modify any other values in the momtab file.

Administration client trace levels

See AdminPol.html on page 133 for details on setting Administration client trace levels.

admb:234:respawn:java com.avaya.cc.cvx.adminmgr.AdminMgrSrv.AdminMgrSrvBaseServer -v 10
adm0:234:respawn:java com.avaya.cc.cvx.adminmgr.AdminMgrSrv.AdminMgrSrvServer -i 0 -v 10
ams:1234:respawn:java com.avaya.cc.cvx.appmanserver.AppManServer -v 0
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Alarm messages
When an alarm occurs, OA forwards an alarm message to the IC Alarm Server where the 
Source-EC (Event Collector) subsystem is installed, which is part of the IC Manager. The 
IC Alarm Server may be on a Windows, Solaris, or AIX system. Avaya IC alarms are 
viewed using the IC Alarm Monitor. This viewer resides on a client machine and is 
therefore supported only on Windows systems. The IC Alarm Viewer provides a GUI 
interface to view and clear alarms. It can view the alarms of multiple Alarm Servers.

An OA alarm is cleared through software by raising an informational alarm. Cleared alarms 
should clearly state that the specific condition no longer exists.

In addition to being forwarded to an IC Alarm Server, OA alarms are also logged into the 
local OA central error log (the Windows Event Log or the Solaris and AIX $PABASE/
data/log/CentralError/CentralErrorLog.log file), as well as into trace files if 
tracing is activated.

Note:
Note: In a CMS-only configuration, alarms are logged only in the 

CentralErrorLog.log file and trace files (if tracing is activated) because 
there is no associated IC system to receive the alarm messages.

This section includes the following topics:

● Viewing alarms on page 70

● Alarm properties on page 70

● Alarm tables on page 71

Viewing alarms
To view alarms on an Avaya IC system, from IC Manager select Tools > Alarm Monitor.

Alarm properties
The alarm properties, stored in the %PABASE%\data\admin\server.properties 
(Windows) or $PABASE/data/admin/server.properties (Solaris and AIX) file, 
specify the host type and location of the alarm server to receive the alarms. This file is 
configured during installation, and under normal conditions does not require editing. 
However, if error messages are logged indicating that alarm messages cannot be 
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forwarded because of incorrect properties values, edit the file and assure these two entries 
are as follows:

AlarmHostType=IC

AlarmServer=<alarmserver location>

where alarmserver location is the fully qualified IP address of the alarm server that 
is to receive the alarms. (For example: myAlarmServerName.denver.avaya.com.)

Alarm tables
Alarms originate from several OA sources. The following tables present the alarms from 
each of the sources. To aid your understanding of the information presented in the tables, 
review these tips:

● The Alarm message column of the tables shows the message as it appears in the IC 
Alarm Monitor and the error log.

● In some cases in the tables an alarm message has an ellipsis (...) at the end of the text. 
This indicates that the actual alarm message will present more information based on 
where in the product the alarm is generated.

● Some alarm message entries contain a list of strings within square brackets, like 
[ a1 | a2 | a3 ]. This indicates that one of the values in the list appears in the actual 
alarm message.

● Many entries specify file path names. While Windows notation %PABASE% and \ is used 
in the paths specified in the entries, you can replace them with $PABASE and / 
respectively for Solaris and AIX.

● In entries where lengthy path names must be broken, they are broken at a directory 
boundary. Always consider path names to be unbroken.

The alarm tables in this section include:

● Administration Manager alarm messages on page 72

● Scheduler alarm messages on page 76

● DBService alarm messages on page 76

● Data Manager alarm messages on page 76

● Report Data Server alarm messages on page 80

● Central Report Data Server alarm messages on page 82

● Forwarder alarm messages on page 84

● Forwarder or recorder alarm messages on page 86

● Event Collector alarm messages on page 86

● Event Collector Bridge alarm messages on page 92
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Administration Manager alarm messages

Alarm message Description Resolution

Exception when resolving 
Admin Manager reserve server. 
Check MOMTAB to be sure it is 
being launched...

Unable to resolve 
administration manager 
reserve server with the 
naming service.

Check the %PABASE% \data\admin\
mom\etc\momtab file to be sure the 
adm0 and admb entries are set to 
respawn, not off. 
Verify the ORBacus Naming Service is 
running. If the service is not running, 
see Starting ORBacus Naming 
Service on page 51 for information 
about starting the service.

Exception when narrowing 
Admin Manager reserve server. 
Check MOMTAB to be sure it is 
being launched...

Unable to narrow the 
object reference.

Check the %PABASE% \data\admin\
mom\etc\momtab file to be sure the 
adm0 and admb entries are set to 
respawn, not off.
Stop and restart adm0 using these 
commands: pa disable adm0 and 
pa enable adm0.

Exception when starting [adm1| 
adm2| adm3| adm4 | adm5] 
process...

Unable to connect to an 
administration manager 
server on the historical 
server.

Verify the ORBacus Naming Service is 
running. If the service is not running, 
see Starting ORBacus Naming 
Service on page 51 for information 
about starting the service.
Check for networking problems.

Server [adm1| adm2| adm3| 
adm4 | adm5] failed to register 
with base server - exiting

The administration 
manager base server 
has died.

Execute the pa list command to see 
if admb is running. If not, restart it using 
pa enable admb.

Exception when resolving 
[adm1| adm2| adm3| adm4 | 
adm5]...

Unable to resolve one 
of [adm1| adm2| adm3| 
adm4 | adm5] with the 
naming service. This 
could be because the 
administration manager 
server is not running.

Reconnect from the Administration 
client.

Exception when narrowing 
[adm1| adm2| adm3| adm4| 
adm5]...

Unable to narrow the 
object reference.

Stop and restart adm0 using pa
disable adm0 and pa enable
adm0.

Exception when setting up 
monitoring of [adm0 | adm1| 
adm2| adm3| adm4 | adm5]...

Server did not start 
properly, or quit.

For adm0, stop and restart using pa
disable adm0 and pa enable
adm0.For others, if Administration client 
is available, then attempt to reconnect 
to the server by selecting File > 
Reconnect, or restart the 
Administration client.
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AdminMgrSrvBaseServer 
unable to get lock. Check the 
momtab file to be sure that only 
one AdminMgrSrvBaseServer 
is being launched.

Unable to get lock. Check the %PABASE% \data\admin\
mom\etc\momtab file to be sure there 
is only one AdminMgrSrvBaseServer 
set to respawn.
If logging in to the Administration client 
with the OA User ID configured during 
installation, check permissions of the 
%PABASE%\data\runtime\lock 
directory and verify this ID has 
permission to write to this directory.
If logging in to the Administration client 
with a different User ID, verify this User 
ID is a member of the OA Group ID 
configured during installation. Then 
check permissions of the %PABASE%\
data\runtime\lock directory and 
verify this group has permission to write 
to this directory.

Exception raised during ORB 
initialization:...

Unable to initialize the 
ORBacus ORB; may 
be using incorrect 
ORB.

Verify in the %PABASE%\
AdminPol.html (or %PABASE%\
AdminSig.html) file that for the entry 
PARAM NAME="java_archive", jars/
OB.jar and jars/OBNaming.jar are 
included in the VALUE specified.
Verify that the OB.jar and 
OBNaming.jar files exist in 
%PABASE%/jars directory.

Exception raised during 
creation of mySrv:...

Problem with CORBA. Check system resources: disk space, 
memory, etc.
Contact Avaya customer support.

Could not publish object 
reference:...

Unable to publish an 
object reference with 
the naming service.

Verify the ORBacus Naming Service is 
running. If the service is not running, 
see Starting ORBacus Naming 
Service on page 51 for information 
about starting the service.
Stop and restart the Administration 
Manager Base Server using pa
disable admb and pa enable
admb.

Alarm message Description Resolution
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AdminMgrSrvBaseServer could 
not initialize as monitoree:...

Monitor cannot publish 
interface with the 
naming service.

Verify the ORBacus Naming Service is 
running. If the service is not running, 
see Starting ORBacus Naming 
Service on page 51 for information 
about starting the service.
Stop and restart the Administration 
Manager Base Server using pa
disable admb and pa enable
admb.

Exception raised during 
impl_is_ready:...

Unable to start CORBA 
event loop.

Check the CLASSPATH environment 
variable to be sure that server.jar 
appears in the CLASSPATH before any 
JRE entries, or before any other ORB 
entries.

AdminMgrSrvServer [0 | 1 | 2 | 3 
| 4 | 5] : failed to get lock for 
AdminMgrSrvServer [0 | 1 | 2 | 3 
| 4 | 5]...

Unable to launch an 
Administration client.

Execute the pa list command to see 
if admb is running. If not, start it using 
pa enable admb.
Possible race condition; wait 30 
seconds and try again.
If logging in to the Administration client 
with the OA User ID configured during 
installation, check permissions of the 
%PABASE%\data\runtime\lock 
directory and verify this ID has 
permission to write to this directory.
If logging in to the Administration client 
with a different User ID, verify this User 
ID is a member of the OA Group ID 
configured during installation. Then 
check permissions of the %PABASE%\
data\runtime\lock directory and 
verify this group has permission to write 
to this directory.

Exception raised during 
Monitoree initialization for...

Monitor cannot publish 
interface with the 
naming service.

Verify the ORBacus Naming Service is 
running. If the service is not running, 
see Starting ORBacus Naming 
Service on page 51 for information 
about starting the service.
Stop and restart this server.

System exception starting 
thread...

Unable to start thread 
to monitor activity of 
reserve server (adm0) 
and Administration 
client servers.
Possibly out of threads.

Check system resources like: threads 
being used, and memory.
Contact Avaya customer support.

Alarm message Description Resolution
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NotInitializedException raised 
during creation of mySrv...

Problem with CORBA. Check system resources like: disk 
space and memory.
Contact Avaya customer support.

Cannot resolve reference to 
base server:...

Unable to resolve 
administration manager 
base server with the 
naming service.

Check the %PABASE% \data\admin\
mom\etc\momtab file to be sure the 
admb entry is set to respawn, not off.
Verify the ORBacus Naming Service is 
running. If the service is not running, 
see Starting ORBacus Naming 
Service on page 51 for information 
about starting the service.

Cannot narrow reference to 
base server:...

Unable to narrow the 
object reference.

Check the %PABASE% \data\admin\
mom\etc\momtab file to be sure the 
admb entry is set to respawn, not off.
Stop and restart admb using pa
disable admb and pa enable
admb.

AdminMgrSrvServer can't 
monitor base server...

Server did not start 
properly, or quit.

Stop and restart admb using pa
disable admb and pa enable
admb.

Exception raised during 
creation of myImpl...

Unable to start CORBA 
event loop.

Check the CLASSPATH environment 
variable to be sure that server.jar 
appears in the CLASSPATH before any 
JRE entries, or before any other ORB 
entries.

Alarm message containing error 
number 4202.

Unable to initialize the 
naming service.

Verify the ORBacus Naming Service is 
running. If the service is not running, 
see Starting ORBacus Naming 
Service on page 51 for information 
about starting the service.

Alarm message containing error 
number 4701.

Monitor cannot publish 
interface with the 
naming service.

Verify the ORBacus Naming Service is 
running. If the service is not running, 
see Starting ORBacus Naming 
Service on page 51 for information 
about starting the service.
Stop and restart this server.

Alarm message Description Resolution
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Scheduler alarm messages

DBService alarm messages

Data Manager alarm messages

Alarm message Description Resolution

ExecutionManager:: 
ExecutionManager: 
Process failed to start
schedule entry name: 
SomeName
process type: 
SomeProcessType

System scheduled 
process failed to start.

Check the Windows Event Log or Solaris and 
AIX $PABASE/data/log/CentralError/
CentralErrorLog.log file for other error 
messages that may indicate the problem.
OA will try to start the process at the next 
scheduled time. If it continues to fail then check 
the trace files associated with the process.
Contact Avaya customer support.

Alarm message Description Resolution

DBService:initialize: RT_359: 
Unable to connect to TimesTen 
DB.

Cannot connect to the 
TimesTen database.

Verify the TimesTen services are 
running: TimesTen Data Manager and 
TimesTen Server. Start them if they 
are not running. See Stopping and 
starting TimesTen on page 56 for 
information on starting TimesTen 
services.
If TimesTen is running, run ttisql and 
attempt to connect to the database. If 
this is successful then Contact Avaya 
customer support.

Alarm message Description Resolution

IntervalExportDone:processEven
t():Exception requesting 
Application Management Server 
to release database from 
Extreme load level

Unable to release 
database resource from 
extreme CPU load level. 
Possibly a CORBA error.

If AMS is not running then this is 
okay.
Run the pa list command to see 
if the ams process is running. 
If AMS is running, then this 
condition should self-correct after a 
time-out period and the resource 
will be released.

DataManager:DataManager() 
RT_104: Failed to get properties.

Unable to get properties 
values.

Verify the administration manager 
is running.
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RT_108: ORB not initialized 
exception.

Unable to initialize 
connection monitoring.

Verify the ORBacus Naming 
Service is running. If the service is 
not running, see Starting ORBacus 
Naming Service on page 51 for 
information about starting the 
service.
Stop and restart data manager.

RT_109: Error while initializing 
connection monitor.

Unable to initialize 
connection monitoring.

Verify the ORBacus Naming 
Service is running. If the service is 
not running, see Starting ORBacus 
Naming Service on page 51 for 
information about starting the 
service.
Stop and restart data manager.

BulkDeliverer:notifyAboutActiveF
iles():RT_111: CORBA call timed 
out for table TableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

SynonymExporter:publishData()::
RT_111: CORBA call timed out 
for table TableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

SynonymExporter:unloadDataAn
dNotify()::RT_111: CORBA call 
timed out for table TableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

WorkitemDataSet:attemptDataD
elivery()::RT_111: CORBA call 
timed out for table TableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

WorkitemDataSet:notifyAboutAct
iveFile()::RT_111: CORBA call 
timed out for table TableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

RT_113: Failed to initialize ORB Unable to initialize the 
ORBacus ORB. May be 
using an incorrect ORB.

Check the CLASSPATH 
environment variable to be sure 
that server.jar appears in the 
CLASSPATH before any JRE 
entries, or before any other ORB 
entries.

RT_115: Failed to initialize name 
service

Unable to initialize the 
naming service

Verify the ORBacus Naming 
Service is running. If the service is 
not running, see Starting ORBacus 
Naming Service on page 51 for 
information about starting the 
service.

Alarm message Description Resolution
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BulkDeliverer:notifyAboutActiveF
iles():RT_118: CORBA 
Communication Failure for table 
SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

SynonymExporter:publishData()::
RT_118: CORBA 
Communication Failure for table 
SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

SynonymExporter:unloadDataAn
dNotify()::RT_118: CORBA 
Communication Failure for table 
SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

WorkitemDataSet:attemptDataD
elivery()::RT_118: CORBA 
Communication Failure for table 
SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

WorkitemDataSet:notifyAboutAct
iveFile()::RT_118: CORBA 
Communication Failure for table 
SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

DataManager:DataManager() 
RT_135: Failed to get Default 
properties.

Unable to get properties 
values.

Verify the administration manager 
is running.

BulkDeliverer:notifyAboutActiveF
iles():RT_137: Forwarder failed 
to take the data. for table 
SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

SynonymExporter:publishData()::
RT_137: Forwarder failed to take 
the data. for table 
SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

SynonymExporter:unloadDataAn
dNotify()::RT_137: Forwarder 
failed to take the data. for table 
SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

WorkitemDataSet:attemptDataD
elivery()::RT_137: Forwarder 
failed to take the data. for table 
SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

WorkitemDataSet:notifyAboutAct
iveFile()::RT_137: Forwarder 
failed to take the data. for table 
SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

Alarm message Description Resolution
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DataManager:registerWithAMF() 
RT_139: Error creating 
ApplicationManager instance

Unable to create 
application manager 
instance.

Check system resources like disk 
space and memory.
Contact Avaya customer support.

DataManager:registerWithAMF() 
RT_140: Error creating 
ResourceManager instance...

Unable to create resource 
manager instance.

Check system resources like disk 
space and memory.
Contact Avaya customer support.

RT_200: Cannot write to event 
buffer files

I/O Error trying to write to 
file %PABASE%\add_on\
data\dm\
EventBufferX.txt

Check available disk space.
Check the permissions of 
%PABASE%\add_on\data\dm 
directory and EventBufferX.txt 
file and verify that the OA 
Administration User configured 
during installation has permission 
to write to this directory and file.
Verify the file is not currently in use 
(for example, being edited).

RT_203: System initialization 
failed - Exiting

A process upon which the 
data manager depends 
failed to start, such as 
EventProcessor, or 
EventManager.

Check the Windows Event Log or 
Solaris and AIX $PABASE/data/
log/CentralError/
CentralErrorLog.log file for 
other error messages that may 
indicate the problem and other 
details.
Check the %PABASE%\data\log\
datamanager\dmTrc.log file for 
other trace messages.
May need to increase the trace 
level for the dm process, restart the 
data manager, and look at the log 
file again.

RT_208 Failed to register 
gateway with name service

Unable to register the 
gateway with the 
ORBacus Naming 
Service.

Verify the ORBacus Naming 
Service is running. If the service is 
not running, see Starting ORBacus 
Naming Service on page 51 for 
information about starting the 
service.
Contact Avaya customer support.

Alarm message Description Resolution
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Report Data Server alarm messages

RT_228: PABASE not set, 
cannot open event buffer files

PABASE environment 
variable is not set.

PABASE needs to be set to the base 
directory of the OA installation.

DataManager 
OA:RT:DataManager: 
0=<MethodName>: RT_600 : 
Error executing the SQL - 227. 
java.sql.SQLException: 
[TimesTen][TimesTen 4.5.25 
ODBC Driver][TimesTen]TT6002: 
Lock request denied because of 
deadlock 
Related to this message, you will 
also see one or more RT_128 
messages.

This message is logged 
as a result of a resource 
conflict between two OA 
processes.

Despite the severity reported 
(ERROR - high), the message is 
only informational in nature. OA will 
recover from the condition.

Alarm message Description Resolution

Alarm message Description Resolution

DataServerMain: RT_104: Failed to 
get properties.

Unable to get properties 
values.

Check that the administration 
manager is running.

DataServerMain:initializeCorba(): 
RT_114 :Failed to initialize BOA

Unable to initialize the 
ORBacus ORB.

Check system resources like 
disk space and memory.
Contact Avaya customer 
support.

DataServerMain: RT_135: Failed to 
get Default properties.

Unable to get properties 
values.

Check that the administration 
manager is running.

DataServerMain:registerWithAMF():
RT_139: Error creating 
ApplicationManager instance...

Unable to create 
Application Manager 
instance.

Check system resources: disk 
space, memory, etc.
Contact Avaya customer 
support.

DataServerMain:registerWithAMF():
RT_140: Error creating 
ResourceManager instance...

Unable to create resource 
manager instance.

Check system resources like 
disk space and memory.
Contact Avaya customer 
support.
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DataServerMain:Main() RT_203: 
System initialization failed - Exiting

A process upon which the 
data server depends 
failed to start.

Check the Windows Event Log 
or Solaris and AIX $PABASE/
data/log/CentralError/
CentralErrorLog.log file for 
other error messages that may 
indicate the problem and other 
details.
Check the %PABASE%\data\
log\dataserver\dsTrc.log 
file for other trace messages.
May need to increase the trace 
level for the ds process, restart 
the data server, and look at the 
log file again.

DataServerMain:Main() RT_314: 
The following required tables are 
missing from data base:...

Tables are missing from 
the TimesTen database.

Stop and restart data manager.
May need to use ttisql to drop 
u.wkheader table and then 
restart data manager.

DataServerMain:initializeCorba(): 
RT_328: Failed to register RDS.

Unable to register the 
report data server with 
the naming service.

Verify the ORBacus Naming 
Service is running. If the service 
is not running, see Starting 
ORBacus Naming Service on 
page 51 for information about 
starting the service.

DataServerMain:initializeCorba(): 
RT_330: Error in getting system 
state.

Verify the ORBacus Naming 
Service is running. If the service 
is not running, see Starting 
ORBacus Naming Service on 
page 51 for information about 
starting the service.

DataServerMain:registerSubCompo
nents() RT_332: Exception: 
Unsupported version.

Incompatible IDLs. Possibly bad installation. 
Contact Avaya customer 
support.

DataServerMain:registerSubCompo
nents() RT_333: Failed to resolve 
gateway narrow.

Incompatible IDLs. Possibly bad installation. 
Contact Avaya customer 
support.

Alarm message Description Resolution
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Central Report Data Server alarm messages

DataSetManager:Constructor: 
RT_374: File Error...

File path does not exist. Verify %PABASE%\add_on\
data\dsvr directory exists and 
that the OA Administration User 
configured during installation has 
permission to write to this 
directory. If the 
dsvr_restartnum.dat file 
exists in that directory, be sure 
that the OA Administration User 
configured during installation has 
permission to write to this file.

DSRestartnum:restartNum: RT_381: 
Could not get strings from properties 
file to build restart num file name

Unable to get values from 
properties file.

Verify the administration 
manager is running.

Alarm message Description Resolution

Alarm message Description Resolution

DataServerMain: RT_104: Failed to 
get properties.

Unable to get properties 
values.

Check that the administration 
manager is running.

DataServerMain:initializeCorba(): 
RT_114 :Failed to initialize BOA

Unable to initialize the 
ORBacus ORB.

Check system resources like 
disk space and memory.
Contact Avaya customer 
support.

DataServerMain: RT_135: Failed to 
get Default properties.

Unable to get properties 
values.

Check that the administration 
manager is running.

DataServerMain:registerWithAMF():
RT_139: Error creating 
ApplicationManager instance...

Unable to create 
Application Manager 
instance.

Check system resources: disk 
space, memory, etc.
Contact Avaya customer 
support.

DataServerMain:registerWithAMF():
RT_140: Error creating 
ResourceManager instance...

Unable to create resource 
manager instance.

Check system resources like 
disk space and memory.
Contact Avaya customer 
support.
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DataServerMain:Main() RT_203: 
System initialization failed - Exiting

A process upon which the 
data server depends 
failed to start.

Check the Windows Event Log 
or Solaris and AIX $PABASE/
data/log/CentralError/
CentralErrorLog.log file for 
other error messages that may 
indicate the problem and other 
details.
Check the %PABASE%\data\
log\dataserver\dsTrc.log 
file for other trace messages.
May need to increase the trace 
level for the ds process, restart 
the data server, and look at the 
log file again.

DataServerMain:initializeCorba(): 
RT_328: Failed to register RDS.

Unable to register the 
report data server with 
the naming service.

Verify the ORBacus Naming 
Service is running. If the service 
is not running, see Starting 
ORBacus Naming Service on 
page 51 for information about 
starting the service.

DataServerMain:initializeCorba(): 
RT_330: Error in getting system 
state.

Verify the ORBacus Naming 
Service is running. If the service 
is not running, see Starting 
ORBacus Naming Service on 
page 51 for information about 
starting the service.

DataServerMain:registerSubCompo
nents() RT_332: Exception: 
Unsupported version.

Incompatible IDLs. Possibly bad installation. 
Contact Avaya customer 
support.

DataServerMain:registerSubCompo
nents() RT_333: Failed to resolve 
gateway narrow.

Incompatible IDLs. Possibly bad installation. 
Contact Avaya customer 
support.

DataSetManager:Constructor: 
RT_374: File Error...

File path does not exist. Verify %PABASE%\add_on\
data\dsvr directory exists and 
that the OA Administration User 
configured during installation has 
permission to write to this 
directory. If the 
dsvr_restartnum.dat file exists 
in that directory, be sure that the 
OA Administration User 
configured during installation has 
permission to write to this file.

Alarm message Description Resolution
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Forwarder alarm messages

DSRestartnum:restartNum: RT_381: 
Could not get strings from properties 
file to build restart num file name

Unable to get values from 
properties file.

Verify the administration 
manager is running.

DataServerMain: RT_434 Do not have any RDS 
connections to handle 
requests at this time.

Make sure that the Report Data 
Servers are running on all 
Real-time servers.

Alarm message Description Resolution

Alarm message Description Resolution

CMSAcd X has 15 minute 
intervals

CMS interval size is 
invalid for OA.

Unadminister that ACD source on OA 
using the Administration client Interface 
Services page.
Change the interval value on CMS to 30 
following instructions in the CMS 
documentation. This involves data 
migration, etc.

SomeId :CMSCollector 
terminated abnormally...

An unhandled exception 
was thrown.

Restart the forwarder.
If the alarms persists, contact Avaya 
customer support.

SomeId :ECHCollector 
terminated abnormally...

An unhandled exception 
was thrown.

Restart the forwarder.
If the alarms persists, contact Avaya 
customer support.

SomeId :HDSCollector 
terminated abnormally...

An unhandled exception 
was thrown.

Restart the forwarder.
If the alarms persists, contact Avaya 
customer support.

SomeId :Buffer terminated 
abnormally...

An unhandled exception 
was thrown.

Restart the forwarder.
If the alarms persists, contact Avaya 
customer support.

SomeId :Exporter terminated 
abnormally...

An unhandled exception 
was thrown.

Restart the forwarder.
If the alarms persists, contact Avaya 
customer support.

SomeTableName: 
CMSReader: specific error 
message

There is a database 
problem causing 
SomeTableName to be 
unreachable for reading.

Specific error message should indicate 
more detail of the problem.
Verify database services are running.
Check that SomeTableName exists in 
the database.
Check for networking problems.
Check disk space.
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unable to open 
SomeFileName: specific error 
message

Unable to open file. Specific error message should indicate 
more detail of the problem.
Check permissions of SomeFileName 
and verify that the OA Administration 
User configured during installation has 
permission to write to this file.
Remove the file if it exists and its 
permissions are correct, and restart the 
forwarder.

unable to read 
SomeFileName: specific error 
message

Unable to open file. Specific error message should indicate 
more detail of the problem.
Check permissions of SomeFileName 
and verify that the OA Administration 
User configured during installation has 
permission to write to this file.
Remove the file if it exists and its 
permissions are correct, and restart the 
forwarder.

unable to read 
SomeFileName: infinite loop

Possibly corrupt file. Data has been lost, but the condition is 
self-correcting.

SomeTableName: buffer full; 
purging oldest data

Buffer became full. Data 
is lost.

Increase the size of the buffer using the 
Administration client Interface Services 
page. This may improve future buffer 
performance during system outages.

unable to write 
SomeFileName: specific error 
message

Unable to write file. Data 
is lost.

Specific error message should indicate 
more detail of the problem.
Check disk space and free up space if 
possible.

Alarm message Description Resolution
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Forwarder or recorder alarm messages

Event Collector alarm messages

Alarm message Description Resolution

SomeId :Clock terminated 
abnormally...

An unhandled exception 
was thrown.

Restart the forwarder or recorder.
If the alarm persists, contact 
Avaya customer support.

SomeTableName: CRTable: 
specific error message

There is a database 
problem causing 
SomeTableName to be 
unreachable for writing.

Specific error message should 
indicate more detail of the 
problem.
Verify database services are 
running.
Check that SomeTableName 
exists in the table.
Check for networking problems.
Check disk space.

Alarm message Description Resolution

EC.AssignFailure: Assign for 
<Server>.assign failed. "Verify that 
the server for <Server>.assign is 
configured correctly and running.

This is most 
typically a probably 
assigning to an 
ADU server where 
<Server> is the 
ADU server alias 
name.

Using IC Manager, verify the IC ADU 
Server is properly administered and is 
running.

EC.AssignFailure: Unable to 
assign to primary ECB server. 
Verify ECB servers are configured 
correctly

Failed to assign to 
any of the Event 
Collector Bridge 
servers configured 
in the system.

Using IC Manager, verify the OA Event 
Collector Bridge Server is properly 
administered and is running. Verify that at 
least one (or the only one) is running as 
the Primary Event Collector Bridge 
Server (see the Event Collector Bridge 
alarm messages on page 92 for more 
information on Primary vs. Standby 
mode).

EC.AssignFailure: Assign to DS 
server failed. Verify DS server is 
configured correctly

EC was unable to 
connect to the IC 
Directory Server.

Using IC Manager, verify the IC Directory 
Server is properly administered and is 
running.
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EC.ConnectionMonitoring: 
ConnectionMonitor 
AlreadyInitializedException.

EC failed to initialize 
its CORBA 
infrastructure.

The most likely cause of this problem is 
an improper installation of EC. Reinstall 
EC per Avaya Operational Analyst 
Release 6.1 Installation and 
Configuration and restart. If he problem 
persists, contact Avaya customer 
support.

EC.ConnectionMonitoring: 
ConnectionMonitor 
CORBA::SystemException.

EC failed to initialize 
its CORBA 
infrastructure.

The most likely cause of this problem is 
an improper installation of EC. Reinstall 
EC per Avaya Operational Analyst 
Release 6.1 Installation and 
Configuration and restart. If the problem 
persists, contact Avaya customer 
support.

EC.ConnectionMonitoring: 
ConnectionMonitor 
InitializeException.

EC failed to initialize 
its CORBA 
infrastructure.

The most likely cause of this problem is 
an improper installation of EC. Reinstall 
EC per Avaya Operational Analyst 
Release 6.1 Installation and 
Configuration and restart. If the problem 
persists, contact Avaya customer 
support.

EC.ConnectionMonitoring: Failed 
to initialize the monitoree interface.

Internal EC Error Verify the local ORBacus Naming Service 
is operating normally. If the problem 
persists, contact Avaya customer 
support.

EC.DMConnectionProblem: 
Connection to DataManager Lost

The DataManager 
process has 
unexpectedly 
terminated or a 
networking problem 
exists.

Verify that the DataManager process is 
running. Verify that there are no 
networking problems between the system 
where the Event Collector is running and 
the system where the DataManager 
process is running.

EC.DMConnectionProblem: Failed 
to establish connection to DM 
within 5 minutes of initial ECServer 
startup.

The Event Collector 
cannot establish a 
connection to the 
DataManager 
process.

Verify that the DataManager process is 
running. Verify that there are no 
networking problems between the system 
where the Event Collector is running and 
the system where the DataManager 
process is running.

EC.EstablishedDataManager 
Connection: Connection to 
DataManager has been 
established.

EC has successfully 
established 
connectivity to its 
associated data 
manager

No action required.

Alarm message Description Resolution
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EC.ICMapperControllerFailed: An 
unexpected failure occurred in the 
EC process.

EC will be 
automatically 
shutdown and 
restarted. Additional 
details regarding 
the failure will be 
included in the error 
message.

Contact Avaya customer support.

EC.ICMapperControllerFailed: 
Memory allocation failure, 
requesting EC shutdown

EC ran out of 
memory during 
normal execution or 
the heap is 
corrupted.

The server hosting EC may not have 
been configured with sufficient memory. 
Verify the host server has sufficient RAM. 
If the problem persists, contact Avaya 
customer support.

EC.ICProxyInitFailure, emergency, 
Failed to initialize Media Queue 
ADU proxy

This indicates that 
the EC server was 
unable to assign an 
ADU server to proxy 
media queue 
events.

Verify that the EC server�s domain 
contains an ADU server in its failover 
path. Refer to Avaya Interaction Center 
Release 6.1 Installation Planning and 
Prerequisites for more information.

EC.ICProxyInitFailure: "Maximum 
number of ADU proxies has been 
exceeded. Use the 
MAX_AGENT_ADU_DOMAINS 
property to increase this number.

The Event Collector 
has been 
configured to 
monitor too many 
agent ADU servers.

Use IC Manager to decrease the number 
to �Domains to Monitor� for the Event 
Collector or use IC Manager to configure 
a value for 
MAX_AGENT_ADU_DOMAINS which 
will be sufficient for monitoring the 
requested number of agent ADU servers.

EC.ICProxyInitFailure: Assign to 
local ADU server failed. Verify 
ADU server is configured correctly.

EC was unable to 
connect to the local 
ADU Server

Using IC Manager, verify that the local 
ADU server is properly administered and 
is running.

EC.ICProxyInitFailure: Failed to 
initialize DS proxy

Internal failure. Contact Avaya customer support.

EC.ICProxyInitFailure: Failed to 
initialize ECBridge proxy

Internal failure. Contact Avaya customer support.

EC.ICProxyInitFailure: Failed to 
initialize local ADU proxy.

Internal failure. Contact Avaya customer support.

Alarm message Description Resolution
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EC.ICServerFailure:Unexpected 
IC server failure

The IC CORBA 
infrastructure 
notified Event 
Collector (EC) that 
one of the required 
IC Servers failed 
(for example, ADU 
Server, Directory 
Server).

In normal operating conditions the 
condition will be transient and EC will 
recover without any external intervention. 
If the problem persists, verify:
● The network is operating normally.
● All required servers are operational (no 

machines crashed).
● EC server and required IC servers (for 

example, ADU Server, Directory 
Server) are properly configured. If the 
problem persists, contact Avaya 
customer support.

EC.ICServerSuccessfulAssign: 
<Server>.assign: Successfully 
assigned to server.

This is normal and 
expected during 
startup.

No action required.

EC.LostDataManagerConnection: 
Connection to DataManager was 
lost.

The EC connection 
to its associated 
data manager 
process failed.

Under normal conditions EC will recover 
the connection to the data manager. If the 
problem persists for more than a couple 
of minutes, verify:
● The associated data manager is 

executing and is reachable (ping the 
data manager host machine) 

● The ORBacus Naming Service is 
operational.

● If the problem persists, contact Avaya 
customer support.

EC.MTTVersionMatch: MTT 
BuiltWith version does not match 
the RunningWith version.

Informational alarm 
indicating that the 
�builtwith� version of 
the IC Multithreaded 
toolkit does not 
match the version 
that the Event 
Collector is 
currently 
�runningwith�.

This is not necessarily a problem. 
However, Avaya customer support may 
want to know if this alarm is occurring if 
other problems are also reported.

Alarm message Description Resolution
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EC.MultipleWAAMonitors: There 
are multiple ECServers configured 
to monitor the WAA

More that one Event 
Collector has been 
configured to 
monitor the IC WAA 
events. There 
should only be one 
running Event 
Collector that is 
doing this. If there 
are multiple 
monitors, email/chat 
queue status counts 
may be incorrect.

Make sure that only ONE running Event 
Collector has the �Monitor WAA� option 
selected.

EC.NoWAAMonitor: There are no 
ECServers configured to monitor 
the WAA

No Event Collectors 
have been 
configured to 
monitor the IC WAA 
events.

Make sure that one Event Collector has 
the �Monitor WAA� option selected.

EC.ORBacusInitialize: Couldn�t 
start the CORBA event loop.

EC failed to initialize 
its CORBA 
infrastructure.

The most likely cause of this problem is 
an improper installation of EC. Reinstall 
EC per Avaya Operational Analyst 
Release 6.1 Installation and 
Configuration and restart. If the problem 
persists, contact Avaya customer 
support.

EC.ORBacusInitialize: Failed to 
initialize ORB server.

EC failed to initialize 
its CORBA 
infrastructure.

The most likely cause of this problem is 
an improper installation of EC. Reinstall 
EC per Avaya Operational Analyst 
Release 6.1 Installation and 
Configuration and restart. If the problem 
persists, contact Avaya customer 
support.

EC.PropertyReadError: Failed to 
read server properties.

Internal failure. Contact Avaya customer support.

EC.ProxyAssign: Failed to set the 
ADU proxy assign criteria.

Internal failure. Contact Avaya customer support.

EC.PumpUpFailure: <ECServer>: 
PumpUp Failed.

Internal failure. Contact Avaya customer support.

EC.PumpUpFailure: ADU 
pump-up failed

Internal failure. Contact Avaya customer support.

EC.PumpUpFailure: DS pump-up 
failed

Internal failure. Contact Avaya customer support.

EC.PumpUpFailure: ECBridge 
pump-up failed

Internal failure. Contact Avaya customer support.

Alarm message Description Resolution
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EC.PumpUpFailure: Failed to 
send default queue service class 
events.

Internal failure. Contact Avaya customer support.

EC.PumpUpFailure: Invalid state 
transition from 
PUMPUP_STATE_COMPLETE

Internal failure. Contact Avaya customer support.

EC.PumpUpFailure: PumpUpState 
transition from invalid state 
(<state>)

Internal failure. Contact Avaya customer support.

EC.PumpUpFailure: PumpUpState 
transition from 
PUMPUP_STATE_FAILED

Internal failure. Contact Avaya customer support.

EC.PumpUpStarted: <ECServer>: 
PumpUp Started.

A PumpUp has 
started.

This is normal and is expected during a 
normal PumpUp.

EC.PumpUpSuccessful: 
<ECServer>: PumpUp Successful.

A PumpUp has 
successfully 
finished.

This is normal and is expected during a 
normal PumpUp.

EC.QueueHighWater: ECQueue: 
queueName has reached the high 
water mark.

The named queue�s 
size has exceeded 
the configured 
warning threshold.

Verify:
● Network throughput to data manager is 

adequate.
● Data manager is operating normally 

and has adequate server resources 
(for example, memory, CPU).

● EC process is getting adequate server 
resources (for example, memory, 
CPU). If the problem persists, contact 
Avaya customer support.

EC.QueueSizeLimit:ECQueue: 
queueName has encountered a 
queue limit exception

The named queue 
has exceeded its 
configured 
maximum size limit 
due to a 
performance 
bottleneck.

Verify:
● Network throughput to data manager is 

adequate
● Data manager is operating normally 

and has adequate server resources 
(for example, memory, CPU)

● The EC process is getting adequate 
server resources (for example, 
memory, CPU). If the problem persists, 
contact Avaya customer support.

Alarm message Description Resolution
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Event Collector Bridge alarm messages

Alarm message Description Resolution

ECB.CannotChangeRunTimeDir: 
Failed to set run time directory to: 
<directory>

Could not set the 
current run time 
directory.

Make sure that the specified <directory> 
exists.

ECB.CannotConnectToMSMQ: 
<ECBServer>: Cannot open 
MSMQ: <msmqname> Error: 
<errornumber>

Failed an MSMQ 
connection.

Make sure that the specified MSMQ exists 
and does not have permissions set that 
would prevent the Event Collector Bridge 
process from connecting to it.

ECB.CannotResolveMSMQName: 
Failed to resolve MSMQ format 
name for <msmqname>

Failed an MSMQ 
connection.

Make sure that the specified MSMQ exists.

ECB.ConnectedToMSMQ: 
<ECBServer>: Successful 
connection to MSMQ: 
<msmqname>

Indicates a 
successful 
connection to the 
specified MSMQ.

This is expected during normal operation.

ECB.FailedAdvocateProxyInit: 
Failed to initialize the 
AdvocateProxy object.

Failed to initialize 
the Advocate 
interface objects.

Make the Event Collector Bridge is running 
on system which is also running Avaya 
Business Advocate. Make sure that the 
PumpUpApp.dll is registered (regsvr32 
PumpUpApp.dll).

ECB.FailedECBridgeInit: FATAL - 
Failed to initialize the ECBridge 
object.

Internal failure. Contact Avaya customer support.

ECB.GeneralInitFailure: FATAL - 
Exception thrown while creating 
one or more ECBridge objects.

Internal failure. Contact Avaya customer support.

ECB.LostMSMQConnection: Lost 
connection to MSMQ: 
<msmqname>

MSMQ or network 
failure has caused 
the loss of an 
MSMQ 
connection.

Verify that MSMQ is up an running OK. 
Verify that there are no networking 
problems between the system where the 
Event Collector Bridge is running and the 
system where the MSMQ it is monitoring 
exists.

ECB.MSMQAlreadyOpen: 
<ECBServer>: <msmqname>: 
already open for exclusive access. 
Running in Standby mode for now.

"Informational 
alarm.

This is normal and expected for any Event 
Collector Bridge that is running in Standby 
mode.
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ECB.MTTVersionMatch: MTT 
BuiltWith version does not match 
the RunningWith version.

Informational 
alarm indicating 
that the �builtwith� 
version of the IC 
Multithreaded 
toolkit does not 
match the version 
that the Event 
Collector is 
currently 
�runningwith�.

This is not necessarily a problem. However, 
Avaya customer support may want to know 
if this alarm is occurring if other problems 
are also reported.

ECB.PumpUpFailure: Failed to 
signal PumpUp start: 
<error_message>

Internal failure. Contact Avaya customer support.

ECB.PumpUpFailure: Failed to get 
Process Map admin data: 
<error_message>

Internal failure. Contact Avaya customer support.

ECB.PumpUpFailure: Failed to get 
Service Goals admin data: 
<error_message>

Internal failure. Contact Avaya customer support.

ECB.PumpUpFailure: Failed to get 
Service Class admin data: 
<error_message>

Internal failure. Contact Avaya customer support.

ECB.PumpUpFailure: Failed to get 
Agent admin data: 
<error_message>

Internal failure. Contact Avaya customer support.

ECB.PumpUpFailure: Exception 
occurred during PumpUp. 

Internal failure. Contact Avaya customer support.

ECB.PumpUpFailure: Failed to 
signal PumpUp end: 
<error_message>

Internal failure. Contact Avaya customer support.

ECB.XMLParseError: Unable to 
process an administration event.

Internal failure. Contact Avaya customer support.

Alarm message Description Resolution
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Error messages
Avaya OA utilizes a central error logging concept for tracking warning and error conditions 
that occur. When a warning or error occurs, OA records a message in a log file on the local 
machine. Event, audit and alarm messages are also recorded into this log file.

This section includes the following topics:

● Windows message log on page 94

● Solaris and AIX message log on page 96

● Windows Internet Information Services (IIS) message log on page 97

● Common error messages on page 98

Windows message log
On Windows systems, the messages are logged by the Event Log Service. In order for OA 
to log the messages, the Event Log Service must be running. This service is generally 
started automatically.

To verify the Event Log Service is running on the OA server:

1. Select Start > Programs > Administrative Tools > Services.

2. Look for EventLog.
The status of this service should be Started. If it is not, highlight the service and click 
Start to start the process.

This section includes the following topics:

● Configuring the log on page 94

● Viewing the log on page 95

Configuring the log

Many Windows applications log messages into the Event Log, including OA. If the log file 
reaches capacity, no more messages can be stored, possibly resulting in the loss of 
valuable troubleshooting information. To ensure adequate log file space, you should 
increase the log size to at least 2 MB.

To increase the size of the log:

1. Select Start > Programs > Administrative Tools > Event Viewer.
2. Select Application Log from the tree-view.

3. Select Action > Properties.
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4. Enter the desired size in the Maximum log size text box.

5. Select OK to save your change.

You can specify the behavior the Event Log exhibits when the log file reaches capacity by 
choosing one of the options in the When maximum log size is reached section of the log 
properties dialog:

● Overwrite events as needed results in removing the oldest message when a new 
message is written. 

● Overwrite events older than X days may result in the log file reaching capacity, 
depending on message volume, log file size, and the number of days specified.

● Do not overwrite events (clear log manually) results in the log file reaching capacity 
unless you monitor and maintain it regularly.

Carefully consider which option fits your system requirements, and maintain the log file 
appropriately by saving its contents to a file and then clearing the file on a regular basis.

Viewing the log

The central error log messages can be viewed using the Event Viewer, which allows users 
to view events on the local machine. Users can also view events of other machines on the 
network.

To view events:

1. Select Start > Programs > Administrative Tools > Event Viewer.
2. Select Application from the Log menu to view the application log.

You can select individual events and double-click them to see event details. Warning, 
error, event and audit messages are logged into the event log, as well as alarm 
messages that have also been forwarded to the Alarm Manager.

In the Event Viewer, the Source value of OA messages is usually prefixed with OA_ to 
facilitate filtering OA messages. Messages are assigned a Type based on their priority. 
This table describes the assignments.

Note:
Note: Audit messages pertain to security events such as logon on the 

Administration client or accessing secure files.

Type Priority Message content Icon

Error High Alarms, high severity errors Red stop sign

Warning Medium Warnings, event level messages Yellow !

Information Informational Informational and audit messages Blue i
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Solaris and AIX message log
On Solaris and AIX, the error, warning, event and audit messages are logged in a central 
error log file that can be viewed by editing the file with any text editor. The file is a simple 
text file that resembles the trace log files. There is no log viewer for viewing these 
messages. The central error log file resides in the $PABASE/data/log/CentralError 
directory and is named CentralErrorLog.log.

! Important:! Important:
Important: The permissions on the CentralErrorLog.log file must match the group 

and user IDs created to install the OA software. If the permissions are not 
correct on this file, no log entries will be written to the file.

The messages in the central error log for Solaris and AIX are prefixed with priority and 
severity indicators to help track conditions that require immediate attention. The priority 
indicators are:

● ALARM
● ERROR
● EVENT
● AUDIT
and the severity indicators are:

● emergency
● high
● low
● info
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Windows Internet Information Services (IIS) message log
The Windows Internet Information Services (IIS) has its own logging mechanism. When 
running OA reports, log entries are created each time a basic report is accessed and each 
time that a basic real-time report is refreshed. When a large number of reports are 
accessed, the IIS log files can grow to a large size and consume large amounts of disk 
space. These log files grow progressively because IIS has no mechanism in place to 
automatically remove older files. If disk space becomes full, this can impact performance of 
OA processes on that system. Therefore, one of the following should be done:

● Turn off logging for the OA reports. If this logging is turned off, no log entries will be 
written for any OA Basic report access or report refresh.

● Administer IIS to create these log files on a disk partition dedicated solely to report 
logging. If this disk becomes full, there will be no performance impact to OA or Basic 
reports, but no reporting messages will be written to the log files.

● Continually monitor the disk space consumed by these log files and purge files as 
needed.

If you create a dedicated disk partition to contain IIS log files, follow these steps to change 
the IIS logging directory:

1. As an Administrator, start the Internet Service Manager.

2. Expand the tree to servername > Default Web Site.

3. Right click on Default Web Site and choose Properties.

4. Under the Web Site tab of the Default Web Site Properties window, click on the 
Properties box.

5. In the General Properties tab of the Extended Logging Properties window, under 
Log file directory enter the directory into which logs are to be created.
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Common error messages
This section lists common error messages and possible solutions.

Message Description Resolution

+ Mar 20, 2003 23:55:07.411 
[pid=2528] [Pollin]:
DBOperations::readSchedWork: 
couldn't get work items 
java.sql.SQLException: 
connection exception - 
communication link failure

The scheduler is not 
running, there are SQL 
exceptions, the database is 
not available, or you cannot 
connect to the database.

The database has been 
restarted and you must 
restart OA.



Troubleshooting the TimesTen database

Issue 1.0 August 2003 99

Troubleshooting the TimesTen database
TimesTen is the physical database that hosts the OA real-time database. This section 
provides some information about troubleshooting TimesTen. For information about 
monitoring the TimesTen database, see Monitoring the TimesTen database on page 56.

This section includes the following topics:

● General TimesTen problems on page 99

● TimesTen will not start on page 99

● TimesTen data store corruption on page 100

● TimesTen data store repair on page 100

● Cannot connect to the TimesTen database on page 101

General TimesTen problems
To troubleshoot other general problems with TimesTen, refer to the TimesTen JDBC Guide. 
This manual is in files JDBCguide.pdf.

TimesTen will not start
Symptom - The TimesTen database will not start.

Solution - Review the TimesTen log files for clues about the cause of the problem. The 
most common reasons for failure are listed in this table:

Reason for failure Corrective action

Inadequate paging file size Set the paging file (swapfile) to 150% - 200% of the 
RAM installed in your system.

Database corruption See TimesTen data store repair on page 100.

C:\temp directory does not exist. Set the TEMP and TMP environment variables to 
point to the desired "temp" directory.
If TimesTen still does not start, create C:\temp.
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TimesTen data store corruption
Symptom - It is possible for the TimesTen database to get into an inconsistent state that 
will prevent applications from connecting to it. There are a couple of ways to detect that 
this has happened. The first is that the data manager and/or data server processes will not 
complete initialization, or will fail after initialization. In this case these processes will report 
one or more of the following errors:

● RT_359: Unable to connect to TimesTen DB

● RT_129: Unable to recover from error encountered processing a database request; The 
RT Service is being shutdown to initiate recovery.

● TimesTen error message: data store segment inconsistent and corrupt

The second way to detect and/or confirm that there is a TimesTen database problem is to 
attempt to connect to it using the ttIsql utility. To do that, perform the following at the 
Windows command prompt:

ttIsql

connect "dsn=dss128";

Solution - If, after step 2, ttIsql reports an error connecting to the database, or reports 
that a recovery is under way and that recovery does not complete in a reasonable amount 
of time, then it is likely that the database is corrupt and must be rebuilt from scratch.

TimesTen data store repair
Symptom - The Event Log on the real-time server shows repeated errors from the 
TimesTen data manager indicating that the data store segment is inconsistent and corrupt. 
Repeated efforts to connect to the database fail.

Solution - A manual procedure may be necessary to recover from this situation.

Action Details

Stop the real-time data 
manager and data server

Use the Administration client Interface Services 
screen to disable the data manager

Move all TimesTen files to 
another location (they may 
be needed later to diagnose 
specific problems).

The TimesTen files are located in %PABASE%\
add_on\TimesTen (Windows) or $PABASE/
add_on/TimesTen (Solaris and AIX).The 
filenames have the pattern rtpa.txt.*.
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Cannot connect to the TimesTen database
Symptom - Data Manager fails to run after installation, upgrade, or modify because it can�t 
connect to the TimesTen database. The following error messages appear in the Central 
Error Log:

<DataManager.OA:RT:DataManager:> [pid=1813] ALARM - emergency:
DataManager OA:RT:DataManager: 0=DBService:initialize:
RT_359:Unable to connect to TimesTen DB.

<DataManager.OA:RT:DataManager:> [pid=1839] ERROR - high:
DataManager OA:RT:DataManager: 0=DBService:initDataBase:
RT_359:Unable to connect to TimesTen DB. : java.sql.SQLException:
[TimesTen][TimesTen x.x.xx ODBC Driver]Data source name not found
and no default driver specified

Solution - From a command prompt:

1. Enter the following commands:

cd /var/TimesTen

cp sys.odbc.ini sys.odbc.ini.backup

cat sys.odbc.ini.old >>sys.odbc.ini

2. Restart Data Manager.

Force the re-creation of the 
TimesTen database

From the command prompt:
ttIsql
connect "dsn=dss128;OverWrite=1";
exit;

Start the real-time data 
manager and data server

Use the Administration client Interface Services 
screen to enable the data manager. The data store 
should recover and a pump up will be initiated 
automatically.

Action Details
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Troubleshooting the historical database
This section describes symptoms seen when troubleshooting the historical database.

This section includes the following topics:

● Interval aggregation exceeds 30 minutes on page 102

● System-scheduled purge fails on Oracle on page 103

● Open cursors exceeded on Oracle on page 104

● Authentication adapter initialization failed on page 104

● CMS data not aggregated on page 105

● Incomplete aggregation on page 105

● Forwarder and recorder not transferring data on page 106

● SQL problems after an upgrade on page 106

● DB2 log files on page 107

● Running out of space on DB2 on page 108

● DB2 limit on SQL statement length on page 109

Interval aggregation exceeds 30 minutes
Symptom - Interval aggregation time exceeds 30 minutes.

Interval Aggregation must complete within 30 minutes for OA to work properly. If your 
aggregation time is approaching 30 minutes or has exceeded 30 minutes then this 
indicates a performance problem that needs to be addressed. 

Solution - Slow aggregation times usually equate to a database performance problem.   
To determine the cause of a database problem run a performance monitoring tool on the 
database server to locate the server resource that is being over utilized. Run the 
performance monitoring tool during the time when Aggregation is running slowly.

Disk I/O - The most common database issue will be a disk contention problem caused 
by having more than one high activity table (either DBMS internal files such as temp 
space or transaction logs, or OA tables such as HISTCMSAGENT) physically located 
on the same disk drive. To determine where you have a disk contention problem:

- Solaris and AIX: Run the iostat -xnP 5 command. This command reports the 
disk and tape I/O activity on your server and refreshes every 5 seconds. The %b 
column in the output indicates the percent of time the disk is busy. Disks running at 
or near 100 are being over-utilized. 
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- Windows: Run the Performance monitoring tool under Administrative Tools and 
select the Physical Disk as the performance object. Any disk with an Average Disk 
Queue Length greater than 2 and a Disk Transfers/sec. greater than 100 is a 
bottleneck.

Once you have determined which disk is causing performance problems, look at the 
OA data files and internal DBMS files that co-reside on that disk. The files that are 
updating the most frequently will be the cause of the disk contention. Move one or 
more of these files to an underutilized disk to improve performance.

Scheduled Database Jobs - The Purge, Aggregation Recovery, and Database Check 
jobs can cause database contention that slows down Interval Aggregation. Try to 
schedule these jobs to run during periods of low database activity to minimize the 
performance impact on Interval Aggregation.

System-scheduled purge fails on Oracle
Symptom - System scheduled Purge fails on Oracle with the following errors in the Event 
Log:

ORA-01562: failed to extend rollback segment
ORA-01650: unable to extend rollback segment
Skipping this table or dataType.

Purge is failing due to insufficient disk capacity in the Oracle Rollback segment to 
accommodate a large Purge transaction.In a normal scenario, the retention period for data 
can be engineered to maintain tablespaces at the recommended 20% minimum free 
space. This involves one of the following approaches:

● When longer data retention is wanted and disk space is sufficient, additional datafiles 
are added to the tablespace to provide capacity; or

● Tune retention periods for target data store types to maintain the data at a volume that 
is 20% less than the space available to the specific tablespace.

The latter approach involves maintaining retention periods and tablespaces consistent with 
the initial configuration (as recommended by the PSO).

The problematic scenario involves a configuration where insufficient disk capacity exists in 
the Rollback segment to accommodate a potentially large transaction by Purge. This may 
cause System Scheduled Purge failure when retention periods are reduced to address 
capacity issues. Logic exists in Purge to breakdown potentially large transactions into 
manageable transaction sizes. This mechanism can be exploited to address the failed 
Purge condition.



Troubleshooting OA components

104 Avaya Operational Analyst R6.1 Maintenance and Troubleshooting

Solution - To correct this, do the following prior to execution of the next Scheduled System 
Purge:

1. Reduce Retention values for target store types to engineered values in Administration 
client: Retention Periods.

2. Use sqlplus to execute the following queries:

update cvxconfig set value conf_value = 1

where conf_name='PURGE_MAX_BASE_RANGE';

update cvxconfig set value conf_value = 1

where conf_name='PURGE_MAX_AGG_RANGE';

3. Verify successful execution of System Scheduled Purge.

4. After successful System Scheduled Purge, use sqlplus to execute the following 
queries:

update cvxconfig set value conf_value = 7

where conf_name='PURGE_MAX_BASE_RANGE';

update cvxconfig set value conf_value = 7

where conf_name='PURGE_MAX_AGG_RANGE';

Open cursors exceeded on Oracle
Symptom - The following message is displayed:

Solution - The Oracle database administrator should increase the value of the 
open_cursor parameter in the Oracle server.

Authentication adapter initialization failed
Symptom - The forwarder or recorder for the Oracle OA historical database may report 
the following error: �Authentication adapter initialization failed.�

This occurs because Oracle uses the Windows Network Authentication Service to 
authenticate the OA forwarders ODBC connection to the DB, and the server network 
domain configuration is set up incorrectly. 

Solution - For details about how to set up an Oracle client/server network configuration 
with security authentication on Windows, please refer to the Oracle Net8 Administration 

ORA-01000: maximum open cursors exceeded
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Guide. As an alternative �quick fix� to circumvent this potentially complicated task, we 
suggest disabling this authentication by modifying the Oracle ../network/admin/
sqlnet.ora file to comment out the �SQLNET.AUTHENTICATION_SERVICE = (NTS)� 
line.

CMS data not aggregated
Symptom - CMS data may not be aggregated if CMS clock is far out of sync with OA

If the CMS master ACD clock is later than the OA clock, transfer of CMS data to OA may 
not complete in time for the scheduled Interval Aggregation job. This may prevent some of 
the CMS data from being aggregated. If the Aggregation Recovery job is enabled, the data 
will be automatically recovered within a day. If the Aggregation Recovery job is not 
enabled, the user will need to schedule an Aggregation job to recover lost data.

Solution - This problem can be avoided by periodically resetting the CMS master ACD 
clock to match the OA clock. The switch ACD software does not currently allow for 
automatic synchronization with OA, so this must be done manually when necessary.

Incomplete aggregation
Symptom - Interval Aggregation may start before CMS interval data has finished 
transferring, causing incomplete aggregation.

This occurs if the amount of time CMS takes to archive the interval data, plus the amount 
of time it takes to transfer the data over the network, is longer than the aggregation offset 
time administered on OA. The default aggregation offset is 10 minutes.

Solution - In order to properly tune this offset, use Container Status Administration to view 
the Last Updated column of the Base Interval Data collection. Check the Last Updated 
time for a few intervals during the busy hour and adjust the scheduled start time of regular 
aggregation to be a minute or two after the latest Base Interval completion time. Large 
CMS customers may have to set this value to as much as 25 minutes.Incomplete 
aggregations will be recovered automatically if the Aggregation Recovery job is enabled, or 
they can be recovered manually by scheduling an Aggregation job when database activity 
is low.
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Forwarder and recorder not transferring data
Symptom - Data missing for a particular data store. Running dcstat -n or checking the 
log file for the particular data store produces errors similar to the following:

● can't insert NULL

● invalid number

● data truncation

Solution - Disable the forwarder, remove the forwarder's buffer file, then enable the 
forwarder. If the problem persists, contact services.

Symptom - Data may overfill a forwarder-recorder datastream and data will not be 
updated in the historical database. You will probably see a database error indicating bad 
data (for example, �can't insertNULL�, or �invalid number�). This error will persist and no 
data will be recorded.

Solution - The workaround is to disable the forwarder, remove the forwarder's data 
storage file, then enable the forwarder. This has only been seen with the displaynames 
forwarder so no data is lost because the forwarder updates all of the display names data 
when it restarts.

SQL problems after an upgrade
Symptom - After an upgrade scenario with an SQL database and application of SQL 
Service Pack 3, the following error may appear for all recorders (in this case 
recdisplaynames):

ALARM - emergency: OA recdisplayname 1080=AgentInfo@qebi2450j: (5)
SQL call failed. 53, -1, 08001, [Microsoft][ODBC SQL Server
Driver][DBNETLIB]SQL Server does not exist or access denied. ** AND
** [Microsoft][ODBC SQL Server Driver][DBNETLIB]ConnectionOpen
(Connect()). MSSQL Database installation followed by SP3
application may change ODBC Data Source Attributes

This results from the application of SP3 to the MSSQL database modifying Data Source 
attributes.

Solution - Do the following:

1. Update the Network Port for the OA ODBC Data Source.

If not known, determine Server Network Default Port. On the database server:
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a. Go to Programs > Microsoft SQL Server > Server Network Utility. 

b. Choose the OA database instance. 

c. Select TCP_IP. 

d. Select Properties. 

e. Note the port number.

2. Update the ODBC Data Source Network Port:

a. Go to Programs > Administrative Tools > Data Sources (ODBC).
b. Select the System DSN tab. 

c. Double-click PA_DSN. 

d. Press Next through the first window. 

e. On the second window, select the Client Configuration button. In this window, click 
Dynamically determine port twice. This will allow port entry. Enter the noted port 
number. 

f. Select OK. 

g. Select Next (getting to this window verifies ODBC connectivity to the database). 

h. Select Next. 
i. Select Finish.

DB2 log files
To aid in troubleshooting problems with the DB2 database, check for error conditions in the 
following log files:

● $PABASE/data/log/dbsetup for OA database setup

● /home/db2inst1/sqllib/db2dump/db2diag.log for diagnostic log

● /tmp/db2setup.log for sofware installation

● /tmp/dasicrt.log for administration server creation

● /tmp/db2icrt.log for instance creation
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Running out of space on DB2
The following table provides solutions for a variety "out of space" error messages that you 
may see in the db2diag.log file.

Message Description Solution

Tablespace 3 
(TEMPSPACE1) is full

You need to add a container 
to tablespace, in this case 
the tempspace tablespace.

● Use db2 list tablespaces
show detail to verify that the 
tablespace is full.

● Use a control center to add additional 
containers to the tablespaces. The 
database will rebalance load among 
all new containers, this will take 
several minutes.

DIA3612C Disk was full One or more tablespaces 
are full.

● If the tablespace is SMS, increase or 
grow the filesystem or volume.

● If the tablespace is DMS, Use a 
control center to add additional 
containers to the tablespaces. The 
database will rebalance load among 
all new containers, this will take 
several minutes.

DIA3609C Log file was full Existing logs are not 
sufficient to accommodate 
the current transaction.

●  Increase the number of primary and 
secondary log files. 

● Increase the size of existing log files 
(you do not want to make them too 
large in order to avoid wasting 
space).

● Restart the database (this will kill all 
connections to the database).
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DB2 limit on SQL statement length
Symptom - A large percentage of OA customers who use the DB2 database and make 
use of OA containers with basic historical reports are likely to experience a problem 
stemming from a limitation of the DB2 database. The nature of the limitation is that DB2 
imposes a limit on the maximum length of SQL statements that it will accept. It is a fixed 
limit that cannot be tuned or adjusted.

OA customers impacted will see the problem as an inability to successfully aggregate their 
OA container data. In this circumstance, the following error message is generated by DB2 
and written to the aggregation log file:

COM.ibm.db2.jdbc.DB2Exception: [IBM][CLI Driver] CLI0118E Invalid
SQL syntax. S QLSTATE=37000

This aggregation failure in turn affects historical reports that access aggregated data since 
the needed aggregated data is unavailable.

Solution - The following guidelines are intended to provide customers some guidance on 
how to minimize the chance they will encounter the DB2 SQL length limit problem. These 
measures do not resolve the problem; they are work-around actions customers can take to 
help mitigate the problem. Be cautioned that they may not work in all cases, since they are 
based on estimates for a hypothetical typical customer.

● The general rule, if the DB2 SQL length problem is encountered, is to redefine 
containers to include all objects (other than agents) when possible, or alternately to 
include a smaller number of objects. Either of these techniques will reduce the SQL 
statement length.

● For CMS containers, define them so they are independent of the data source, that is, 
they hold data for the defined objects from all data sources. This will maximize the 
number of objects allowed per container. As an example of this for VDNs, define VDN 
containers so they are independent of the data source (holding data for the defined 
VDNs from all data sources).

● If it is not acceptable to define CMS containers independent of data source, next best is 
to define each container to have data from only a single source. This implies defining 
more containers, each with data from a single source. As an example of this for VDN 
containers, define each container to have data from only a single source.

● If CMS containers must contain data from multiple data sources, limit the number of 
other objects defined per container. This implies defining more containers, each with 
fewer objects. As an example of this for VDN containers, limit the number of VDNs 
defined per container.

● Similarly, for CMS container definitions with rules based on VDNs, CWCs, or Splits, it is 
beneficial to either:

- define the container to include all VDNs, CWCs or Splits when that satisfies the 
customer need, or
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- reduce the numbers of VDNs, CWCs or Splits in the container definition. This implies 
defining more containers, each with a narrower scope of data.

● In IC agent containers, define them to include all dialers or service classes if possible. 
This will maximize the number of agents allowed per container.

● If it is not acceptable to include all dialers or service classes, then minimize the number 
of service classes, dialers and jobs defined per container. This will also increase the 
number of allowable agents. Use the analysis results shown in DB2 limit on SQL 
statement length on page 46 in Avaya Operational Analyst Release 6.1 Installation 
Planning and Prerequisites as a guideline. This implies defining more containers, each 
with a narrower scope of data.

● For both IC and CMS agent containers, if the preceding guidelines are not sufficient, 
limit the number of agents defined per container, using the referenced analysis results 
as a guideline. This again implies defining more containers, each with fewer agents.

● For IC containers other than for agents, a general statement for those that contain more 
than one object type is that minimizing the number of one of the object types will allow 
maximizing the other object type. For example, in Job and SysComp containers, 
minimizing the number of dialers defined per container will allow more jobs to be defined 
per container.

● Another potential option exists, that of reporting on unaggregated data. However, this is 
not thought to be a very useful option for customers because the time scale of all 
historical reports will be one-half hour intervals. This means that rather than seeing 
historical data summarized on a report by day, or week, or month, it will be presented by 
the half hour (base interval). For example, to see data for a 24-hour day, data for each 
of 48 half-hour intervals will be shown. This amount of data will clutter the report and 
make it very hard to interpret, spot historical trends, etc. Again, this will not be a viable 
option for the vast majority of customers, and perhaps none.
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Data manager, report data server, and central report 
data server

The data manager stores data originating in IC into the real-time database. Real-time data 
is used in real-time reports and is also forwarded to the historical database. If real-time 
reports do not reflect current data, or if the real-time database appears to be missing data, 
there may be a problem with the data manager process. It may be improperly 
administered, or it may not be in an operational state. Check data manager status via the 
Administration client (see the Administration Client Help) or by using the pa command.

Report data server (RDS) provides up-to-date data to the real-time reports. It monitors the 
real-time database for changes to data and forwards the changes to the Report 
subsystem. If real-time reports do not reflect current data, there may be a problem with the 
data server process. It may be improperly administered, or it may not be operational. 
Check data server status via the Administration client (see the Administration Client Help) 
or by using the pa command.

This section includes the following topics:

● Data manager, RDS, or CRDS fails on page 112

● CRDS troubleshooting on page 113
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Data manager, RDS, or CRDS fails
If the data manager, RDS, or central report data server (CRDS) fail to start or fail after 
initially starting, take these actions:

1. Check the process logs for details about the failures. The logs are:

and are located in:

See Trace files on page 67 for more information on tracing and logging.

2. Verify that the Orbacus Naming Service is running and operational. See 
Troubleshooting map on page 33 for details.

3. Verify that TimesTen is running by looking for the TimesTen Data Manager service in 
the services log.

4. If TimesTen is available and operational, use ttIsql to verify TimesTen is accessible. 
See TimesTen data store corruption on page 100.

5. If ttIsql cannot access TimesTen, see Troubleshooting the TimesTen database on 
page 99.

6. If you receive an alarm message, see Alarm messages on page 70 for an 
interpretation of the message.

Data manager datamanager\dmTrc.log (Windows)
datamanager/dmTrc.log (Solaris and AIX)

RDS dataserver\dsTrc.log (Windows)
dataserver/dsTrc.log (Solaris and AIX)

CRDS dataserver\CRDSTrc.log (Windows)
dataserver/CRDSTrc.log (Solaris and AIX)

Windows %PABASE%\data\log

Solaris and AIX $PABASE/data/log



Data manager, report data server, and central report data server

Issue 1.0 August 2003 113

CRDS troubleshooting
Symptom - Reports only display data from one real-time source.

Solution - This will happen if the CRDS temporarily looses a connection to one of the 
RDSs on one of the real-time sources. If this problem persists, do the following:

1. Using the Administration client, verify that a CRDS is enabled. This will happen 
automatically when more than one real-time source is enabled. First, look in the 
Interface Services tab under OA Administration. Verify that there are at least two Data 
Managers and two RDS interface service types added and enabled. If these do not 
exist, add them at this time.

2. Look in the Subsystems under OA Administration on the Administration client. Verify 
that at least one Report subsystem has been added. If a Report subsystem does not 
exist, add a Report subsystem at this time.

If the Report subsystem either exists, or has been added, verify that a CRDS Interface 
Service type exists and is synchronized under the Interface Services tab. 

If all of the above steps have been verified and the reports still only display data from one 
of the real-time sources, check to see if an error has been logged in either the Event 
Viewer for Windows or the Central Error log for Solaris and AIX. Check for an error 
indicating that the CRDS has lost a connection to one of the RDSs. If this is the case, the 
CRDS should restore the connection when the RDS becomes available.
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Symptom - There is an error indicating that the CRDS does not have any RDS 
connections to respond to requests. 

Solution - Verify that the RDS instances are running using either the Administration client, 
or the pa command. If they are not running, start the RDS instances. If the problem 
persists, restart the CRDS process.
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Troubleshooting data collection problems
Avaya OA can collect data from several sources, including a CMS server or an Avaya IC 
event collector server (also known as EC or Source-EC). This section describes ways to 
troubleshoot problems when collecting data from these sources.

This section includes the following topics:

● CMS subsystem problems on page 115

● Event Collector failures on page 116

● Event Collector Bridge failures on page 118

CMS subsystem problems
This section describes symptoms and solutions for specific problems with the Source-CMS 
subsystem.

Symptom - When running the dcstat command on CMS forwarders, the following 
message is displayed:

Description - This error has been seen on R3V9 versions of CMS. The installation of the 
CMS source subsystem on the CMS will add parameters to the onconfig.cms and 
sqlhosts files in order for the forwarders to connect to the Informix IDS database. The 
onconfig.cms and sqlhosts files are only read when IDS is brought on-line. For more 
information about the dcstat command, see Forwarders and recorders on page 48.

Solution - Since the onconfig.cms and sqlhosts files are only read when IDS is 
brought on-line, IDS and CMS must be restarted. This only applies to R3V9 versions of 
CMS since IDS on R3V11 and later versions of CMS are brought on-line with the OA 
parameters necessary for the forwarders to connect in those files.

-908: [Informix][Informix ODBC Driver][Informix]Attempt to
connect to database server (oacms_ol) failed.
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Event Collector failures
This section describes Event Collector failures and possible solutions. To assist in 
gathering Event Collector information, see Event collector troubleshooting tools on 
page 59.

Symptom - Poor event collector performance

Event Collector performance can be affected by many situations, including:

● An improperly configured host server can result in poor event collector performance. 

● Inadequate physical memory can increase virtual memory paging to the point where 
event collector cannot process any events. 

● An overloaded server running too many IC or OA processes. Symptoms of this type of 
problem include:

- Poor EC performance

- EC "Queue limits exceeded" errors

- Failures of other IC or OA processes co-located with EC.

Solution - Investigate doing any or all of the following:

● Reconfigure the host server

● Add memory to the server

● Reduce the number of components running on servers

● Add more servers to the configuration.

Symptom - The event collector fails.

Solution - Do the following:

1. Verify the EC is configured as described in Administering the Event Collector server on 
page 126 in Avaya Operational Analyst Release 6.1 Installation and Configuration. 
Make sure that the following options are populated and configured correctly for EC in 
the IC Manager:

● Site

● Domains to Monitor

● Real-Time System ID (The OA real-Time Source ID)

● Data Manager Host

2. Verify that each domain specified under �Domains to Monitor� contains an ADU server.
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3. Try to start the Event Collector via the IC Manager. Check the IC Manager for the 
Event Collector status. The status should be reported as �Up�

4. Inspect the error logs to be sure the prerequisite services are available:

● ORBacus Naming Service - On Windows, check system Services to verify that it is 
Started.   On Unix, use ps –ef | grep nameserv to see if nameserv is in the list 
of running applications. If the local ORBacus naming service is not running, there 
will be an alarm logged by EC similar to: �EC.ConnectionMonitoring, emergency, 
Failed to initialize the monitor interface.�.

● ADU - Verify that the ADU server in the EC server local domain has a status of �Up�.

● DS � Verify that at least one IC Directory Server (DS) for the IC site is up and 
running (status of �Up�).

5. If the Event Collector cannot connect to the Data Manager:

a. Verify that the correct values have been administered in IC Manager for the 
Real-Time System ID and the Data Manager Host name or IP address of the target 
Real-Time system.

b. Verify on the target OA Real-Time system that the Data Manager process is 
running.

c. If the Event Collector and the OA Real-Time are installed on separate machines, 
verify the network is operating correctly by attempting to ping the associated Data 
Manager host server from the EC host server.

Symptom - The Event Collector does not automatically restart after an abnormal 
termination.

The Event Collector may fail to automatically restart after it crashes. This happens even 
though the �Autostart� option is selected for the server configuration of the Event Collector. 
The only known reason for this is that the Event Collector was manually shutdown and 
restarted by way of the IC Manager user interface after IC was started. Once the Event 
Collector has been shutdown and restarted in this manner, IC will not automatically restart 
it after it crashes. This is a feature of the way IC was designed to manage servers.

Solution - The only way to reestablish automatic restarts is to stop and restart all of IC or 
reboot the system.

Symptom - You receive the following alarm message:

EC.ICProxyInitFailure, emergency, Failed to initialize Media Queue
ADU proxy

Solution - This indicates that the EC server was unable to assign to an ADU server to 
proxy media queue events. Verify that the EC server's domain contains an ADU server in 
its failover path. Refer to Avaya Interaction Center Release 6.1 Installation Planning and 
Prerequisites for more information.



Troubleshooting OA components

118 Avaya Operational Analyst R6.1 Maintenance and Troubleshooting

Symptom - The Event Collector cannot assign to the Event Collector Bridge (ECB).

Solution - Check the following:

1. Make sure that the ECB in the system is running.

2. Make sure that the at least one ECB (or the only ECB) in the system is functioning as 
the Primary ECB. See Event Collector Bridge failures on page 118 for more 
information on debugging ECB problems.

Event Collector Bridge failures
This section describes Event Collector Bridge (ECB) failures and possible solutions. To 
assist in gathering Event Collector Bridge information, see Event Collector Bridge 
troubleshooting tools on page 61. 

Symptom - The event collector bridge will not start or will not stay running.

Solution - Do the following:

1. Verify that the ECB is configured as described in Administering the Source-EC Bridge 
(Event Collector Bridge) on page 132 in Avaya Operational Analyst Release 6.1 
Installation and Configuration.   Make sure that the system specified for Advocate 
Host under the Event Collector Bridge tab is correct and that a "pa_admin" MSMQ 
exists on that system. Make sure that the "pa_pumpup" MSMQ exists on the system 
where ECB is running.

2. Try to start the Event Collector Bridge via the IC Manager. Check the IC Manager for 
the Event Collector Bridge status. The status should be reported as "Up."

3. Verify that Avaya Business Advocate is correctly installed on the same system where 
ECB is running. If ECB cannot establish interface connections to Advocate at startup, 
then it will fail to start.

Symptom - The event collector bridge will not function as the primary.

Solution - Check the primary/standby status of ECB by looking at the Advanced/Server 
Status properties in IC Manager. If there are multiple ECBs in the system, only one ECB 
will be allowed to function as the primary. If none of the ECBs are functioning as the 
primary, there is some sort of MSMQ problem. Make sure that the "pa_admin" MSMQ 
exists and is available. If there are multiple Avaya Business Advocate systems (primary/
standby) then the "pa_admin" MSMQ must exist on the primary Advocate system and all 
ECBs must specify this system name for Advocate Host.



Troubleshooting data collection problems

Issue 1.0 August 2003 119

Symptom - The event collector bridge will not perform a PumpUp against Advocate.

Solution - Do the following:

1. Verify that Advocate is functioning properly.

2. Verify that there are no problems accessing the pa_admin or pa_pumpup MSMQs.

3. Verify that the correct version of the Microsoft XML parser exists on the system. It 
should be at least Microsoft XML Parser Version 3.0 SP1. Internet Explorer Version 6.0 
and later supplies an acceptable minimum version of the Microsoft XML parser. It can 
also be downloaded directly from Microsoft�s website and then installed.

Symptom - The event collector bridge PumpUp takes a long time.

Solution - Do the following:

1. Check the number of Agents, Service Classes and Agent capability/profile sets defined 
in Advocate. Large numbers of agents and capability/profile sets will generate a large 
number of PumpUp events to be processed by ECB. 

2. Verify the configuration of virus scanning software on the Advocate/ECB system. If log 
files, database files, and temp files are being scanned, this can make Advocate 
PumpUp extremely slow. Consider not scanning the log, database, and temp files.
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Troubleshooting the Administration client

This section provides some tips on troubleshooting the Administration client. Here you can 
find information about various error messages you may see, and explanations of behaviors 
you may encounter.

This section includes the following topics:

● General Administration client issues on page 122 deals with a variety of problems that 
you might encounter. It includes "hangs," long waits, and data entry problems.

● Administration client Java plug-in and Java console on page 129 concentrates on Java 
Console configurations that may aid you in resolving Administration client initialization 
issues.

● Log files on page 131 describes how you can use the log files to identify problems as 
well as explain the log errors.

● Administration client administration screens on page 140 lists problems that you may 
encounter with a particular administration screen, with corresponding solutions.

● Administration client status messages on page 146 explains what the status messages 
mean.

● Administration client error messages on page 148 lists error dialogs that you might 
encounter and provides suggestions on how you might resolve the errors.
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General Administration client issues
This section lists a collection of common problems and their solutions. It focuses on issues 
that you might encounter while launching the Administration client or while using it. It deals 
with any difficulty that is not specific to an Administration client module or an administration 
screen.

General Administration client issues include:

● Authentication problems on page 122

● Client not updated on page 124

● Connectivity on page 124

● Data Entry on page 125

● General Protection Faults on page 125

● Initialization Errors on page 126

● Long wait time on page 127

● Page faults on page 128

● Printing on page 128

● Unresponsive system on page 128

Authentication problems
This section describes problems seen when users are unable to log on to the 
Administration client.

Note:
Note: All references to domains in this section refer to software residing on 

Windows servers only.

Symptom - You see the message: "An invalid user name or password was entered    
Please try again."

Solution - The cause can be one of the following:

● The user ID is not defined on the specified domain.

● The format to specify the domain and user ID is wrong (it should be <domain>\
<userid> when the historical host is on Windows).

● The password for the user on the domain is wrong.



Administration Client log files

Issue 1.0 July 2003 123

● If no domain is specified, the authentication is done on the historical host. Verify all of 
the above on the historical host.

Symptom - You see the message: "The user is not authorized to do administration. Please 
try again."

Solution - The cause can be one of the following:

● The wrong domain is used.

● The user is not a member of the administration group on the specified domain (the 
group is defined when installing the historical server).

Symptom - You see the message: "An instance of the authentication service could not be 
created. The user name and password could not be authenticated. Please try to login 
again."

Solution - The cause can be one of the following:

● The administration client configuration is not pointing to the right host for the Historical 
subsystem. This is set in the AdminPol.html or AdminSig.html files. Refer to the 
SERVER_NAME applet parameter in that file.

● The network is not configured properly for the Administration client host to reach the 
historical host.

● The naming service is not running on the historical host.

● The authentication service is not running on the historical host.

● If this problem persists, contact Avaya support.

Symptom - When logging on to the administration client, the following error message is 
displayed: "The maximum number of erroneous login attempts has been reached for this 
user name. Administration cannot be done without a valid login. You must wait for the 
administered timeout period before trying to login again with this user name."

Solution - This means that you have reached the maximum number of attempts to log on 
to the client. You need to wait 10 minutes (default value) before you can try again with the 
same user ID.
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Client not updated
Avaya OA does not update the configuration data displayed in the Administration client 
automatically. Refresh the administration screen often by clicking View > Refresh on the 
Administration client menu.

Avaya OA allows up to five Administration clients to connect to the server simultaneously. It 
does not lock any user out and keep him or her from administering the data. If more than 
one person is administering the Administration client, the first one to save the configuration 
settings will have his or her entries saved; the other administrators will have their entries 
rejected. This is because the update value of the first person matches the value in the 
database, while the update values of the subsequent users are out of sync with the 
database (because the first person has already changed the value). This first-person rule 
prevents other users from destroying the initial changes another user has made. Refresh 
your administration screen periodically to ascertain that you are working with the latest 
configuration.

Connectivity
The Administration client establishes a CORBA connection when you launch it. The 
connection may break if you are not using the Administration client for a while (a 
"time-out"). You can re-establish the CORBA connection by clicking File > Reconnect in 
the Administration client menu.

If the problem persists and an error message notifies you that the server is unavailable, 
close your Internet Explorer browser, then relaunch the Administration client.
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Data Entry

General Protection Faults
General Protection Faults (GPF) happen when an application, such as the Administration 
client, attempts to read or write data that is outside its permission rights.

You can track down the GPFs by eliminating suspects one by one.

To isolate the source:

1. Shut down all applications one at a time ending with Internet Explorer.

2. If the GPF persists, re-launch the Administration client from Internet Explorer. Type in 
C:\Program Files\Avaya\BI\AdminPol.html (if you did not use the default 
installation, enter the appropriate address) in the Address text box.

An alternative solution is to change your computer's system video mode to use the 
Windows standard VGA driver (16 color VGA). If this solves your problem, then your 
original video driver may have problems. Contact your video card vendor for an updated 
video driver.

Symptom Description Resolution

The Administration 
client is not 
recognizing my 
shortcut keys.

Your entries might be 
applying to the 
browser and not the 
Administration client.

Click anywhere within the administration 
screen or a dialog box to activate the 
shortcut keys and to start entering your 
configuration.

The Administration 
client is not 
accepting my input.

Your entries might be 
applying to the 
browser and not the 
Administration client.

Click anywhere within the administration 
screen or a dialog box to activate the 
shortcut keys and to start entering your 
configuration.

The text boxes are 
not accepting my 
input. It accepts the 
first few digits, but 
not the succeeding 
ones.

The text boxes have a 
defined minimum and 
maximum range.

If you enter a value larger than the 
maximum permissible value, the 
Administration client will not display the 
digit where you have exceeded the limit.
For example, if you enter 13 in the date 
field for the month, only the 1 will be 
echoed since 13 is an illegal parameter.
If you enter a value below the minimum, 
the client will either not display your entry 
or convert your entry to the minimum 
value when you move on to the next field.
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Initialization Errors
If the Administration client does not seem to be initializing, it might either be not responding 
or is experiencing initialization errors.

Check the Windows Task Manager to see if the Administration client has stopped 
responding. If that is not the issue, close the Administration client, open the Java Console 
and open the Administration client again to see if initialization errors are still occurring.

Initialization errors are most likely caused by problems with the system environment. It 
might be a security problem (policy files), invalid installation file structure (missing 
directories or files), invalid file permissions (read only), incomplete environment variable 
specification (PATH), missing or unregistered libraries, or corrupt jar files.

The PATH is set during installation and initial set-up. For more information, see Avaya 
Operational Analyst Release 6.1 Installation and Configuration.

If you see any of the following errors when starting the Administration client:

● No JDK 1.2.2 support for APPLET!!

● JRE not installed correctly

● Browser settings are incorrect!!!

ActiveX components could not be started when the client was launched. This usually 
means the JRE wasn't installed correctly. The correct version needs to be installed. 
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Long wait time

Symptom Description Resolution

The 
Administration 
client takes a 
long time to 
load.

The Administration client does 
not load.

Re-launch your browser and the Administration 
client.

The Java Console is empty. It 
may display the following text 
immediately after the 
Administration client initializes:
Java(TM) Plug-in: Version
1.3.1_06
Using JRE version 1.3.1_06
Java HotSpot(TM) Client VM
User home directory = C:\
WINNT\Profiles\...
Proxy Configuration: Manual
Configuration
Proxy: co.proxy.avaya.com:8000
Proxy Overrides: *.avaya.com,
<local>
Jar cache enabled.
Initializing the OA admin
client applet...

The Administration client cannot find the Java 
Security Plug-in, therefore it tries to download 
the plug-in form Sun Microsystems. This may 
take a while to complete.
The Administration client launches as soon as 
the download is complete and the plug-in is 
available.

The 
Administration 
client is taking 
a long time to 
load and is not 
generating 
error 
messages.

The Administration client is 
responding and is not reporting 
or logging errors.

This might be an initialization error or an 
unresponsive system (hang) problem.
Close the Administration client then start the 
Java Console. Start the Administration client 
again and look at the Java Console error log.
If it appears to be an initialization error, check 
the environment.
The most likely cause of this error is an 
improperly set or incomplete environment 
variable specification (PATH). The PATH is set 
during installation and initial set-up. For more 
information, see Avaya Operational Analyst 
Release 6.1 Installation and Configuration.
If this is not the source of the error, you may 
have a security problem (invalid or missing 
policy files), invalid installation file structure 
(missing directories or files), invalid file 
permissions, missing or unregistered libraries, 
or corrupt jar files.
If the Java Console does not display any output, 
refer to the solution proposed above.
Also refer to Initialization Errors on page 126.
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Page faults
Page faults occur when your computer is low on RAM or swap file space. You must either 
increase the RAM or the swap file size.

Printing
You cannot print the Administration client user interface (UI) by using the Print menu in the 
browser or by pressing Ctrl+P.

To print the Administration client UI, select File > Print in the Administration client menu 
bar.

Unresponsive system
Sometimes the Administration client does not respond to your input. To determine whether 
the Administration client is just taking a long time to process input or is not responding, use 
Windows Task Manager. 

This table lists a few things you can do when the Administration client freezes.

Symptom Description Resolution

JRE freezes The Java Console is 
completely empty and a 
download dialog box 
appears.
A Java Console in debug 
mode may cause this.

Disable debugging.
To disable debugging:

1. Go to the Java Plug-in 
Control Panel.

2. Select the Advanced tab.

3. Clear the Enable Debug 
check box.

4. Click Apply.

5. Close the Java Plug-in 
Control Panel.
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Administration client Java plug-in and Java console
As an additional troubleshooting aid, the Administration client logs messages in the Java 
Security Plug-in Java console window. The Java Console helps you diagnose problems 
that might occur when the applet initializes.

This section includes the following topics:

● Accessing the Java Plug-in Control Panel on page 129

● Enabling the Java Console on page 129

● Recycle Classloader on page 130

Accessing the Java Plug-in Control Panel
The Java Plug-in Control Panel lets you configure the security plug-in, the Java console, 
and Jar caching. You need to use the control panel to troubleshoot certain problems.

To access the Java Plug-in Control Panel (JRE 1.3) in Windows:

1. Select Start > Settings > Control Panel.
2. Double-click the Java Plug-in icon.

The Java Plug-in Control Panel launches.

Enabling the Java Console
You can view the Java Console to troubleshoot initialization errors.

Tip:
Tip: The Java Console, while useful for diagnosing problems, need not be 

enabled under normal operations.

To enable the Java Console:

1. Launch the Java Plug-in Control Panel.

2. In the Basic tab, select Show Java Console.

3. Click Apply, then close the window.

4. Re-launch the Administration client.

The Java Console appears when the Administration client is starting.
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Tip:
Tip: To disable the Java console, follow the procedure above except to clear the 

Show Java Console check box. 

Recycle Classloader
Enable the Recycle Classloader option so you can launch the Administration client more 
than once from one browser.

To recycle the classloader:

1. Launch the Java Plug-in Control Panel.

2. In the Basic tab, select Recycle classloader.
3. Click Apply, then close the window.

4. Restart the Administration client.

Tip:
Tip: To disable recycling of classloader, follow the procedure above except to 

clear the Recycle classloader check box. 
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Log files
If you want to find out why the system is not working as it should, you should look at the 
trace files.

The Administration client trace files are in %PABASE%\data\log\adminclient\. If you 
installed OA in the default directory, that would be C:\Program Files\Avaya\BI\
data\log\adminclient\.

The Administration manager trace files are in %PABASE%\data\log\adminmgr\. If you 
installed OA in the default directory, that would be C:\Program Files\Avaya\BI\
data\log\adminmgr\.

This section includes the following topics:

● Configuring the log files on page 131

● Error types and codes on page 133

Configuring the log files
You can customize your trace files to give more or less information. This level of detail is 
configured in two places: the loginfo file and the AdminPol.html file. The sections 
below detail how you can modify them to suit your needs

Loginfo

Administration client files - You can change the size and roll-over of the trace file. The 
file is in %PABASE%\data\admin\. (If you selected the default location during installation, 
that would be: C:\Program Files\Avaya\BI\data\admin.)

The entry in the loginfo file for the Administration client trace files might look like this:

adminClientTrace data/log/adminclient/adminClientTrc 150000 3

where:

● adminClientTrace is the name of the entry. Do not change this value.

● data/log/adminclient/adminClientTrc is the directory location of the trace file. 
Do not change this value.

● 150000 is the size of the trace file. The size of the trace file can be from 100000 
to 10000000. You may specify this value to be whatever is appropriate for your needs.

● 3 is the roll over count. You can specify a value of 3 to 99. When a trace file reaches the 
maximum size, it rolls over. This means that the current trace file is renamed with an 
.nn insert (where .nn is a number). For example, adminClientTrc-1.log becomes 
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adminClientTrc-1.01.log when it reaches the maximum limit. If there already is 
an adminClientTrc-1.01.log file, that existing file becomes 
adminClientTrc-1.02.log. While the logged messages are rolling over, OA 
continues logging the latest messages on the original file (which in this case is: 
adminClientTrc-1.log).

Tip:
Tip: To determine which client trace file is being used, click View > Trace File 

Location in the Administration client menu bar. The Administration client 
displays the name and location of the trace file it is using.

Administration manager files - The entry in the loginfo file for the Administration 
manager trace files might look like this:

adminMgrTrace data/log/adminmgr/logentry 150000 3

where:

● logentry includes the following Administration manager entries:

- adminbaselog

- adminbasetrc

- adminsrvadm

- adminsrvlog

- adminsrvtrc

● adminMgrTrace is the name of the entry. Do not change this value.

● data/log/adminmgr/logentry is the directory location of the trace file. Do not 
change this value.

● 150000 is the size of the trace file. The size of the trace file can be from 100000 
to 10000000. You may specify this value to be whatever is appropriate for your needs.

● 3 is the roll over count. You can specify a value of 3 to 99. When a trace file reaches the 
maximum size, it rolls over. This means that the current trace file is renamed with an 
.nn insert (where .nn is a number). For example, adminsrvtrc-1.log becomes 
adminsrvtrc-1.01.log when it reaches the maximum limit. If there already is an 
adminsrvtrc-1.01.log file, that existing file becomes adminsrvtrc-1.02.log. 
While the logged messages are rolling over, OA continues logging the latest messages 
on the original file (which in this case is: adminsrvtrc-1.log).

Tip:
Tip: To determine which client trace file is being used, click View > Trace File 

Location in the Administration client menu. The Administration client 
displays the name and location of the trace file it is using.
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AdminPol.html

You can change the detail level of your trace file as well as activate the CORBA tracing. If 
you selected the default location during installation, this file would be in C:\Program
Files\Avaya\BI\.

Error types and codes
Avaya OA logs an error in the following conditions:

● The Administration client cannot access required resources, such as the resource 
bundles for internationalization.

● The Administration client cannot get a server connection.

● The Administration client is not in sync with the OA server.

● CORBA exceptions are caught.

This table lists error types the Administration client uses:

Attribute Description Default 
Value

Possible Values

TRACE_LEVEL Specifies the level of 
trace information to 
collect

10 10 - Event level 
trace.

20 - Interface level 
trace.

30 - Debug level 
trace. This produces 
the highest number 
of trace messages.

CORBA_TRACE Enables CORBA 
tracing.
Enabling this results 
in a voluminous trace 
log. Turn on only 
when necessary.

No Yes

No

ID Error Type

1050 to 1100 Database

4101 to 4300 Common CORBA

4301 to 4400 Common object
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This section includes the following topics:

● Administration client error codes on page 135

● Administration client-server error codes on page 137

● CORBA error codes on page 138

● Common objects error codes on page 139

● Registration error codes on page 139

11601 to 11700 Registration

11801 to 11900 Administration client

11901 to 12000 Administration client/server

12001 to 12100 Administration client

12101 to 12200 Server metadata

12501 to 12600 Migration 

12601 to 12700 Maximum capacity 

12901-13000 Scheduling 

ID Error Type
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Administration client error codes

This table lists error codes related to the Administration client.

Error Code Description Resolution

AC_INTERNAL_ERROR 
(12003)

Internal error. This 
generally indicates one of 
the following types of 
errors:
● The code is out of sync 

with UI (user interface) 
files (.gui).

● What the Administration 
client supports is out of 
sync with what the 
server supports.

● Page and server access 
classes are out of sync.

● Missing objects within 
the client (null).

● Unknown server error 
code received by 
Administration client.

Contact Avaya customer support and 
report the error. The representative will 
contact the appropriate developers.
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AC_LOST_CONNECTION 
(12002)

The Administration client 
cannot establish 
connection with the server.

Reconnect by clicking File > 
Reconnect on the Administration 
client menu.
If this error persists, make sure that the 
server is running and the 
AdminMgrSrvBase process is 
executing.
If the AdminMgrSrvBase process 
cannot create AdminMgrSrv 
processes, the Administration client 
will not be able to connect to the 
server.
Check the log file to see if there are 
other errors, such as ORB initialization 
failures, which could result from 
improperly-set classpath or policy 
files.
The classpath is set in Start 
>Settings > Control Panel > System 
Environment during installation and 
initial set-up. For more information, see 
Avaya Operational Analyst 
Release 6.1 Installation and 
Configuration.

AC_MISSING_RESOURCES 
(12001)

The Administration client 
cannot find the language 
resource bundles needed 
to execute.

Contact Avaya customer support and 
report the error. The representative will 
contact the appropriate developers.

Error Code Description Resolution
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Administration client-server error codes

This table lists error codes related to the Administration client-server issues.

Error Code Description Resolution

ADMIN_DATABASE_UNAVAILABLE 
(12102)

The database is not 
available.

Investigate the server logs 
to determine why the 
database is unavailable. It 
could be because:
● The database is down

● The JDBC driver is not 
able to connect

● Allowed database 
connections are 
exhausted

ADMIN_INVALID_IDL_VERSION 
(12106)

The Administration 
client and 
Administration 
Manager server 
component use IDL to 
communicate with 
each other.
The client and server 
must use compatible 
versions of the IDL. 
Incompatible versions 
result in this error.

Upgrade either the 
Administration client or the 
server, or both.

ADMIN_SERVER_CONFIG_NOT_KN
OWN (12158)

The administration 
client could not get 
the server 
configuration from the 
historical server.

This could be a 
connectivity problem, or an 
installation problem.

ADMIN_SVC_DISABLE_OVERRIDE 
(12160)

The administrator has 
decided to delete or 
modify a subsystem 
that has services in 
an enabled or 
unknown state.

Manual cleanup of 
interface services that 
were not disabled prior to 
subsystem modification or 
deletion may be needed.
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CORBA error codes

This table lists error codes related to CORBA issues.

Error Code Description Resolution

CORBA_EXCEPTION 
(4201)

ORB initialization failure. 
The server connection 
could not be established.

Reconnect by clicking File > 
Reconnect in the menu bar. 
This will not work until the 
underlying problem is fixed.
The most likely cause of this 
error is an improperly set 
CLASSPATH environment 
variable. It is set in Start > 
Settings > Control Panel > 
System Environment during 
installation and initial set-up. 
For more information, see 
Avaya Operational Analyst 
Release 6.1 Installation and 
Configuration.

ORBIX_NARROW 
(4108)

The Administration client 
cannot establish a 
connection because it is 
unable to get the right 
version of server object to 
connect.

The AdminMgrSrv process 
could not be created. This may 
either be a server problem or a 
CORBA problem.
Investigate the Administration 
client and server trace files to 
determine the cause.

ORBIX_NS_BIND 
(4104)

The Administration client is 
unable to bind to the 
AdminMgrSrvBase server 
process while attempting to 
connect.

The Administration client 
attempt this operation three 
times before failing. 
Connection failure may be 
because of a 
AdminMgrSrvBase server 
process that is not running or a 
CORBA problem.
Investigate the Administration 
client and server trace files to 
determine the cause.
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Common objects error codes

This table lists error codes related to common objects.

Registration error codes

This table lists error codes related to registration.

Error Codes Description Resolution

OBJ_INVALID_STATE 
(4301)
OBJ_INVALID_VALUE 
(4302)

The server returned an 
invalid value to the 
Administration client.

Contact Avaya customer support 
and report the error. The 
representative will contact the 
appropriate developers.

Error Codes Description Resolution

REG_INVALID_SUBSYSTEM 
(11817)

Internal error. The 
Administration client 
received an 
unknown subsystem 
type.

Contact Avaya customer 
support and report the error. 
The representative will contact 
the appropriate developers.
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Administration client administration screens
This section addresses some of the common problems you might encounter while 
managing your data in the administration screen.

This section includes the following topics:

● Container profiles on page 140

● Scheduled jobs on page 142

● Interface Services on page 143

● Subsystems on page 144

Container profiles

The requirement for the creation of any container is that you have the necessary display 
name information (rows in the Info tables). Each historical store has different requirements, 
as shown in the following table:

Problem Description Resolution

The Administration client 
does not allow you to 
enable or disable a 
container.

Display name 
information is not 
available.

Verify that data is being received from 
the CMS or Avaya IC system.

The data could not 
be aggregated 
within the 30 
minute interval.

Limit the administrator from creating too 
many containers.

Historical store Info tables

Agent state Workgroup

Agent service class Workgroup and 
SvcClassInfo

Service class state SvcClassInfo

Service class summary SvcClassInfo

Agent completion code Workgroup, DialerInfo, 
and JobInfo
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If there are no administered workgroups, containers for the historical stores that require a 
workgroup cannot be administered. This is also true for all other Info tables and historical 
stores. The following is how rows are created in the Info tables:

Workgroup - Administered in IC. When they are added in IC, they are available for 
container administration.

DialerInfo - Dialers are also administered. This information is obtained at pump-up time 
and through administration events.

AgentInfo - Agents are also administered. This information is obtained at pump-up time 
and through administration events.

JobInfo - Jobs are known when they are loaded into a dialer. The agent association is 
created when an agent works on a job. A watch event notifies the system of these events. 
This data is sent to the Historical subsystem by the bulk HDS deliverer. That means it is not 
available in historical (that is, for container admin) until the end of each base interval. If you 
create a job and load it into a dialer, you will probably have to wait until the end of that base 
interval (every 30 minutes) to be able to do container administration for it.

AgentCapSetInfo - Business Advocate service classes are administered. This information 
is obtained at pump-up time and through administration events.

AgentSvcClassInfo - Rows are generated in this table when an agent is associated with a 
service class (IC queue). It is dependent on the HDS delivery mechanism when this is 
available. It is part of the bulk delivery system, meaning this information is not available 
until the end of each base interval.

Agent job Workgroup, DialerInfo, 
and JobInfo

Job summary DialerInfo and JobInfo

System completion code DialerInfo and JobInfo

Historical store Info tables
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Scheduled jobs

Problem Description Resolution

Aggregation for every 
other interval is failing.

You are trying to 
aggregate too 
much data each 
interval (either too 
many containers or 
containers are too 
large). 

Aggregation recovery should eventually 
remedy this problem, but you may want 
access to your aggregated data sooner 
than aggregation recovery can provide. 
If this scenario is encountered, you 
should reduce the number or size of 
your containers.
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Interface Services

Problem Description Resolution

Changes to interface 
services are not 
recognized.

Another administrator might 
have saved changes and your 
administration screen is not 
reflecting the latest 
configuration settings.

Refresh the screen by clicking 
View > Refresh on the 
Administration client menu.

Interface services are 
not synchronized.

When the server and the 
Administration client hold 
different information about a 
service, they are not 
synchronized. Synchronization 
has failed.
You can monitor the 
synchronization status of your 
interface services in the 
Synchronized column of the 
Interface Services results 
screen. 

Disable then re-enable the 
service.
If this does not clear the 
problem because the service 
is unreachable (the service 
state is displayed in the 
Status column of the 
Interface Services screen), 
you must manually disable 
and enable the service in the 
command line:

1. Navigate to the 
Interface Services 
administration screen.

2. Look up the interface 
service name in the 
Name column. 

3. Log into the subsystem 
host where the wayward 
service is located.

4. Disable the service with 
this command: pa
disable <name>.

5. Re-enable the service 
with this command: pa
enable <name>.

What is the interface 
service name?

You need to know the interface 
service name if you wish to do 
something with an interface 
service over the command line.
The interface service name is 
an internally assigned name the 
server uses to identify the 
service. You cannot modify the 
name.

To find the interface service 
name, Navigate to the 
Interface Services 
administration screen and look 
up the interface service name 
in the Name column.
Use the name to troubleshoot 
the interface service.
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Subsystems

Cannot modify, 
enable, or disable a 
service (buttons are 
grayed out)

Modify/enable/disable are not 
allowed until the status of the 
service is known.

Select services from table 
(highlight them) and select 
View status.

Cannot select all 
services to get status.

Services can only be selected 
one at a time.

Select Edit > Select All or 
Edit > Select None to select 
or deselect all services.

Problem Description Resolution

Problem Description Resolution

The Administration 
client does not 
accept the 
subsystem 
configuration.

The subsystem name must be 
unique.

Enter a unique name.

Cannot add a report 
subsystem.

Avaya OA supports no more 
than one Report subsystem on 
any server.

Do not exceed these 
constraints.

Cannot add a 
Real-time 
subsystem.

OA supports no more than two 
Real-time subsystems on a 
server. A Real-time subsystem 
cannot reside on a server 
where a CMS subsystem is 
already installed.

Do not exceed these 
constraints.

Cannot add a 
Historical subsystem.

OA allows only 1 Historical 
subsystem, which is created 
during the OA installation 
process.

Cannot add a CMS 
subsystem.

CMS subsystems are subject 
to these constraints:
● Only one CMS subsystem 

per server.
● CMS subsystems cannot be 

added to servers where a 
Historical subsystem is 
already assigned.

● CMS subsystems cannot be 
added to servers where a 
Real-time subsystem is 
already assigned.
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Cannot add an IC 
source subsystem.

Only one IC source subsystem 
is allowed per Real-time 
subsystem.

Add a new Real-time 
subsystem to support the new 
IC source subsystem, then add 
the IC source subsystem.

Cannot add an ACD 
source subsystem.

A CMS subsystem supports a 
maximum of eight ACD source 
subsystems.

Add a new CMS subsystem, 
the add the ACD source 
subsystem.

Cannot delete an 
ACD source 
subsystem.

The system scheduled job 
cannot be deleted, so the 
subsystem cannot be deleted.

Disable the system scheduled 
job.

Cannot delete or 
modify a subsystem.

There are services associated 
with the subsystem in an 
enabled or unknown state. 
These services will be deleted 
from the OA database, leaving 
them inaccessible from the 
Administration client.

Disable all associated services 
before deleting the subsystem. 
If you choose not to disable the 
services, they may become 
inaccessible from the client and 
remain in an executing status 
on the server.

Cannot delete a CMS 
or Real-time 
subsystem.

The subsystem has associated 
source subsystems.

Delete or reassign the source 
subsystems to a new CMS or 
Real-time subsystem.

Cannot delete a 
Historical subsystem.

OA does not allow the 
Historical subsystem to be 
deleted.

Problem Description Resolution
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Administration client status messages
This section describes and explains some status messages you might receive while using 
the OA Administration client.

This section includes the following topics:

● Interface services on page 146

● Schemas on page 147

Interface services

Status Message Description

Change(s) cancelled. Ready. Your changes have been removed and are not 
going to be sent to the server.

Disabling services may result in the 
loss of data.

Disabling the interface service stops it from 
running and might result in lost data.Some 
interface services have pre-administered buffer 
space that mitigates data loss for brief periods 
of time.

Modifying this service may result in 
the loss of data.

Because you need to disable an interface 
service when you modify it, data might be lost.

One or more changes failed. Ready. One or more changes failed on the server.

Pressing the Cancel button causes 
all unsaved administration changes 
to be deleted.

All the changes you made since the last save 
will be discarded.

Retrieving data from server. The Administration client is waiting for the 
server to send it requested data.

Sending change(s) to the server. The Administration client is sending your 
changes to the server.

There are unsaved administration 
changes for this screen.

You have not saved your changes.
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Schemas

Status Message Description

A migration has started. The schema 
can't be accessed at this time.

OA is migrating data from one table to 
another, therefore you cannot view the 
schema. 
Wait until the migration is done.

Could not get requested data from the 
server. Please try again later.

The server data is not available. Try your 
request again later.

Change(s) cancelled. Ready. Your changes have been removed and not 
sent to the server.

Change failed. Ready. Your change request failed. Try again.

Change(s) succeeded. Ready. Your change request is successfully being 
sent to the server. You may now make 
more changes.

Current and Pending schemas exist. 
Current schema can only be viewed.

When both current and pending schemas 
for a historical store exist, you can only 
view the current schema and not modify it.
If you want to modify your schema, make 
your changes to the pending schema.

Migration in progress. Current schema 
can only be viewed until the migration 
completes.

OA is migrating data from one table to 
another, therefore you cannot view the 
schema.
Wait until the migration is done.

Retrieving data from server. The Administration client is waiting for the 
server to send it the requested data.

Save cancelled at user's request. The changes were not sent to the server at 
your request.

Sending change(s) to the server. The Administration client is sending your 
changes to the server.

There are unsaved administration 
changes for this screen.

You have not saved your changes.
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Administration client error messages
This section describes and explains some error messages you might receive while using 
the OA Administration client.

Note:
Note: Some of the descriptions and resolutions proposed are vague because the 

problems arise out of third-party software or defective hardware. You may 
need to look at the other vendors' troubleshooting documentation or contact 
their technical support department.

This section includes the following topics:

● General on page 149

● Connection on page 150

● Containers on page 152

● Container archives on page 153

● Daily intervals on page 154

● Database and data access on page 155

● Interface services on page 156

● Retention periods on page 158

● Scheduled jobs on page 158

● Schemas on page 159

● Subsystems on page 161
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General
This section pertains to error messages that you might encounter while using any of the 
OA administration screens.

Error message Description Resolution

Client could not start. 
Unable to load 
presentation widgets.

The Administration client 
applet could not start 
because it could not load 
the presentation widgets.

Make sure the image 
directory is available and 
contains .gui and .gif files.

Host name contains illegal 
characters: \ / { ' " or Esc.

Your host name has illegal 
characters.

Do not use \ / { ' " or Esc 
when you name your host 
machine.

Host name exceeds 
maximum length of 20 
characters.

The host machine name is 
too long. The maximum is 
20 characters.

Give your host machine a 
shorter name.

Internal parameter syntax 
error. Client and server are 
out of sync. Contact your 
support organization.

Administration parameter 
validation failed due to a 
syntax error. The 
Administration client and 
the server are out of sync.

Contact your support 
organization.

Mandatory entry was left 
blank. Please enter a value 
in field: field name.

You skipped a mandatory 
data entry field.

Go back and enter a valid 
entry on the mandatory 
field.

Paste failed. The clipboard 
may be empty or a type 
mismatch occurred. Make 
sure non-numeric 
characters aren't being 
pasted into a field 
allowing only numeric 
values.

Your paste attempt failed. Try again.
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Connection

This request is 
inconsistent with the 
server database. Please 
refresh and try again.

OA allows multiple 
Administration clients to 
connect to the server 
simultaneously but does not 
automatically update the 
administration data.
Someone else has changed 
the configuration settings 
and your Administration 
client is not reflecting the 
latest administration data.

Refresh your 
administration screen by 
clicking View > Refresh on 
the Administration client 
menu.
For more details, see Client 
not updated on page 124.

Unknown error received 
from server, error index 
number: xxxxx

The Administration client 
and the administration 
server components are out 
of sync.

Try again, if problem 
persists, contact Avaya 
customer support.

Error message Description Resolution

Error message Description Resolution

A connection to the 
server database 
can't be created. 
Administration can't 
be done without a 
database 
connection.

OA could not establish a 
database connection.
The Administration client 
needs a database 
connection to send your 
administration requests.

Try again.
If the problem persists, contact 
your support organization to 
troubleshoot the database 
connection error.

Administration client 
couldn't connect to 
server.

The Administration client 
cannot establish a 
connection with the server

See Connectivity on page 124.

Administration client 
received unexpected 
exception.

The Administration client 
caught an unexpected 
exception during 
construction. This is 
generally an exception 
generated by the server 
when it encounters 
problems while the 
Administration client is 
connected to it.

Try again. If this problem 
persists, contact customer 
support.
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Administration client 
couldn't connect to 
server due to ORB 
initialize failure.

The Administration client 
could not initialize the 
Object Request Broker.

The most likely cause of this 
error is an improperly set 
CLASSPATH environment 
variable. It is set in Start > 
Settings > Control Panel > 
System Environment during 
installation and initial set-up. For 
more information, see Avaya 
Operational Analyst Release 6.1 
Installation and Configuration.
See also Initialization Errors on 
page 126.

Server connection 
has been lost due to 
a CORBA failure. To 
continue, please 
reconnect.

CORBA failure occurred 
during initialization.

Reconnect to the server by 
clicking File > Reconnect in the 
Administration client menu bar.

The maximum 
number of allowed 
client/server 
connections are 
currently in use. 
This client can't 
connect to the 
server until another 
client exists. Please 
try again later.

Avaya OA allows a 
maximum of 5 
Administration clients to 
connect to the server.

Try again later, when there are 
not as many Administration client 
users.

Error message Description Resolution
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Containers

There is a problem 
with the server 
connection. Please 
exit this dialog.

The server connection has 
been lost.

Reconnect to the server by 
clicking File > Reconnect in the 
Administration client menu bar.

Use File > 
Reconnect to 
reconnect. If this 
problem persists 
contact your support 
organization.

The client-server connection 
is lost or could not be 
established.
This might be a temporary 
problem or a CORBA 
problem.

Reconnect to the server by 
clicking File > Reconnect in the 
Administration client menu bar.
If this does not work, check the 
system environment to make 
sure that the problem is not due 
to an improperly set 
CLASSPATH environment 
variable.
The CLASSPATH is set in Start 
> Settings > Control Panel > 
System > Environment during 
installation and initial set-up. For 
more information, see Avaya 
Operational Analyst Release 6.1 
Installation and Configuration.
See also Initialization Errors on 
page 126.

Error message Description Resolution

Error message Description Resolution

Container name 
contains illegal 
character: \ / { ' " or Esc.

The container name 
contains one or more 
illegal characters.

Do not use \ / { ' " or Esc when 
you name your container.

Container name exceeds 
maximum length of 40 
characters.

The container name is 
too long. The 
Administration client 
allows a maximum of 40 
characters

Give the container a shorter 
name.

The following container 
name is not unique:

The container name is 
not unique.

Give the container a unique 
name.
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Container archives

Error message Description Resolution

An external user has 
corrupted the data for 
the historical 
subsystem.

Another user might have 
corrupted the Historical 
subsystem.

Determine the damage and 
repair it.

Internal server error or 
client and server are 
out of sync. Contact 
your support 
organization.

Either an internal server error 
occurred or the Administration 
client and the server are out of 
sync. The asynchronism is 
most likely caused by differing 
client and server software 
versions.

Upgrade the software 
version in your client or 
server.

Server error occurred, 
please try again. If this 
error continues, 
contact your support 
organization.

A server error occurred. Try again.
If the problem persists, 
contact your support 
organization to troubleshoot 
the server error.

This request is 
inconsistent with the 
server database. 
Please refresh and try 
again.

OA allows multiple 
Administration clients to 
connect to the server 
simultaneously but does not 
automatically update the 
administration data.
Someone else has changed 
the configuration settings and 
your Administration client is 
not reflecting the latest 
administration data.

Refresh your administration 
screen by clicking View > 
Refresh on the 
Administration client menu.
For more details, see Client 
not updated on page 124.
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Daily intervals

Error message Description Resolution

Fixed Interval name 
specified is not unique. 
Specify a unique name.

The daily interval name is 
not unique.

Give the daily interval a 
unique name.

Fixed Interval start time 
specified has already 
been used. Specify an 
unused start time.

You have already defined a 
daily interval with the same 
start time.

Specify a different start time 
or not create a duplicate daily 
interval.

Internal server error or 
client and server are 
out of sync. Contact 
support.

Either an internal server 
error occurred or the 
Administration client and 
the server are out of sync. 
The asynchronism is most 
likely caused by differing 
client and server software 
versions.

Upgrade the software version 
in your client or server.

This request is 
inconsistent with the 
server database. Please 
refresh and try again.

OA allows multiple 
Administration clients to 
connect to the server 
simultaneously but does not 
automatically update the 
administration data.
Someone else has changed 
the configuration settings 
and your Administration 
client is not reflecting the 
latest administration data.

Refresh your administration 
screen by clicking View > 
Refresh on the 
Administration client menu.
For more details, see Client 
not updated on page 124.

Unknown error 
received from server, 
error index number: 
xxxxx

The Administration client 
and the administration 
server components are out 
of sync.

Try again, if problem persists, 
contact Avaya customer 
support.
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Database and data access
Persistent database problems might be generated by third-party applications, flawed 
configuration, or faulty hardware. Consult the appropriate troubleshooting documentation.

Error message Description Resolution

A connection to the 
server database can't be 
created. Administration 
can't be done without a 
database connection.

OA could not establish a 
database connection.
The Administration client 
must have a database 
connection to send your 
administration requests.

Try again.
If the problem persists, 
contact your support 
organization to troubleshoot 
the database connection 
error.

Can't access the 
database at this time. 
Please try again later.

OA could not access the 
database.

Try again later.
If the problem persists, 
contact your support 
organization to troubleshoot 
the database connection 
error.

Data could not be 
accessed on the server. 
If this condition 
persists, contact your 
support organization.

OA could not access the 
database.

Reconnect by clicking File > 
Reconnect in the 
Administration client menu.
See also Connectivity on 
page 124.

Database SQL error 
occurred. If this error 
continues, contact your 
support organization.

An SQL error occurred on 
the server.

Contact your support 
organization to troubleshoot 
the SQL error.

Database update failed, 
please try again. If this 
error continues, contact 
your support 
organization.

The database update failed. Try again.
If the problem persists, 
contact your support 
organization to troubleshoot 
the database connection 
error.
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Interface services

Server connection has 
been lost due to a 
CORBA failure.

CORBA failure occurred 
during initialization.

Contact Avaya customer 
support.

This request is 
inconsistent with the 
server database. Please 
refresh and try again.

OA allows multiple 
Administration clients to 
connect to the server 
simultaneously but does not 
automatically update the 
administration data.
Someone else has changed 
the configuration settings 
and your Administration 
client is not reflecting the 
latest administration data.

Refresh your administration 
screen by clicking View > 
Refresh on the 
Administration client menu.
For more details, see Client 
not updated on page 124.

Error message Description Resolution

Error message Description Resolution

A service can't be found. 
Please refresh the screen 
and try again.

The Administration client 
could not find the service.

Refresh your administration 
screen by clicking View > 
Refresh on the 
Administration client menu.

An error occurred 
obtaining data from 
server. Please try again 
later.

The Administration client 
encountered an error while 
retrieving data from the 
server.

Try again later.

Host could not be 
contacted.

The Administration client 
could not reach the host 
machine of the interface 
service

Make sure that the server 
where the interface service 
resides in is not down.

Initialization server could 
not be contacted.

InitSrv process couldn't be 
contacted.

Try again later.

Internal server error or 
client and server are out 
of sync. Contact your 
support organization.

Either an internal server 
error occurred or the 
Administration client and the 
server are out of sync. The 
asynchronism is most likely 
caused by differing client 
and server software 
versions.

Upgrade the software 
version in your client or 
server.
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One or more changes 
failed. Ready.

One or more changes failed 
on the server.

Try again later.

Server connection has 
been lost due to an 
ORBacus failure.

CORBA failure occurred 
during initialization.

Contact Avaya customer 
support.

Services of this type 
cannot be modified. 
Changes to this service's 
configuration are 
equivalent to a delete.

You can not modify 
recorders.

Do not attempt to modify 
recorders.

The client encountered 
network failure. Please 
try this operation again 
later.

Network error. Contact your support 
organization.

This <interface service 
type> could not be 
disabled. Unable to 
contact Initialization 
Server.

The Administration client 
could not disable the 
interface service because it 
could not reach the InitSrv 
process.

Try again later.

Unknown error received 
from server, error index 
number: xxxxx

The Administration client 
and the administration 
server components are out 
of sync.

Try again. If the problem 
persists, contact Avaya 
customer support.

Error message Description Resolution
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Retention periods

Scheduled jobs

Error message Description Resolution

Internal server error or 
client and server are out 
of sync. Contact support.

Either an internal server 
error occurred or the 
Administration client and 
the server are out of sync. 
The asynchronism is most 
likely caused by differing 
client and server software 
versions.

Upgrade the software 
version in your client or 
server.

The historical subsystem 
must be administered to 
access this page.

You need to configure the 
Historical subsystem first 
before you can do anything 
with this administration 
screen.

Go to the Subsystems 
screen and make sure the 
Historical subsystem exists 
and is configured properly 
(correct host, IP Address, 
and so on.).

Unknown error received 
from server, error index 
number: xxxxx

The Administration client 
and the administration 
server components are out 
of sync.

Try again. If the problem 
persists, contact Avaya 
customer support.

Error message Description Resolution

Can't aggregate data 
prior to the container 
creation date.

You entered an invalid date 
range. OA cannot aggregate 
data that does not exist.

Enter a valid date range.

Job name contains 
illegal character: \ / { ' " 
or Esc.

Your scheduled job name 
has illegal characters.

Do not use \ / { ' " or Esc 
when you name your host 
machine.

Scheduled job name 
exceeds maximum 
length of 40 characters.

The scheduled job name is 
too long. The maximum is 
40 characters.

Give your scheduled job a 
shorter name.

The Recurrence 
specifies date which do 
not exist.

You may not configure an 
external job to recur every 
30 if your recurrence cycle 
includes February, which 
does not have 30 days.

You must enter a valid day 
for the months.
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Schemas

Error message Description Resolution

A schema field can't be 
found. Please refresh 
the screen and try again.

The Administration client is 
not synchronized with the 
server.

Refresh your administration 
screen by clicking View > 
Refresh on the 
Administration client menu.

An error occurred 
validating the schema 
change request. Please 
try the change again. 
Contact your support 
organization if the 
problem persists.

OA could not validate the 
schema change requests.

Try your request again later. 
If the problem persists, 
contact your support 
organization.

Inconsistent data found 
in data schema tables. 
Contact your support 
organization.

The data schema tables are 
inconsistent. Your tables 
might contain data types 
that OA does not support.

Contact your database 
administrator.
If you are the database 
administrator, investigate 
your database and refer to 
the database vendor's 
documentation.

Internal server error 
occurred for data 
schema request. Contact 
your support 
organization.

You have an internal server 
error.

Contact your support 
organization.

Internal server error or 
client and server are out 
of sync. Contact your 
support organization.

You either have an internal 
server error or the 
Administration client and 
the server are out of sync. 
The asynchronism is most 
likely caused by differing 
client and server software 
versions.

Upgrade the software 
version in your client or 
server.

Internal parameter 
syntax error: client and 
server are out of sync. 
Contact your support 
organization.

The Administration client 
parameter validation failed 
due to a syntax error.

Contact your support 
organization.
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Invalid date field entry 
for: <field name>. Please 
enter time as 
mm-dd-yyyy.

You did not enter a valid 
date format.

You must use the 
mm-dd-yyyy format. The 
month and the day must 
have two digits, and the year 
must have four. July 4, 2001 
should be entered as 07/04/
2001.

Invalid time field entry 
for: <field name>. Please 
enter time as hh:mm.

You did not enter a valid 
time format.

You must use the hh:mm 
format. You must use two 
digits for the hour and the 
minutes. 3:02 a.m. must be 
entered as 03:02.

More than one schema 
field is selected. Please 
select one schema field 
and try again.

You tried to select two 
schema fields.

Modify only one field at a 
time.

Numeric field contains 
non-numeric 
character(s).

You have entered 
characters that are 
inconsistent with the field 
data type, that is you 
entered non-numeric 
characters.

Remove the non-numeric 
characters and enter valid 
characters. Enter numbers 
only.

Request failed. There 
isn't enough disk space 
to complete associated 
migration.

You do not have sufficient 
disk space to accommodate 
the new schema. The 
migration can not be 
completed because of this 
limitation.

Be less ambitious with your 
additions or increase your 
disk space

Required schema fields 
can't be modified.

You can not modify required 
schema fields.

You just have to leave the 
field alone.

Server couldn't get 
required resources. 
Please try again later.

The Administration client 
and the server may be out 
of sync. Or the server 
components may not be 
able to get needed 
resources, such as logging 
components.

Try again later. If this 
problem persists, contact 
your support organization.
See also General 
Administration client 
issues on page 122.

The default time is not 
correct. Please enter 
time as hh:mm:ss.

Time was entered 
incorrectly.

You must use the hh:mm:ss 
format. You must use two 
digits for the hour minutes, 
and seconds. 3:02:05 a.m. 
must be entered as 
03:02:05.

Error message Description Resolution
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Subsystems

The default value is not 
within the specified 
precision.

You have entered a default 
value that is not within the 
precision.

Enter a value that is within 
the specified precision.

This request is 
inconsistent with the 
server database. Please 
refresh and try again.

OA allows multiple 
Administration clients to 
connect to the server 
simultaneously but does not 
automatically update the 
administration data.
Someone else has changed 
the configuration settings 
and your Administration 
client is not reflecting the 
latest administration data.

Refresh your administration 
screen by clicking View > 
Refresh on the 
Administration client menu.
For more details, see Client 
not updated on page 124.

Unknown error received 
from server, error index 
number: xxxxx

The Administration client 
and the administration 
server components are out 
of sync.

Try again, if problem 
persists, contact Avaya 
customer support.

Error message Description Resolution

Error message Description Resolution

A non-unique site id has 
been specified: nnn

The site ID you entered is 
not unique.

You must have a unique site 
ID.

An invalid IP Address 
was specified. Please 
enter an address in the 
format: n.n.n.n, where 
each n is from 0 to 255.

You entered an invalid IP 
address.

Enter an IP address in a 
format n.n.n.n format, where 
each "n" is a value from 
0-255.

Client and server out of 
sync of server 
components can't be 
accessed. Contact your 
support organization.

The Administration client 
and the server are not in 
sync. This is most likely 
caused by differing client 
and server software 
versions.

Upgrade the software version 
in your client or server.

Corrupt data has been 
found in the database for 
the historical subsystem.

There is invalid data in 
your database. This could 
occur if someone manually 
alters the database.

Check to see if someone 
altered the database and if 
so, investigate the first day of 
week, first hour of day and 
the archive operations. 
Reverse the changes.
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Database contains 
corrupt subsystem 
information. Contact 
your support 
organization.

The database has no 
information about the 
subsystem, the Historical 
subsystem is not in the 
database, or someone 
manually altered the 
database.

Check to see if someone 
altered the database.

Host name contains 
illegal characters: \ / { ' " 
or Esc.

The host name has illegal 
characters.

Do not use \ / { ' " or Esc 
when you name your host 
machine.

Internal server error or 
client and server are out 
of sync. Contact your 
support organization.

The Administration client 
and the server are not in 
sync. This is most likely 
caused by differing client 
and server software 
versions.

Upgrade the software version 
in your client or server.

IP Address could not be 
derived from Host Name. 
Please enter a valid Host 
Name or IP Address.

OA could not look up the 
IP address using the 
provided host name. You 
have either provided a 
non-existent host name or 
your host does not have a 
DNS/hosts entry.

Enter a valid host name.

Server connection has 
been lost due to a 
CORBA failure. Please 
reconnect.

CORBA failure occurred 
during initialization.

Reconnect to the server by 
clicking File > Reconnect in 
the Administration client 
menu bar.

The following subsystem 
could not be deleted, one 
or more containers 
include its source id: 
xxxxx

OA cannot delete the 
source subsystem 
because it still contains 
containers.

You must delete the 
containers first before you 
can remove the subsystem.

The following subsystem 
name is not unique: 
xxxxx

You have entered a 
subsystem name that 
already exists.

Enter a different name.

The historical subsystem 
can not be deleted.

You can not delete the 
Historical subsystem.

Do not try to delete the 
Historical subsystem.

Error message Description Resolution
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Unable to lock the 
database tables needed 
to make this change. 
Please try again later.

Someone else is working 
on the database. The 
tables are locked and 
unavailable.

Try again later.

Unknown error received 
from server, error index 
number: xxxxx

The Administration client 
and the administration 
server components are out 
of sync.

Try again. If the problem 
persists, contact Avaya 
customer support.

Error message Description Resolution
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Troubleshooting basic reports and the report 
server

This section presents information about Basic Reports operation and the sources that 
provide the data Basic Reports utilize. The information in this section is designed to help 
you identify possible Basic Report trouble situations and associated corrective actions, and 
to provide you with details about the various database elements involved in the 
calculations required by each report.

This section includes the following topics:

● Historical report size limit on page 166

● Report client Java plug-in and Java console on page 167

● Authentication problems on page 169

● General problems on page 172

● Troubleshooting Stumbras on page 184

● Report calculations on page 195

If you desire higher-level descriptions of Basic Report calculations or behavior, refer to 
Avaya Operational Analyst Release 6.1 Reports Reference.
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Historical report size limit
By default, historical reports (including Work Item Detail) return no more than 500 rows. 
The one exception is the CMS Detail Report, which returns by default 5000 rows. These 
limits are imposed to prevent extremely large query jobs reports that could immobilize the 
report and historical database servers.

If a historical report reaches the row limit, an information page is displayed requesting that 
the input criteria be adjusted to reduce the number of rows returned. In certain 
circumstances, the row limit may be too low.

To increase the row limit:

1. Open the following file (default installation location shown):

● %PABASE%/stumbras/webapp/WEB-INF/config/Reports/DBTypeInfo/
DBTypeInfo.properties (Windows)

● $SUN_ONE_HOME/https-stumbras/webapp/WEB-INF/config/Reports/
DBTypeInfo/DBTypeInfo.properties (Solaris)

● $WEBSPHERE_HOME/installedApps/hostname/OAReports.ear/
stumbras.war/WEB-INF/classes/Reports/DBTypeInfo/
DBTypeInfo.properties (AIX)

Note:
Note: Avoid using a file editor such as Windows Notepad that can corrupt the file 

content by changing the encoding format. Use an editor that guarantees the 
UTF-8 encoding format, such as WordPad or TextPad.

2. Set ID_MAX_ROWNUM to a value greater than the current limit.

3. Save the file.

4. Restart the Stumbras service for the change to take effect.

! CAUTION:
CAUTION: Changing this limit can affect report and database server performance and 

kill the server processes.
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Report client Java plug-in and Java console
As an additional troubleshooting aid, the Report client logs messages in the Java Security 
Plug-in Java console window. The Java Console helps you diagnose problems that might 
occur when the applet initializes.

This section provides information to help you use the Java Console. Topics in this section 
include:

● Accessing the Java Plug-in Control Panel on page 167

● Enabling the Java Console on page 167

● Recycle Classloader on page 168

Accessing the Java Plug-in Control Panel
The Java Plug-in Control Panel lets you configure the security plug-in, the Java console, 
and Jar caching. You need to use the control panel to troubleshoot certain problems.

To access the Java Plug-in Control Panel (JRE 1.3) in Windows:

1. Select Start > Settings > Control Panel.
2. Double-click the Java Plug-in icon.

The Java Plug-in Control Panel launches.

Enabling the Java Console
You can view the Java Console to troubleshoot initialization errors.

Tip:
Tip: The Java Console, while useful for diagnosing problems, need not be 

enabled under normal operations.

To enable the Java Console:

1. Launch the Java Plug-in Control Panel.

2. In the Basic tab, select Show Java Console.

3. Click Apply, then close the window.

4. Re-launch the Administration client.

The Java Console appears when the Report client is starting.
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Tip:
Tip: To disable the Java console, follow the procedure above except to clear the 

Show Java Console check box. 

Recycle Classloader
Enable the Recycle Classloader option so you can launch the Report client more than 
once from one browser.

To recycle the classloader:

1. Launch the Java Plug-in Control Panel.

2. In the Basic tab, select Recycle classloader.
3. Click Apply, then close the window.

4. Restart the Administration client.

Tip:
Tip: To disable recycling of classloader, follow the procedure above except that 

you clear the Recycle classloader check box. 
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Authentication problems
This section describes problems seen when users are unable to log on to the Report client.

Note:
Note: All references to domains in this section refer to software residing on 

Windows servers only.

Symptom Solution

You see the message: "An invalid user 
name or password was entered. Please 
try again."

The cause can be one of the following:
● The user ID is not defined on the specified domain.
● The format to specify the domain and user ID is wrong 

(it should be <domain>\<userid> when the report 
server is on Windows).

● The password for the user on the domain is wrong.
● If no domain is specified, the authentication is done on 

the server where the Historical subsystem is located.
Verify all of the above on the server where the Report 
subsystem is installed.

You see the message: "The user is not 
authorized to do reports. Please try 
again."

The cause can be one of the following:
● The wrong domain is used.
● The user is not a member of the reports group on the 

specified domain (the group is defined when installing 
the Historical subsystem).

You see the message: "An instance of the 
authentication service could not be 
created. The user name and password 
could not be authenticated. Please try to 
login again."

The cause can be one of the following:
● The Report subsystem is not pointing to the right host 

name for the Historical subsystem. This is set in the 
%PABASE\AdminPol.html or %PABASE\
AdminSig.html files. Refer to the SERVER_NAME 
applet parameter in that file.

● The naming service is not running on the report server.
● The authentication service is not running on the server 

where the Historical subsystem is installed.
If this problem persists, contact Avaya support.

When logging on to the Report client, the 
following error message is displayed after 
you have failed to log in successfully after 
the allowed number attempts (default is 
three):
Error: 401
Location:/Stumbras/tree-viewer
No detailed message

This means that you have reached the maximum number 
of attempts to log on to the client. You need to wait 10 
minutes (default value) before you can try again with the 
same user ID.
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When attempting to access the Report 
server, the following is displayed:
You are not authorized to view
this page.
You do not have permission to
view this directory or page
using the credentials you
supplied.
HTTP 401.1 – Unauthorized:
Login Failed Internet
Information Services.

For Windows 2000 on the server machine containing the 
Report subsystem:

1. Select Start > Programs > Administrative Tools 
> Internet Services Manager.

2. Expand the tree view: server-name > Default Web 
Site. 

3. Right click on the Default Website > Properties. 
4. Click on the Directory Security tab. 
5. Click on the Edit button under the Anonymous 

access and Authentication control section. 
Verify that only the Anonymous access box is 
checked in the first section and the Integrated 
Windows authentication box is checked in the 
Authenticated access section.

6. Click the Edit button next to Account used for 
Anonymous Access. In the Anonymous User 
Account window, the value in the Username box 
MUST be IUSR_<ServerName>, where 
<ServerName> is the name of this server machine. 
If the machine was restored from an image that is 
not specifically for this machine, then this name will 
be incorrect which will cause IIS Anonymous 
Authentication to fail. If it is not correct, put in the 
correct machine name. Leave Allow IIS to control 
password checked. 

7. Click OK twice, and then click Apply. 
8. When the Inheritance Overrides box is displayed, 

do NOT select Jakarta; just click OK.
9. Click OK once more.

10. Exit the Internet Services Manager and attempt to 
display the basic reports again. If this value was 
incorrect previously, then the login window should 
now be displayed.

Symptom Solution
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When attempting to access the Report 
server, the following is displayed:
You are not authorized to view
this page.
You do not have permission to
view this directory or page
using the credentials you
supplied.
HTTP 401.1 – Unauthorized:
Login Failed Internet
Information Services.

For Windows NT on the server machine containing the 
Report subsystem:

1. Choose Start > Programs > Windows NT 4.0 
Option Pack > Microsoft Internet Information 
Server > Internet Service Manager. 

2. Expand the tree view: Internet Information Server 
> server-name > Default Web Site. 

3. Right click on the Default Website > Properties.
4. Click on the Directory Security tab.
5. Click on the Edit button under the Anonymous 

access and Authentication control section. 
Verify that only the Allow Anonymous Access 
and Windows NT Challenge/Response boxes 
are checked. 

6. Click the Edit button next to Account used for 
Anonymous Access. In the Anonymous User 
Account window, the value in the Username box 
MUST be IUSR_<ServerName>, where 
<ServerName> is the name of this server machine. 
If the machine was restored from an image that is 
not specifically for this machine, then this name will 
be incorrect which will cause IIS Anonymous 
Authentication to fail. If it is not correct, put in the 
correct machine name. Leave Enable Automatic 
Password Synchronization checked. 

7. Click OK twice, and then click Apply. 
8. When the Inheritance Overrides box is displayed, 

do NOT select Jakarta; just click OK.
9. Click OK once more.

10. Exit the Internet Services Manager and attempt to 
display the basic reports again. If this value was 
incorrect previously, then the login window should 
now be displayed.

Symptom Solution
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General problems
Basic Reports depends on many OA components and services being present, correctly 
configured, and running. The table below describes several possible trouble symptoms 
and actions you can take to resolve the problems.

Symptom Possible cause Solution

An error is displayed 
when clicking the 
localhost/report1 
link.

Services not running. 1. Verify that the Web service is running and 
automatic (Windows only).

2. Verify that the Data Manager is administered 
and running using:
pa disable dm

pa enable dm

3. Verify that the network is functional.
4. Verify that the Report subsystem is 

administered and running.
Refer to the Administration Client Help for more 
information about how to verify the status of the 
services and subsystems.

Unsatisfied link error Missing JRE or 
Report client files

Install the correct JRE and Report client files before 
launching any graphical reports.

1. Open a browser and go to the URL http://
<hostname:port number if any>/
reports1.   

2. Click on the last link from the tree-view in the 
left pane.

3. If the correct JRE is not installed, install the 
correct JRE.

4. Install the Report client files.

Unsatisfied link error 
because of failure to 
initialize JNv2432.dll

Incompatible 
hardware or software 
such as the graphics 
adapter.

See Client PC minimum hardware requirements on 
page 29 and Client software requirements on 
page 32 in Avaya Operational Analyst Release 6.1 
Installation Planning and Prerequisites. Update 
your client PC to meet the minimum requirements.

Basic reports do not 
run on a report client.

1. Report client files 
are not installed.
2. Insufficient swap 
space.

1. Install the report client files by clicking Install 
Reporting Support Files in the tree-view.

2. Be sure to configure at least 700 MB of swap 
space on the server where the Report 
subsystem is installed and each client 
running reports.
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Report client installer 
does not launch. The 
error message may 
indicate JVM is not 
found.

JRE is not installed 
on the report client 
machine.

1. Install the correct JRE by clicking on Install 
Reporting Support Files in the tree-view.

2. Install the Report client files.

Basic reports do not 
run after an upgrade 
from R6.0.x to R6.1.

The correct report 
client files are not 
installed.

1. Uninstall the current Report client files by 
executing C:\Program Files\Avaya\
BI\_uninst\uninstall.jar.

2. Install the latest Report client files by clicking 
Install Reporting Support Files in the 
tree-view.

Table-based basic 
reports run, but no 
graphical reports run.

Report client is not 
installed.

Download the client installation program from the 
tree-view, and install the client.

Report client is 
installed, but the applet 
is gray and no 
graphical reports 
appear.

Missing or 
incompatible Java 
Runtime Environment 
(JRE) or Java plug-in 
version.

Download and install JRE patch from http://
java.sun.com, or uninstall the current JRE or Java 
plug-in and launch the applet. This prompts you to 
download the correct plug-in. 
Alternatively, install the JRE on the report client 
machine from the installation CD.

Cannot run reports for 
multiple servers.

The same Internet 
Explorer session is 
pointing to multiple 
report servers. This is 
a Java limitation.

Launch a new Internet Explorer session for each 
report server by selecting the IE desktop icon or 
through the Start > Programs menu.

Date-time information 
does not reflect my 
time zone.

User�s time zone 
setting is incorrectly 
specified. (Each user 
must do this.)

1. Select User Settings from the tree-view.
2. Select the desired time zone from the menu.
3. Select Save to permanently set the time 

zone.

Negative duration 
values appear in any 
real-time reports.

IC and OA server 
clocks are not 
synchronized.

Follow the instructions in Time synchronization on 
page 131 of Avaya Operational Analyst 
Release 6.1 Installation Planning and Prerequisites 
to set server clock synchronization.

Aggregation selection 
box is empty on 
historical report input 
pages.

No containers 
defined.

Verify that containers are properly administered 
and enabled.
Allow time for new data to aggregate.
Refer to the Administration Client Help for more 
information about administering containers and 
scheduling jobs.

Symptom Possible cause Solution

http://java.sun.com
http://java.sun.com
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Graphical reports 
response is slow or 
reports do not appear.

Temporary directories 
are full.

As reports are accessed, associated Java JAR files 
are copied to the C:\temp or C:\winnt\temp 
folders. These files are not removed 
programmatically, and over time can consume a 
significant amount of memory. Delete these files on 
a regular basis to eliminate this problem.

You can log in to the 
Report server, but all 
reports show "Null 
PointerExceptions."

Communication 
between the Admin 
Manager and 
Stumbras may be 
down, resulting in 
missing database 
configuration 
information.

Review the ConfigService.properties file in 
%PABASE%\Stumbras\webapp\WEB-INF\
config\ConfigService (Windows), 
$SUN_ONE_HOME/https-stumbras/webapp/
WEB-INF/configConfigService (Solaris), or 
$WEBSPHERE_HOME/installedApps/
hostname/OAReports.ear/stumbras.war/
WEB-INF/config/ConfigService/
ConfigService (AIX) for configuration 
information. If this file does not exist, the report 
server and the Admin Manager are not 
communicating. See Troubleshooting Stumbras on 
page 184 for more information.

No Agent data in 
reports or some Agent 
data is missing

Agents are not 
properly configured 
with the role of 
"Agent" in IC 
Manager.

Verify that the role of Agent is selected in the 
agent's Security tab properties in the IC Manager.

Agent not 
administered for the 
correct domain in IC 
Manager.

Verify that the domain specified in the agent�s 
General tab is a domain that contains an OA Event 
Collector for the OA real-time system where the 
reports are being run.

IC Agent ADU 
servers are not 
running.

Verify the status the IC agent domain ADU servers. 
They should be up and running.

IC Agent ADU 
failover strategy is 
not correct.

Verify the IC system failover strategy for agent 
domain ADUs. The agent ADU server for the agent 
data in question may have failed over to an ADU 
server in another domain. Agent ADU servers must 
not be allowed to failover to ADU servers in 
domains that are not monitored by OA Event 
Collectors.

The agent may have 
failed over to an 
agent ADU domain 
that feeds a different 
OA Event Collector.

Verify that the agents in question have not failed 
over to another agent ADU domain. If multiple 
Event Collectors and OA real-time systems are 
configured, the agent's data may be appearing on a 
different OA real-time system's report.

Symptom Possible cause Solution
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On some OA installations, there have been 
problems selecting a large number of agents or 
service classes from a report input page that 
can create a large SQL query, which causes 
both DataManager and DataServer to crash. 
The DataManager and DataServer are java 
processes associated with the real time 
subsystem.
The issue manifests itself initially as an error 
message on the report just after hitting the 
Submit button on the final input page of the 
report. After the initial error, the OA system is 
unresponsive to requests to start a new report 
for about one minute while the DataManager 
and the DataServer are restarting.
An additional characteristic of this problem is 
that several errors will be logged in the 
$PABASE/data/log/CentralError/
CentralErrorLog.log file on Solaris and 
AIX, or the Event Viewer on Windows, by the 
OA DataManager, indicating that the Data Store 
has been invalidated. See example below:
ERROR - high: DataManager
OA:RT:DataManager:
0=DBService:invalidateDatabase: Database is
invalidated. Please
Reconnect::java.sql.SQLException:
[TimesTen][TimesTen 4.5.25 ODBC
Driver][TimesTen]TT0994: Data store
connection terminated. Please reconnect. --
file "sqlAPI.c", lineno 1175, procedure
"sb_sqlExec ()"

Edit the momtab entry for DataServer on the server 
that is running the Real-time subsystem. The 
momtab file is located at the following location:

%PABASE%\data\admin\mom\etc\
momtab (Windows)

$PABASE/data/admin/mom/etc/momtab 
(Solaris and AIX)

Edit the entry to include -Xss8m. The entry should 
look similar to the one below:
dsvr:4:respawn:{}java -Xrs
-DUSE_ADS=N -Xmx256m -Xss8m
com.avaya.cc.rtdss.ds.DataServerMain
-v 0

With DB2, some of the 
historical reports are 
displaying the following 
error message:
COM.ibm.db2.jdbc.
DB2Exception:
[IBM][CLI Driver]
CLI0115E Invalid
cursor state.
SQLSTATE=24000

This is caused when 
the DB2 server or 
client software has 
been installed without 
the recommended 
fixpak (patch) from 
IBM.

Apply the recommended DB2 fixpack on the 
machine where the DB2 server and client software 
is installed. See Software required for the historical 
database and Historical subsystem servers on 
page 34 in Avaya Operational Analyst Release 6.1 
Installation Planning and Prerequisites.

Symptom Possible cause Solution
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OA real-time reports 
may show agents with 
deferred email contacts 
that are never 
completed. 

This may be caused 
by ADU server 
behavior that 
removes, or clips, 
"old" data based on a 
configurable 
definition of what 
"old" is considered to 
be. OA monitors 
Agent records within 
the ADU to gather 
data on agent status. 
This monitoring is 
affected by record 
clipping. Email 
contact information in 
the Agent ADU 
record is susceptible 
to clipping because it 
can be relatively 
long-lived. If the 
Agent ADU record 
included deferred 
emails that were 
clipped by the ADU 
server, it is possible 
that OA will not be 
able to track 
subsequent activity 
against deferred 
emails when they 
become active again.

Contact information in the Agent ADU record is 
stored in an entity called a container. An ADU 
server is configured with a maximum number of 
containers an Agent ADU record may contain. As a 
workaround, the maximum number of containers 
that the ADU server will allow can be modified. As 
there is an impact in terms of ADU memory usage 
and event collector startup time, it is recommended 
that only the maximum number of email containers 
be changed. Additionally, it is recommended that 
the maximum number of email containers be no 
more than 50.
To modify the default value:

1. Log in to the IC Manager application.
2. Selecting the Server tab.
3. For each ADU server defined in the 

installation:
a. Right click on the associated ADU entry 

and select Edit....
b. In the resulting dialog select the ADU tab.

c. Right click somewhere on the background 
of the resulting page and select Show 
advanced properties....

d. Scroll down until the Subcontainer 
instances... button is visible and click the 
button.

e. The default value for the email 
subcontainer is represented by the entry 
email.4 where 4 is the default number of 
allowed subcontainers for the email 
channel. Increase this number to an 
appropriate value and select OK. It may 
take some experimentation to arrive at an 
appropriate value based on the email traffic 
volume and the length of time it typically 
takes to complete an email contact. When 
determining the new value keep in mind 
that the associated ADU server will require 
additional memory for each additional 
subcontainer. 

Symptom Possible cause Solution
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Multiple agent login IDs 
for the same agent.
In the input page of 
agent related historical 
reports, the old login ID 
will appear deleted 
while the new login ID 
for the same agent will 
appear active.

IC Agent 
administration in IC 
Manager allows the 
agent login ID to be 
modified. When this 
happens, OA will 
maintain two 
independent agent 
records that belong to 
the same agent. 
Ultimately, both 
real-time and 
historical reports will 
display two separate 
agent records without 
combining the two 
agent data since 
agents are 
distinguished by their 
login IDs in OA. Until 
the real-time interval 
rolls over, the 
real-time agent 
reports will continue 
to display as separate 
agents. 

When changing an agent login ID, delete the agent 
and then re-add the agent with the new login ID.

Symptom Possible cause Solution
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Assigning a previously 
used login ID to a new 
agent may cause agent 
data to be misidentified.

IC agents are 
uniquely identified in 
the OA database by 
their login ID, which is 
stored in the 
AgentLogin field in 
various tables. If an 
agent is deleted, and 
later a new agent is 
added using the 
same login ID, OA 
considers them the 
same agent. The 
display name for the 
old agent will be 
overwritten by the 
new name and will no 
longer be available. 
Historical reports may 
show data for the 
new agent and the 
old agent together. 
This same situation 
applies to CMS 
agents, VDNs, Skills, 
and Call Work Codes.

To avoid this situation, do not assign a previously 
used login ID to a new agent.

Agents that are in a 
working state during a 
pump-up will be put in 
the unknown state. 

Works as designed. No action required. All time that the agent spends 
working on the contact that they were assigned to 
during pump-up will be captured in the unknowndur 
for the agent. If the agent changes focus to work on 
a different contact that has been assigned after 
pump-up they will go to the working state. If the 
agent changes their focus again back to the 
original contact that they were working during 
pump-up, they will again return to the unknown 
state. When the agent finishes all work for contacts 
that existed at the time of pump-up, they should not 
go to the unknown state unless an attempt is made 
to put the agent in a working or wrap-up state and 
the contact assigned to them does not exist in the 
real-time DataManager.

VOIP calls are not 
included in the voice 
queue.

Works as designed. No action required. All VOIP calls are included in 
the channel.voice.default queue.

Symptom Possible cause Solution
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On Solaris systems, a 
second �firewall� 
authentication prompt 
may appear when the 
first report is launched 
a browser window. The 
immediate workaround 
is to complete the 
authentication prompt 
window with the login/
password used during 
initial report login. This 
will not occur in the 
same browser window 
after the firewall has 
been authenticated.

The Report 
subsystem server 
and the Report client 
machine may reside 
in different domains. 
The report user is 
being asked to 
authenticate into the 
new domain. 

Use a fully qualified host name of the report server 
to access reports

Verify the Report server and Report client are in the 
appropriate trust relationship.

The Sun ONE Web 
Server (formerly 
iPlanet) is not 
installed with a fully 
qualified name.

Verify there is a file http-[fully qualified
host name of the report server] under 
$SUN_ONE_HOME (as opposed to http-[the
short host name].
For instance, if the fully qualified host name of the 
report server is "peak1.domain2.com", then 
"http-peak1.domain2.com" is correct and 
�http-peak1� is not correct. If the short name was 
used during installation, reinstall the Sun ONE Web 
Server and the OA Report subsystem. 

No agent data in 
reports or some agent 
data is missing.

Agents are not 
properly configured 
with the role of Agent 
in IC Manager.

Verify that the role of Agent is selected in the 
agent's Security tab properties in the IC Manager.

IC Agent ADU 
servers are not 
running.

Verify the status of the IC agent domain ADU 
servers. They should be up and running.

IC Agent ADU 
failover strategy is 
not correct.

Verify the IC system failover strategy for agent 
domain ADUs. The agent ADU server for the agent 
data in question may have failed over to an ADU 
server in another domain. Agent ADU servers must 
not be allowed to failover to ADU servers in 
domains that are not monitored by OA Event 
Collectors.

EC server may not be 
configured to monitor 
the correct agent 
ADU domains.

Verify the list of monitored domains for EC server 
under the EventCollector tab for EC server in IC 
Manager. Also verify that a single domain has not 
been selected multiple times.

Misconfigured IC 
system.

Verify that the IC system is configured in IC 
Manager as directed in Avaya Interaction Center 
Release 6.1 Installation and Configuration.

Symptom Possible cause Solution
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Real-Time tabular and 
graphical reports may 
occasionally fail to 
refresh based on the 
load of the Real-Time 
data web server and 
the report refresh 
interval.

The user sees a 
"Cannot Find Server" 
or "The page cannot 
be displayed" error, 
which is displayed in 
the web browser. 
Third-party software 
constraint.

Refresh the web page via the Refresh toolbar 
button. To make this problem less likely to occur, 
use slower refresh rates or run fewer reports per 
web server. Graphical reports may stop refreshing.

The communication 
between the 
Real-time and Report 
subsystems are not 
working temporarily.

Close the browser and re-start. If the problem 
persists, verify that the Real Time and Report 
subsystems are operational.

Browser window 
disappears

Insufficient graphics 
memory

To run the graphical reports, your graphics adapter 
should have a minimum of 8MB in memory. When 
the graphics adapter does not have enough 
memory, you may experience losing the browser 
windows after a graphical report has started. It is 
also possible that the browser window may 
disappear before the report has fully launched. 
Upgrade the graphics adapter.

Insufficient virtual 
memory (swap 
space) 

If the amount of RAM on your PC already exceeds 
the minimum requirement for the virtual memory 
space (700 MB or more), it is not necessary to 
change the virtual memory space. If does not meet 
the 700 MB minimum, you must increase virtual 
memory to 700 MB or greater. To change the virtual 
memory:

1. Select Start > Programs > Settings > 
Control Panel. 

2. Select the Systems icon.
3. From the Systems dialog, select the 

Advance tab.
4. In the Advanced tab, select the Performance 

Options button.
5. When the Performance Options dialog 

opens up, select Change. This will open the 
Virtual Memory window. 

6. Enter a value of 700 (or greater) in the Initial 
size field. The Maximum size field should be 
something greater than the Initial size field 
value.   

7. Click OK three times to accept the change.

Symptom Possible cause Solution
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Browser window 
disappears (continued)

Missing JRE You should first verify whether the JRE has been 
installed.   Two ways to verify this are:
● If you have access to the registry, open the 

registry and select HKEY_LOCAL_MACHINE\
SOFTWARE\JavaSoft. In this folder, expand 
both the Java Plug-in and Java Runtime 
Environment subfolders and verify whether you 
see a folder for 1.3.1_06. If you do not see 
this, install the correct JRE.

● Search directories on your hard disk(s) and find 
out whether you have the correct JRE. The 
default location of the JRE is found in: C:\
Program Files\JavaSoft\JRE\1.3.1_06. 
If you cannot find this JRE, install the correct 
JRE.

Unable to launch the 
Java Plug-in Control 
Panel

To run the graphical reports, you must use the 
companion driver issued for the graphics adapter 
on your PC. If you use Microsoft�s default driver, 
you may experience loss of browser windows while 
graphical reports are running.   To verify or change 
the driver:

1. Right-click on your mouse from your desktop 
area and select Properties.

2. From the Display Properties dialog box, 
select the Settings tab. 

3. From the Settings tab, select the Advanced 
button. This will open a new dialog box.

4. Select the Adapter tab.
5. Select the Properties button.
6. In the displayed dialog box, select the Driver 

button.
7. Select a suitable driver compatible with your 

graphics adapter. 

Old graphics driver In some cases, the companion driver for your 
graphics adapter has been installed but the driver 
may be outdated causing a loss of browser 
windows. Visit the web site of your graphics 
adapter vendor and download the latest driver. If 
necessary, consult the installation guide issued by 
your graphics adapter vendor.

Incorrect resolution The minimum requirement for graphics resolution 
is 1024 x 768 pixels and 32,768 colors. If your 
resolution is too low, you may experience this 
problem. Increase the resolution to 1024 x 768.

Symptom Possible cause Solution



Troubleshooting basic reports and the report server

182 Avaya Operational Analyst R6.1 Maintenance and Troubleshooting

Real-time reports 
momentarily display 
errors.

This situation can 
occur when the 
process that collects 
operational data from 
the contact center is 
disrupted for any 
reason.

The user must start the report again.

Real-time reports are 
missing information.

This situation can 
occur when the 
process that collects 
operational data from 
the contact center is 
disrupted for any 
reason.

When data collection resumes this condition will 
correct itself. At this point, the reports will once 
again display the desired information. 

Printing a graphical 
report and then 
canceling it will cause 
Error dialogue to 
appear.

This is a third-party 
software constraint.

Click on the OK button on the error dialogue.

In the Work Item 
report's Input Page, 
when any of the 
duration or count fields 
are left with zeros, the 
Work Item Detail 
Reports will ignore zero 
values. Given certain 
input options, this may 
appear as missing 
data.

Information only. No action required.

Symptom Possible cause Solution
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You can still run reports 
after the Report 
subsystem is deleted 
using the Admin client.

The Report 
subsystem is still 
actively in service.

OA does not guarantee correct functionality if the 
user continues to run the reports after the report 
subsystem has been deleted. Stop the 
Stumbras-Tomcat service for IIS on Windows, stop 
the Stumbras virtual host server for iPlanet on 
Solaris, or stop the Stumbras virtual host server for 
WebSphere on AIX.

agentcapsetinfo has 98 
in the agentrole column 
for the 
channel.voice.default 
service class

You will not have 
agent roles defined 
for an agent for the 
default svcclass 
unless you administer 
one for that agent in a 
capability set in a 
profile that matches 
the default svcclass 
(for example, 
_Channel._Call).

Administering default service classes is not 
enough. You also have to administer matching 
capability sets for the agent.

Symptom Possible cause Solution
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Troubleshooting Stumbras
Stumbras is the reporting framework that provides communication between a Web (HTTP) 
server and basic reports. Stumbras also provides services that maintain historical 
database pool connections and real-time connections.

This section includes the following topics:

● Viewing and changing the error logging level on page 184

● Common Stumbras problems on page 185

● Troubleshooting Stumbras on Solaris on page 187

● Troubleshooting Stumbras on AIX on page 191

Viewing and changing the error logging level
Stumbras offers a logging service, which by default logs to the OA main logger and the 
Stumbras in-memory logger.

To view and change the error logging level:

1. Enter:

http://hostname/stumbras/admin

where hostname is the name of your Report server. 

2. In the left pane, select Logging Admin.

3. In the right pane, select Runtime Settings.

4. Under Current Logging Level, select Change to view the current setting.

5. To increase the number of messages captured, set the log level to DEBUG. Use this 
level carefully since increasing the number of messages can affect disk space and 
system performance.

6. Select Set.

Note:
Note: You must have administrator privileges to set the debugging level.
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Common Stumbras problems
This table lists some common Stumbras trouble symptoms and solutions.

Symptom Possible cause Solution

Cannot connect to the 
database.

Profile service failed. Verify the dbname assigned is the same as the 
dbpool name used by the DbPool service. (The 
name is case sensitive.)

Verify the JDBC driver name matches the 
relevant HTDB server type. The implementation 
class should be:

● Oracle:
com.avaya.stumbras.services.profile.Oracle8i
Storage

● SQL Server 2000:
com.avaya.stumbras.services.profile.JdbcBlob
Storage

● DB2
com.avaya.stumbras.services.profile.JdbcBlob
Storage

No real-time reports run 
and an error page is 
displayed.

RTPA service failed to 
start.

Verify the Admin Manager is running and is 
configured for Stumbras.

No historical reports run 
and an error page is 
displayed.

DbPool service failed 
to start.

Verify the Admin Manager is running and is 
configured for Stumbras.

Valid Stumbras users 
are denied access.

Authorization server 
failed.

Verify that the authorization server (autserver) is 
running on the server where the Historical 
subsystem is installed.

Note:
Note: After 3 consecutive login failures, 

you are locked out and you must 
wait for 10 minutes before trying 
again.
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Report tree-view is not 
displayed (Windows 
only)

Stumbras failed to start. Check these log and error files for information:
$PABASE/data/log/reports/
reportlog.XX.log
● ../tomcat/jvm.stderr
● ../tomcat/jvm.stdout
● ../tomcat/hs_pidXXX.log (where XXX is 

some number)
● ../tomcat/logs/isapi.log
● ../tomcat/logs/jasper.log
● ../tomcat/logs/servlet.log
● ../tomcat/logs/tomcat.log

The HTML links in the 
tree-view do not work 
(Solaris only)

The client PC is in a 
different subnet than 
the Report server.

For Solaris reporting only, if the client PC is in a 
different subnet than the Report server, the hosts 
file on the client PC should be modified to include 
the Report server.

Symptom Possible cause Solution
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Troubleshooting Stumbras on Solaris
This section describes troubleshooting information for Stumbras on Solaris using the Sun 
ONE Web Server software (formerly, iPlanet).

This section includes the following topics:

● Variables on page 187

● Basic Stumbras troubleshooting on page 187

● Common problems and solutions on page 189

● Troubleshooting firewall authentication issues on page 190

Variables

Throughout this troubleshooting, the following variables are used:

● $PABASE refers to the default OA installation directory, usually /export/home/
biadmin/BI.

● $STUMBRASBASE refers to the Stumbras home directory, usually $SUN_ONE_HOME/
https-stumbras.

Basic Stumbras troubleshooting

To verify basic functionality:

1. Verify that the correct version of Sun ONE Web server was installed.

2. Verify that Sun ONE was installed correctly. See Installing and configuring Sun ONE 
Web Server on a Solaris machine on page 119 in Avaya Operational Analyst 
Release 6.1 Installation Planning and Prerequisites.

Sun ONE should be installed with the FQDN for the application server. This is key to 
avoiding firewall issues. 

Sun ONE installs two servers under the install directory (the default is 
$SUN_ONE_HOME). A valid installation will result in:

● An administrative server called https-admsrv

● A Web server called https-[fully qualified server name] (for example, 
https-system.dr.company.com.

● If the OA Report subsystem has been administered and the Web server is running, 
then there will be a third server, a Report server called https-stumbras.

Verify the web server name is fully qualified, for example, 
https-system.dr.company.com instead of https-system. If it is not, you should 
reinstall the Sun ONE using the fully qualified server name.
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3. Verify that the Report subsystem has been configured.

Using the Subsystems screen of the Administration client, verify that the Report 
subsystem has been configured. See Adding a Report subsystem on page 120 in 
Avaya Operational Analyst Release 6.1 Installation and Configuration.

4. Verify that Stumbras is running. From a command line, enter:

ps –ef | grep stumbras

If Stumbras is running, a message similar to the following is displayed: 

5. Verify that the Report subsystem configuration was successful.

When the Report subsystem is configured, the Administration manager only updates 
changes every four to five minutes, so the change may not appear immediately.   
When successful, two files are created:

● $PABASE/data/admin/stumbras.properties

● $STUMBRASBASE/webapp/WEB-INF/config/ConfigService/
ConfigService.properties

If these files have not been created, check the file permissions of their directories. 

6. Verify that the report page displays and tries to authenticate the user.

When the Report server URL is entered, the reports page displaying AVAYA in the 
main frame and a blank left frame appears. A pop-up windows requests the user to 
authenticate. 

If a Page not found error occurs:

● Check the URL for the format http://[fully qualified server
name]:[stumbras port number]/reports1.

● Verify that Stumbras is running using ps -ef | grep stumbras.

● Verify that there are no network blockages.

When the user is correctly authenticated, the pop-up window closes and the left frame 
displays the tree view with links to OA reports. 

If the authentication pop-up closes, yet the reporting tree does not appear (with or 
without an error message), verify the authentication status. Check the $PABASE/
data/log/CentralErrorLog/CentralErrorLog.log and $PABASE/data/
log/reports/reports.log error files.

biadmin 19146 19138 0 11:09:57 pts/14 0:00 grep iplanet
biadmin 8958 8957 0 Dec 15 ? 0:01 ns-httpd -d /usr/

iplanet/servers/https-stumbras/config
biadmin 8959 8958 0 Dec 15 ? 2:01 ns-httpd -d /usr/

iplanet/servers/https-stumbras/config
biadmin 8957 1 0 Dec 15 ? 0:00 ./uxwdog -d /usr/

iplanet/servers/https-stumbras/config
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Common problems and solutions

This section contains some common Stumbras symptoms and solutions.

Symptom Solution

Failed authentication 
on the Solaris 
machine.

Verify the user ID, user password, and that the user is a 
member of the reports group.

Failed authentication 
at the network level.

Verify that the user ID and password authenticates across 
the network.

Login attempts failed 
three times and 
caused a lockout.

Verify that the user ID, password, and group are correct. 
The file $PABASE/data/admin/
autserver.properties specifies the lockout time and 
number of allowed retries. If these are modified, the 
autserver process must be stopped and restarted.

! SECURITY ALERT:
SECURITY ALERT: Changing the allowed number of retries can 

open your system to possible attacks from 
unauthorized persons. Avaya recommends 
that you do not increase the number of 
allowed retries.

Authentication 
request was not 
received (does not 
appear in 
autserverTrc.log 
logs).

Look at the Web server Stumbras logs (report logging will 
not yet have been turned on) in $STUMBRASBASE/logs/
errors. This may indicate that the system has not 
initialized correctly. This could be caused by file permission 
problems. Check the /tmp/https-stumbras directory 
for permissions. If the user and group are not set correctly, 
stop the Web server, remove the /tmp/https-stumbras 
directory, and restart the Web server. The directory will be 
recreated with the proper permissions.

The HTML links in the 
tree-view do not work.

For Solaris reporting only, if the client PC is in a different 
subnet than the Report server, the hosts file on the client 
PC should be modified to include the Report server. The 
hosts file is located at c:\WINDIR\system32\drivers\
etc where WINDIR is Winnt for Windows 2000 and 
Windows for Windows XP.
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Troubleshooting firewall authentication issues

On some systems, when the first report is launched from the client, a second 
authentication screen pops up and requests a network password to cross a firewall.   After 
the user correctly authenticates once, the request no longer occurs.

All subsequent authentication requests come from Java and are not explicitly called from 
Stumbras. The problem can occur for a variety of reasons, and therefore has several 
workarounds. You may be experiencing some or all of these problems.

To troubleshoot firewall authentication problems:

1. Verify that Sun ONE was installed correctly. See Installing and configuring Sun ONE 
Web Server on a Solaris machine on page 119 in Avaya Operational Analyst 
Release 6.1 Installation Planning and Prerequisites.

Sun ONE should be installed with the FQDN for the application server. This is key to 
avoiding firewall issues. 

Sun ONE installs two servers under the install directory (the default is 
$SUN_ONE_HOME). A valid installation will result in:

● An administrative server called https-admsrv

● A Web server called https-[fully qualified name] (for example, 
https-system.dr.company.com.

● If the OA Report subsystem has been administered and the Web server is running, 
then there will be a third server, a Report server called https-stumbras.

Verify the web server name is fully qualified, for example, 
https-system.dr.company.com instead of https-system. If it is not, you should 
reinstall the Sun ONE using the fully qualified server name.

2. Compare the domains of the Report subsystem server and Report client.

The Report subsystem and the Report client do not need to be in the same domain or 
in a trusted relationship. However, if they are not, the fully qualified host name must be 
used for the report URL. For example, http://system.dr.company.com:11000/
reports1 instead of http://system:11000/reports1.

3. Verify that the Report subsystem was installed correctly.

Check the following two files to verify that they each reference the correct fully qualified 
Report server name (the server where Sun ONE is installed).

● $SUN_ONE_HOME/https-stumbras/config/server.xml

● $SUN_ONE_HOME/https-stumbras/config/webpub.conf
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Troubleshooting Stumbras on AIX
This section contains troubleshooting information for WebSphere installed on the AIX 
operating system.

This section includes the following topics:

● WebSphere log files on page 191

● WebSphere trouble conditions on page 192

WebSphere log files

Log messages for WebSphere are saved at:

$WEBSPHERE_HOME/logs/server1

Log messages for Stumbras are saved at:

/opt/BI/data/log/reports/reportlog.log

Log messages for the OA installation of Stumbras under WebSphere (OAReports.ear) 
are saved at:

/home/biadmin/ws_install_logs

Check these log files for WebSphere-related problems.
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WebSphere trouble conditions

This section contains a variety of possible trouble conditions and solutions to the condition.

Symptom Solution

WebSphere will not 
start

● Check the $WEBSPHERE_HOME/logs/server1 log 
files.

● There may be a conflict with the default administration 
port of 9090. See Changing the administration port on 
page 122 in Avaya Operational Analyst Release 6.1 
Installation Planning and Prerequisites.

● When running WebSphere as a non-root user, 
permission changes may be incomplete. Check the 
following:

- Remove the WebSphere logs after each failed 
attempt.

- Use ls -lR $WEBSPHERE_HOME to find files that 
do not have the correct permissions. Correct as 
needed. See Changing file permissions on 
page 127 in Avaya Operational Analyst 
Release 6.1 Installation Planning and Prerequisites 
for more information.

- The non-root user must be a member of the primary 
group.

- The primary group of the non-root user must match 
the group given to WebSphere to "Run As."

OA reports will not run ● Check the $WEBSPHERE_HOME/logs/server1 
messages.

● There may be a possible conflict with the default context 
root of "/". Do the following:

- Using the WebSphere Administrative Console, 
select Enterprise Applications to check for other 
applications with the default context root.

- Remove the applications or lower their weight.

Note:
Note: Never remove the Administrative Console 

Enterprise Applications. Remove any other 
applications that are not used, or lower their 
restart time.
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Basic Stumbras 
functionality not 
working correctly

● Check the /opt/BI/data/log/reports/
reportlog.log file. Verify that there are five lines 
showing that services have been started.

● OAReports.ear may have not installed properly. Verify 
the installation by checking that the directory 
$WEBSPHERE_HOME/installedApps/hostname/
OAReports.ear/stumbras.war has subdirectories 
of META-INF, WEB-INF, reports1, and stumbras.

● Check the messages in the log files at /home/
biadmin/ws_install_logs.

● If there are no obvious installation errors, increase 
available file system space, uninstall the Report 
subsystem, and reinstall the Report subsystem.

Stumbras cannot 
connect to the 
historical database

● Check the /opt/BI/data/log/reports/
reportlog.log file. Verify that there are five lines 
showing that services have been started.

● If the DBPool service (the connection to the historical 
database) has not started:

- Verify that the database name is OADB_AKA in the 
$WEBSPHERE_HOME/installedApps/
hostname/OAReports.ear/stumbras.war/
WEB-INF/config/ConfigService/
ConfigService.properties.

- Verify the database connection by using db2
connect to OADB_AKA as user using
password.

● OAReports.ear may have not installed properly. Verify 
the installation by checking that the directory 
$WEBSPHERE_HOME/installedApps/hostname/
OAReports.ear/stumbras.war has subdirectories 
of META-INF, WEB-INF, reports1, and stumbras.

● Check the messages in the log files at /home/
biadmin/ws_install_logs.

● If there are no obvious installation errors, increase 
available file system space, uninstall the Report 
subsystem, and reinstall the Report subsystem.

Symptom Solution
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The login ID used to 
access the reports will 
not authenticate.

● Check the authentication and report logs.
● The login ID is not in the correct group. It must be a 

member of the reports group. Check the /opt/BI/
data/admin/autserver.properties file and /
etc/group.

● The password is invalid. Verify that the password works 
when logging in to the OS.

● The authentication server is not running. Use the pa
list command on the server where the Historical 
subsystem is installed to verify that the autserver 
process is running.

● WebSphere was not restarted properly:
- Only OAReports.ear was restarted.
- The /opt/BI/.profile was not run prior to 

starting WebSphere.

All OA processes 
stopped on the server 
where the Report 
subsystem is installed

If WebSphere is running as root (not the recommended 
configuration) and Stumbras writes the last error message 
into $PABASE/data/log/CentralError/
CentralErrorLog.log before rolling over, Stumbras will 
change the permissions of CentralErrorLog.log to 
root. Other processes will not be able to write to 
CentralErrorLog.log and will not start. Do the 
following:
● Check for root ownership of CentralErrorLog.log 

files. Restore ownership to the appropriate group and 
user.

● Change WebSphere to run as a non-root user.
● Restart OA (pa start all).

Cannot connect to the 
real-time database

● Verify that the dm, dsvr, and crds processes are 
running on the server where the Real-time subsystem is 
installed.

● Verify that the Corba gateway addresses appear in 
$WEBSPHERE_HOME/installedApps/hostname/
OAReports.ear/stumbras.war/WEB-INF/
config/ConfigService/
ConfigService.properties.

● Stop and start dm, followed by crds, if you have more 
than one Real-time subsystem.

Graphical reports do 
not display the pop-up 
screen to save the 
report

The correct version of WebSphere has not been installed. 
Install WebSphere 5.0.1.

Symptom Solution
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Report calculations
This section presents the database items used in the calculations for the Basic Reports. If 
you are interested in a more high-level discussion of the generic values used in the 
calculations, see Avaya Operational Analyst Release 6.1 Reports Reference.

The reports in this section include:

● Agent Set Outcome Codes - Historical on page 196

● Agent Set Outcome Codes - Real-time on page 197

● Agent Performance - Historical - CMS Version on page 198

● Agent Performance - Historical - IC Version on page 200

● Agent Performance - Real-time on page 202

● Agent Performance by Job - Historical on page 204

● Agent Performance by Job - Real-time on page 207

● Agent Performance by Service Class and Queue - Historical on page 210

● Agent Performance by Service Class and Queue - Real-time on page 213

● Agent Performance by Skill - Historical on page 215

● Agent Time in State - Real-time on page 218

● Job Performance - Historical on page 219

● Job Performance - Real-time on page 222

● Service Class and Queue Performance - Historical on page 223

● Service Class and Queue Performance - Real-time on page 226

● Service Class and Queue Status - Real-time on page 228

● Service Class and Queue Volume - Historical on page 234

● Skill Performance - Historical on page 236

● System Set Completion Codes - Historical on page 238

● System Set Completion Codes - Real-time on page 239

● Telephone Number States - Real-time on page 240

● Detail reports on page 241
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Agent Set Outcome Codes - Historical
The OA database items used to determine the content of the drop-down lists are:

The OA database items and calculations used to populate the table are:

Input screen Database table Database item

Agents Employee
GroupMember
Workgroup
Channel

Display Employee.FullName (Employee.LoginName)
where Employee.Pkey = Channel.Employee_Key and 
GroupMember.EmployeeGroup = Employee.PKey and 
GroupMember.WorkgroupGroup = Workgroup.Pkey for 
one of the selected workgroups

Jobs JobInfo
DialerInfo
AgentCompCode

JobInfo.JobName (DialerInfo.DialerName) where 
AgentCompCode.JobID = JobInfo.JobID and where 
AgentCompCode.DialerID = DialerInfo.DialerID

Outcome Codes 
to Include

AgentCompCodeInfo AgentCompCodeName where ClassCodeType = 3 
(outcome code)

Visual Representation Database table Database value or calculation

<outcome code count> AgentCompCode AgentCompCodeCnt summed over the report 
interval where JobID = the ID of this job and 
AgentLogin = the login ID of this agent and 
AgentCompCodeID = the ID of this outcome 
code

Total N/A The sum of the values in the respective column

<agent name (agent ID)> AgentState AgentName (AgentLogin)

<job name (dialer name)> JobInfo
DialerInfo
AgentCompCode

JobInfo.JobName (DialerInfo.DialerName) 
where AgentCompCode.JobID = JobInfo.JobID 
and where AgentCompCode.DialerID = 
DialerInfo.DialerID

<outcome code x name> AgentCompCodeInfo AgentCompCodeName where 
AgentCompCodeID = an ID of one of the 
selected outcome codes

<all other outcome codes 
for agent x and job y>

AgentCompCode sum of all AgentCompCodeCnt summed over 
the report interval where JobID = the ID of this 
job and AgentLogin = the login ID of this agent 
and AgentCompCodeID = the ID of an 
unselected outcome code
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Agent Set Outcome Codes - Real-time
The OA database items used to determine the content of the drop-down lists are:

The OA database items and calculations used to populate the table are:

Input screen Database table Database item

Agents Employee
GroupMember
Workgroup
Channel

Display Employee.FullName (Employee.LoginName)
where Employee.Pkey = Channel.Employee_Key and 
GroupMember.EmployeeGroup = Employee.PKey and 
GroupMember.WorkgroupGroup = Workgroup.Pkey for 
one of the selected workgroups

Jobs JobSummary
DialerInfo

JobSummary.JobName (DialerInfo.DialerName) where 
JobSummery.DailerID = DialerInfo.DialerID

Outcome Codes 
to Include

AgentCompCodeInfo AgentCompCodeName where ClassCodeType = 3 
(outcome code)

Visual Representation Database table Database value or calculation

<outcome code count> AgentCompCode AgentCompCodeCnt where JobID = the ID of this 
job and AgentLogin = the login ID of this agent and 
AgentCompCodeID = the ID of this outcome code

Total N/A The sum of the values in the respective column

<agent name (agent ID)> AgentState AgentName (AgentLogin)

<job name (dialer name)> JobSummary
DialerInfo

JobSummary.JobName (DialerInfo.DialerName) 
where JobSummary.DialerID = DialerInfo.DialerID

<outcome code x name> AgentCompCode AgentCompCodeName where AgentCompCodeID 
= an ID of one of the selected outcome codes

<all other outcome codes 
for agent x and job y>

AgentCompCode sum of all AgentCompCodeCnt where JobID = the 
ID of this job, AgentLogin = the login ID of this 
agent, AgentCompCodeID = the ID of an 
unselected outcome code
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Agent Performance - Historical - CMS Version
The OA database items used to determine administered agents for the input screen are:

The OA database items and calculations used to populate the report floor are:

The OA database items used to determine the content of the screen tip on data columns 
are:

The OA database items used to determine the screen tip data for x-axis labels are:

Input parameter Database table Database item

Agents CMSAgentInfo LogName (LogID, <Data Source Name>)

Statistic Database table Database item or calculation

Number of ACD 
Calls

CmsAgent acdcalls + da_acdcalls summed across all skills for this 
agent

Average ACD 
Duration

CmsAgent (acdtime + da_acdtime) / (acdcalls + da_acdcalls) the 
numerator and denominator are separately summed across 
all records for this agent

Average ACW 
Duration

CmsAgent (acwtime + da_acwtime) / (acdcalls + da_acdcalls) the 
numerator and denominator are separately summed across 
all records for this agent

Screen tip label text Database table Database item or calculation

Agent N/A Associated agent name

Date N/A The associated date/time category

<name of statistic being 
displayed>

N/A Height of the column

Screen tip label text Database table Database item or calculation

Agent N/A From associated floor x-axis label

Login ID CMSAgentInfo LogID

Data Source N/A The data source from the input page selection
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The OA database items used to determine the screen tip data for y-axis labels are:

The OA database items and calculations used to populate the left and right walls are:

The OA database items used to determine the content of the left wall screen tip are:

The OA database items used to determine the content of the right wall screen tip are:

Screen tip label text Database table Database item or calculation

Date N/A From associated floor y-axis label

Floor statistic Database item or calculation

Number of ACD Calls When the selected statistic for the wall is Total of Floor Data:
(b1+ b2+ b3+ �+ bn) where b = the value a floor column for this 
Skill, and where n = the number of columns on the floor for this 
Skill or date as appropriate

● Number of ACD Calls
● Average ACD Duration
● Average ACW Duration

When the selected statistic for the wall is Average of Floor Data:
[(c1+c2+c3+�+cn)/ (b1+ b2+ b3+ �+ bn)] where c = is the 
numerator used to calculate the height of the floor column and 
where b = the denominator used to calculate the height of the floor 
column and where n = the number of columns on the floor for this 
Skill or date as appropriate.

Screen tip label text Database table Database item or calculation

Agent N/A From associated floor x-axis label

<name of statistic being 
displayed>

N/A Value of respective bar

Screen tip label text Database table Database item or calculation

Date N/A From associated floor y-axis label

<name of statistic being 
displayed>

N/A Value of respective bar
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Agent Performance - Historical - IC Version
The OA database items used to determine administered agents for the input screen are:

The OA database items and calculations used to populate the report floor are:

Input parameter Database table Database item

Agents Employee
GroupMember
Workgroup
Channel

Display Employee.FullName (Employee.LoginName)
where Employee.Pkey = Channel.Employee_Key and 
GroupMember.EmployeeGroup = Employee.PKey and 
GroupMember.WorkgroupGroup = Workgroup.Pkey for 
one of the selected workgroups

Statistic Database table Database item or calculation

Number of Work Items 
Completed 

AgentSvcClass
AgentJob

AgentSvcClass.WkForwardedCnt + 
AgentSvcClass.WkTransferredCnt

Number of Work Items 
Opened 

AgentSvcClass
AgentJob

AgentSvcClass.WkOpenedCnt + 
AgentJob.WkOpenedCnt

Average Work Duration AgentSvcClass
AgentJob

[(WkWorkDur summed across all records in 
AgentSvcClass for this agent) + (WkWorkDur 
summed across all records in AgentJob for this 
agent)]
/
[((WkForwardedCnt + WkTransferredCnt) 
summed across all records in AgentSvcClass 
for this agent) + (WkForwardedCnt summed 
across all records in AgentJob for this agent)]

Average Wrap-Up Duration AgentSvcClass
AgentJob

[(WkWrapupDur summed across all records in 
AgentSvcClass for this agent) + 
(WkWrapupDur summed across all records in 
AgentJob for this agent)]
/
[((WkForwardedCnt + WkTransferredCnt) 
summed across all records in AgentSvcClass 
for this agent) + (WkForwardedCnt summed 
across all records in AgentJob for this agent)]
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The OA database items used to determine the content of the screen tip on floor columns 
are:

The OA database items used to determine the screen tip data for x-axis labels are:

The OA database items used to determine the screen tip data for y-axis labels are:

The OA database items and calculations used to populate the left and right walls are:

Screen tip label text Database table Database item or calculation

Agent N/A From associated floor x-axis label

Date N/A From associated floor y-axis label

<name of statistic being 
displayed>

N/A Value of respective column

Screen tip label text Database table Database item or calculation

Agent N/A From associated floor x-axis label

Login ID AgentInfo AgentLogin

Screen tip label text Database table Database item or calculation

Date N/A From associated floor y-axis label

Floor statistic Database item or calculation

● Number of Work Items 
Forwarded

● Number of Work Items 
Opened

When the selected statistic for the wall is Total of Floor Data:
(b1+ b2+ b3+ �+ bn) where b = the value a floor column for this service 
class or queue, and where n = the number of columns on the floor for 
this service class/queue or date as appropriate
Note that the walls shall not display Total of Floor Data when Average 
type statistics are displayed on the floor.

● Number of Work Items 
Forwarded

● Number of Work Items 
Opened

● Average Work 
Duration

● Average Wrap-Up 
Duration

When the selected statistic for the wall is Average of Floor Data:
[(c1+c2+c3+�+cn)/ (b1+ b2+ b3+ �+ bn)] where c = is the numerator 
used to calculate the height of the floor column and where b = the 
denominator used to calculate the height of the floor column and where 
n = the number of columns on the floor for this service class/queue or 
date as appropriate.
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The OA database items used to determine the content of the left wall screen tip are:

The OA database items used to determine the content of the right wall screen tip are:

Agent Performance - Real-time
The OA database items used to determine administered agents for the input screen are:

Screen tip label text Database table Database item or calculation

Agent N/A From associated floor x-axis label

<name of statistic being 
displayed>

N/A Value of respective bar

Screen tip label text Database table Database item or calculation

Date N/A From associated floor y-axis label

<name of statistic being 
displayed>

N/A Value of respective bar

Input parameter Database table Database item

Agents Employee
GroupMember
Workgroup
Channel

Display Employee.FullName (Employee.LoginName) 
where
Employee.Pkey = Channel.Employee_Key and 
GroupMember.EmployeeGroup = Employee.PKey and 
GroupMember.WorkgroupGroup = Workgroup.Pkey for 
one of the selected workgroups
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The OA database items and calculations used to populate the report floor are:

The data base items used to determine the contents of the screen tip are:

Statistic Database table Database item or calculation

Number of Work 
Items Open

AgentState WkOpenCnt

Average Work 
Duration

AgentSvcClass
AgentJob

[(WkWorkDur summed across all records in 
AgentSvcClass for this agent) + (WkWorkDur summed 
across all records in AgentJob for this agent)]
/
[((WkForwardedCnt + WkTransferredCnt) summed across 
all records in AgentSvcClass for this agent) + 
(WkForwardedCnt summed across all records in AgentJob 
for this agent)]

Average Wrap-Up 
Duration

AgentSvcClass
AgentJob

[(WkWrapupDur summed across all records in 
AgentSvcClass for this agent) + (WkWrapupDur summed 
across all records in AgentJob for this agent)] 
/
[((WkForwardedCnt + WkTransferredCnt) summed across 
all records in AgentSvcClass for this agent) + 
(WkForwardedCnt summed across all records in AgentJob 
for this agent)]

Idle Available 
Duration

AgentState If AgentState = Idle and Availability = Available, then Idle 
Available Duration = IdleAvailDur 
+((Current_Time_of_Day) - 
MAX(AgentState.StateStartTime, start of current base 
interval))
else
Idle Available Duration = IdleAvailDur

Aux Work 
Duration

AgentState If AgentState = On Break, then On Break Duration = 
OnBreakDur +((Current_Time_of_Day) - 
MAX(AgentState.StateStartTime, start of current base 
interval))
else
On Break Duration = OnBreakDur

Screen tip label text Database table Database item or calculation

Agent AgentState AgentName

Login ID AgentState AgentLogin

Login Date/Time AgentState LoginTime

name of statistic being displayed N/A Value of respective column.
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Agent Performance by Job - Historical
The OA database items used to determine drop-down box items for the input screen are:

The OA database items used to determine the entities on the report floor are:

Agent State AgentState AgentStateName

Current Mode AgentState If AgentState.Mode = 1 (inbound) display 
StaticNameInfo.DisplayName where 
StaticNameInfo.IDType = "Mode" and 
StaticNameInfo.ID = 1
If AgentState.Mode = 2 (outbound) display 
StaticNameInfo.DisplayName where 
StaticNameInfo.IDType = "Mode" and 
StaticNameInfo.ID = 2
If AgentState.Mode = 3 (aux) or 0 
(unknown) display <blank>

If AgentState.JobsSubscribedCnt 
> 0 Number of Subscribed Jobs

AgentState JobsSubscribedCnt

Screen tip label text Database table Database item or calculation

Input parameter Database table Database Item

Agents Employee
GroupMember
Workgroup
Channel

Display Employee.FullName (Employee.LoginName)
where Employee.Pkey = Channel.Employee_Key and 
GroupMember.EmployeeGroup = Employee.PKey and 
GroupMember.WorkgroupGroup = Workgroup.Pkey for 
one of the selected workgroups

Jobs AgentJob AgentJob.JobID + JobInfo.JobName

Statistic Database table Database item or calculation

Average Work Duration AgentJob WkWorkDur / (WkForwardedCnt + 
WkTransferredCnt)

Average Wrap-Up Duration AgentJob WkWrapupDur / (WkForwardedCnt + 
WkTransferredCnt)

Total Work Duration AgentJob WkWorkDur

Total Wrap-Up Duration AgentJob WkWrapupDur

Average Preview Duration AgentJob WkPreviewDur / WkPreviewCnt
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The OA database items used to determine the content of the floor column screen tips are:

The OA database items used to determine the screen tip data for x-axis labels are:

The OA database items used to determine the screen tip data for y-axis labels are:

Number of Work Items 
Completed

AgentJob WkForwardedCnt

Number of Work Items Rejected AgentJob WkRejectedCnt

Number of Work Items 
Previewed

AgentJob WkPreviewCnt

Screen tip label text Database table Database item or calculation

Agent N/A From x-axis label

Job N/A From y-axis label

Date N/A From associated floor y-axis label

<name of statistic being 
displayed>

N/A Height of the column

Screen tip label text Database table Database item or calculation

Agent N/A From associated floor x-axis label

Job N/A From associated floor x-axis label

Login ID AgentJob AgentLogin

Dialer AgentJob
DialerInfo

DialerInfo.DialerName where DialerInfo.DialerID = 
AgentJob.DialerID and DialerInfo.JobID = 
AgentJob.JobID

Screen tip label text Database table Database item or calculation

Date N/A From associated floor y-axis label



Troubleshooting basic reports and the report server

206 Avaya Operational Analyst R6.1 Maintenance and Troubleshooting

The OA database items and calculations used to populate the left and right walls are:

The OA database items used to determine the content of the left wall screen tip are:

The OA database items used to determine the content of the right wall screen tip are:

Floor statistic Database item or calculation

● Total Work Duration
● Total Wrap-Up Duration
● Number of Work Items Completed
● Number of Work Items Rejected
● Number of Work Items Previewed

When the selected statistic for the wall is Total of Floor 
Data:
(b1+ b2+ b3+ �+ bn) where b = the value of a floor column 
for this service class/queue/agent/date, and where n = the 
number of columns on the floor for this service class/
queue/agent or date as appropriate
Note that the walls shall not display Total of Floor Data 
when Average type statistics are displayed on the floor.

● Average Work Duration
● Average Wrap-Up Duration
● Total Work Duration
● Total Wrap-Up Duration
● Average Preview Duration
● Number of Work Items Completed
● Number of Work Items Rejected
● Number of Work Items Previewed

When the selected statistic for the wall is Average of Floor 
Data:
[(c1+c2+c3+�+cn)/ (b1+ b2+ b3+ �+ bn)] where c = is the 
numerator used to calculate the height of the floor column 
and where b = the denominator used to calculate the height 
of the floor column and where n = the number of columns 
on the floor for this service class/queue/agent or date as 
appropriate

Screen tip label text Database table Database item or calculation

Agent N/A From associated floor x-axis label

Job N/A From associated floor x-axis label

<name of statistic being 
displayed>

N/A Value of respective bar

Screen tip label text Database table Database item or calculation

Date N/A From associated floor y-axis label

<name of statistic being 
displayed>

N/A Value of respective bar
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Agent Performance by Job - Real-time
The OA database items used to determine drop-down box items for the input screen are:

The OA database items used to determine the entities on the report floor are:

The OA database items used to determine the content of the floor column screen tips are:

Input parameter Database table Database Item

Agents Employee
GroupMember
Workgroup
Channel

Display Employee.FullName (Employee.LoginName) 
where Employee.Pkey = Channel.Employee_Key and 
GroupMember.EmployeeGroup = Employee.PKey and 
GroupMember.WorkgroupGroup = Workgroup.Pkey for 
one of the selected workgroups

Jobs JobSummary
DialerInfo

JobSummary.JobName (DialerInfo.DialerName) where 
JobSummary.DialerID = DialerInfo.DialerID

Statistic Database table Database item or calculation

Average Work Duration AgentJob WkWorkDur / (WkForwardedCnt + 
WkTransferredCnt)

Average Wrap-Up Duration AgentJob WkWrapupDur / (WkForwardedCnt + 
WkTransferredCnt)

Total Work Duration AgentJob WkWorkDur

Total Wrap-Up Duration AgentJob WkWrapupDur

Average Preview Duration AgentJob WkPreviewDur / WkPreviewCnt

Number of Work Items 
Completed

AgentJob WkForwardedCnt

Number of Work Items Rejected AgentJob WkRejectedCnt

Number of Work Items 
Previewed

AgentJob WkPreviewCnt

Screen tip label text Database table Database item or calculation

Agent N/A Associated agent name

Job N/A Associated job name

<name of statistic being 
displayed>

N/A Height of the column
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The OA database items used to determine the screen tip data for x-axis labels are:

The OA database items used to determine the screen tip data for y-axis labels are:

Screen tip label text Database table Database item or calculation

Agent N/A From associated floor x-axis label

Login ID AgentState AgentLogin

Current State AgentState AgentState

Current Job AgentState
JobSummary

If AgentState.Mode = 2 (outbound) then 
Display: JobSummary.JobName where 
AgentState.JobID = JobSummary.JobID and 
AgentState.DialerID = JobSummary.DialerID

Login Date/Time AgentState LoginTime

Number of Subscribed 
Jobs

AgentState JobsSubscribedCnt

Screen tip label text Database table Database item or calculation

Job N/A From associated floor y-axis label

Dialer JobSummary
DialerInfo

DialerInfo.DialerName where DialerInfo.DialerID = 
JobSummary.DialerID

Current State JobSummary JobStateName

Number of Agents 
Subscribed

JobSummary AgentsSubscribedCnt
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The OA database items and calculations used to populate the left and right walls are:

The OA database items used to determine the content of the left wall screen tip are:

The OA database items used to determine the content of the right wall screen tip are:

Floor statistic Database item or calculation

● Total Work Duration
● Total Wrap-Up Duration
● Number of Work Items Completed
● Number of Work Items Rejected
● Number of Work Items Previewed

When the selected statistic for the wall is Total of Floor 
Data:
(b1+ b2+ b3+ �+ bn) where b = the value of a floor column 
for this service class/queue/agent/date, and where n = the 
number of columns on the floor for this service class/
queue/agent or date as appropriate
Note that the walls shall not display Total of Floor Data 
when Average type statistics are displayed on the floor.

● Average Work Duration
● Average Wrap-Up Duration
● Total Work Duration
● Total Wrap-Up Duration
● Average Preview Duration
● Number of Work Items Completed
● Number of Work Items Rejected
● Number of Work Items Previewed

When the selected statistic for the wall is Average of Floor 
Data:
[(c1+c2+c3+�+cn)/ (b1+ b2+ b3+ �+ bn)] where c = is the 
numerator used to calculate the height of the floor column 
and where b = the denominator used to calculate the 
height of the floor column and where n = the number of 
columns on the floor for this service class/queue/agent or 
date as appropriate

Screen tip label text Database table Database item or calculation

Agent N/A From associated x-axis label

<name of statistic being 
displayed>

N/A Value of respective bar

Screen tip label text Database table Database item or calculation

Job N/A From associated floor y-axis label

<name of statistic being 
displayed>

N/A Value of respective bar
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Agent Performance by Service Class and Queue - Historical
The OA database items used to determine drop-down box values for the input screen are:

The OA database items used to determine the entities on the report floor are:

The OA database items used to determine the content of the screen tip on floor columns 
are:

Input parameter Database table Database item

Agents Employee
GroupMember
Workgroup
Channel

Display Employee.FullName 
(Employee.LoginName)
where
Employee.Pkey = Channel.Employee_Key and 
GroupMember.EmployeeGroup = Employee.PKey 
and GroupMember.WorkgroupGroup = 
Workgroup.Pkey for one of the selected 
workgroups

Service Classes SvcClassInfo SvcClassName

Queues SvcClassInfo SvcClassName (SvcClassID)

Statistic Database table Database item or calculation

Average Work Duration AgentSvcClass WkWorkDur / (WkForwardedCnt + 
WkTransferredCnt)

Average Wrap-Up Duration AgentSvcClass WkWrapUpDur / WkForwardedCnt + 
WkTransferredCnt)

Number of Work Items Opened AgentSvcClass WkOpenedCnt

Number of Work Items 
Completed

AgentSvcClass WkForwardedCnt + 
AgentSvcClass.WkTransferredCnt

Average Customer Hold 
Duration

AgentSvcClass CustomerHeldDur / CustomerHeldCnt

Average Deferred Duration AgentSvcClass WkHeldDur / WkHeldCnt

Screen tip label text Database table Database item or calculation

Agent N/A Associated agent name

Service Classes N/A Associated service class name
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The OA database items used to determine the screen tip data for x-axis labels are:

The OA database items used to determine the screen tip data for y-axis labels are:

Queues N/A Associated queue name

Date N/A The associated date/time category

For Service Class 
related rows in Report 
by Service Class or 
Queue type reports: 
Current Role

AgentCapSetInfo
StaticNameInfo

StaticNameInfo.DisplayNamewhere 
StaticNameInfo.IDType = �AgentRole� and 
StaticNameInfo.ID = AgentCapSetInfo.AgentRole for 
this agent login and this service class.

<name of statistic being 
displayed>

N/A Height of respective column

Screen tip label text Database table Database item or calculation

Screen tip label text Database table Database item or calculation

Agent AgentInfo AgentName
AgentLogin

Agent ID AgentInfo AgentName
AgentLogin

Service Class SvcClassInfo SvcClassInfo.SvcClassName where 
SvcClassInfo.SvcClassID = the ID of this service 
class

Queue SvcClassInfo SvcClassID

Queue ID SvcClassInfo SvcClassID

Screen tip label text Database table Database item or calculation

Date N/A From associated floor y-axis label
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The OA database items and calculations used to populate the left and right walls are:

The OA database items used to determine the content of the left wall screen tip are:

The OA database items used to determine the content of the right wall screen tip are:

Floor statistic Database item or calculation

● Number of Work Items Opened
● Number of Work Items Completed 

When the selected statistic for the wall is Total of Floor 
Data:
(b1+ b2+ b3+ �+ bn) where b = the value of a floor column 
for this service class/queue/agent/date, and where n = the 
number of columns on the floor for this service class/
queue/agent or date as appropriate
Note that the walls shall not display Total of Floor Data 
when Average type statistics are displayed on the floor.

● Average Work Duration 
● Average Wrap-Up Duration
● Number of Work Items Opened
● Number of Work Items Completed
● Average Customer Hold Duration
● Average Deferred Duration

When the selected statistic for the wall is Average of Floor 
Data:
[(c1+c2+c3+�+cn)/ (b1+ b2+ b3+ �+ bn)] where c = is the 
numerator used to calculate the height of the floor column 
and where b = the denominator used to calculate the 
height of the floor column and where n = the number of 
columns on the floor for this service class/queue/agent or 
date as appropriate

Screen tip label text Database table Database item or calculation

For Report by Agent 
"Display service 
class/queue labels"

N/A From associated floor x-axis label

For Report by Service 
Class/Queue Display 
Agent Label

N/A From associated floor x-axis label

<name of statistic being 
displayed>

N/A Value of respective bar

Screen tip label text Database table Database item or calculation

Date N/A From associated floor y-axis label

<name of statistic being 
displayed>

N/A Value of respective bar
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Agent Performance by Service Class and Queue - Real-time
The OA database items used to determine drop-down box values for the input screen are:

The OA database items used to determine the entities on the report floor are:

Input parameter Database table Database item

Agents Employee
GroupMember
Workgroup
Channel

Display Employee.FullName 
(Employee.LoginName)
where
Employee.Pkey = Channel.Employee_Key and 
GroupMember.EmployeeGroup = Employee.PKey 
and GroupMember.WorkgroupGroup = 
Workgroup.Pkey for one of the selected 
workgroups

Service Classes SvcClassInfo SvcClassName

Queues SvcClassInfo SvcClassName (QueueID)

Statistic Database table Database item or calculation

Average Work Duration AgentSvcClass WkWorkDur / (WkForwardedCnt + 
WkTransferredCnt)

Average Wrap-Up Duration AgentSvcClass WkWrapUpDur / (WkForwardedCnt / 
WkTransferredCnt)

Number of Work Items 
Opened

AgentSvcClass WkOpenedCnt

Number of Work Items 
Completed

AgentSvcClass WkForwardedCnt + 
AgentSvcClass.WkTransferredCnt

Average Customer Hold 
Duration

AgentSvcClass CustomerHeldDur / CustomerHeldCnt

Average Deferred Duration AgentSvcClass WkHeldDur / WkHeldCnt

For Service Classes:
<Column Color>

AgentCapSetInfo Map AgentRole for this AgentLogin and 
SvcClassID to the specified color for this role.
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The OA database items used to determine the content of the screen tip on floor columns 
are:

The OA database items used to determine the screen tip data for x-axis labels are:

The OA database items used to determine the screen tip data for y-axis labels are:

Screen tip label text Database table Database item or calculation

Agent N/A From associated floor x-axis label

Service Classes N/A From associated floor y-axis label

Queues N/A From associated floor y-axis label

Agent Role StaticNameInfo
AgentCapSetInfo

StaticNameInfo.DisplayName where 
StaticNameInfo.IDType = "AgentRole" and 
StaticNameInfo.ID = AgentCapSetInfo.AgentRole 
and AgentCapSetInfo.AgentLogin = the login ID of 
this agent and AgentCapSetInfo.SvcClassID = the 
service class ID of this service class

<name of statistic being 
displayed>

N/A Height of respective column

Screen tip label text Database table Database item or calculation

Agent AgentState AgentName

Login ID AgentState AgentLogin

Screen tip label text Database table Database item or calculation

Service Classes SvcClassInfo SvcClassName

Queue SvcClassInfo SvcClassName
SvcClassID

Queue ID SvcClassInfo SvcClassName
SvcClassID
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The OA database items and calculations used to populate the left and right walls are:

Agent Performance by Skill - Historical
The OA database items used to determine drop-down box values for the input screen are:

The OA database items and calculations used to populate the report floor are:

Floor Statistic Data Base Item or Calculation

● Number of Work Items Opened
● Number of Work Items 

Completed 

When the selected statistic for the wall is Total of Floor Data:
(b1+ b2+ b3+ �+ bn) where b = the value a floor column for 
this service class or queue, and where n = the number of 
columns on the floor for this service class/queue or agent as 
appropriate.
Note that the walls shall not display Total of Floor Data when 
Average type statistics are displayed on the floor.

● Average Work Duration
● Average Wrap-Up Duration
● Number of Work Items Opened
● Number of Work Items 

Completed
● Average Customer Hold 

Duration
● Average Deferred Duration

When the selected statistic for the wall is Average of Floor 
Data:
[(c1+c2+c3+�+cn)/ (b1+ b2+ b3+ �+ bn)] where c = is the 
numerator used to calculate the height of the floor column 
and where b = the denominator used to calculate the height 
of the floor column and where n = the number of columns on 
the floor for this service class/queue or agent as appropriate.

Input parameter Database table Database item

Agents CmsAgentInfo LogName (<Data Source Name>)

Skills CmsSkillInfo SplitName (<Data Source Name>)

Statistic Database table Database item or calculation

Number of ACD Calls CmsAgent acdcalls + da_acdcalls

Average ACD Duration CmsAgent (acdtime + da_acdtime) / (acdcalls + 
da_acdcalls)

Average ACW Duration CmsAgent (acwtime + da_acwtime) / (acdcalls + 
da_acdcalls)
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The OA database items used to determine the content of the floor column screen tips are:

The OA database items used to determine the screen tip data for x-axis labels are:

or

The OA database items used to determine the screen tip data for y-axis labels are:

Screen tip label text Database table Database item or calculation

Agent N/A Associated agent name

Skill N/A Associated skill name

Date N/A The associated date/time category

<name of statistic being 
displayed>

N/A Height of the column

Screen tip label text Database table Database item or calculation

Agent N/A From associated floor x-axis label

Login ID CMSAgentInfo LogID

Data Source N/A The data source from the input page selection

Screen tip label text Database table Database item or calculation

Skill N/A From associated floor x-axis label

Data Source N/A The data source from the input page selection

Screen tip label text Database table Database item or calculation

Date N/A From associated floor y-axis label
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The OA database items and calculations used to populate the left and right walls are:

The OA database items used to determine the content of the left wall screen tip are:

The OA database items used to determine the content of the right wall screen tip are:

Floor statistic Database item or calculation

Number of ACD Calls When the selected statistic for the wall is Total of Floor Data:
(b1+ b2+ b3+ �+ bn) where b = the value a floor column for this 
Skill, and where n = the number of columns on the floor for this 
Skill/agent or date as appropriate.

● Number of ACD Calls
● Average ACD Duration
● Average ACW Duration

When the selected statistic for the wall is Average of Floor 
Data:
[(c1+c2+c3+�+cn)/ (b1+ b2+ b3+ �+ bn)] where c = is the 
numerator used to calculate the height of the floor column and 
where b = the denominator used to calculate the height of the 
floor column and where n = the number of columns on the floor 
for this Skill/Agent or date as appropriate.

Screen tip label text Database table Database item or calculation

For Report by Agent 
"Skill"

N/A From associated floor x-axis label

For Report by Skill 
"Agent"

N/A From associated floor x-axis label

<name of statistic being 
displayed>

N/A Value of respective bar

Screen tip label text Database table Database item or calculation

Date N/A From associated floor y-axis label

<name of statistic being 
displayed>

N/A Value of respective bar
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Agent Time in State - Real-time
The OA database items used to determine the content of drop-down boxes are:

The OA database items and calculations used to populate the Agent Time in State table 
are:

Drop-down box Database table Database item or calculation

Agents Employee
GroupMember
Workgroup
Channel

Display Employee.FullName (Employee.LoginName)
where
Employee.Pkey = Channel.Employee_Key, 
GroupMember.EmployeeGroup = Employee.PKey, 
GroupMember.WorkgroupGroup = Workgroup.Pkey for 
one of the selected workgroups

Agent States N/A Include the following entries:
1. Busy This Service Class, Queue, or Job
2. Busy Other Service Class, Queue or Job
3. Idle
4. AuxWork

Service Classes SvcClassInfo SvcClassName

Queues SvcClassInfo SvcClassName (SvcClassID)

Jobs JobSummary
DialerInfo

JobSummary.JobName (DialerInfo.DialerName) where 
JobSummary.DialerID = DialerInfo.DialerID

Visual representation Database table Database value or calculation

Number of Agents 
Found

The number of records that comprise the table

Agent AgentState AgentName

State (displayed only if 
multiple states are 
selected or if either of the 
"Busy" states is selected)

AgentState AgentStateName

Availability AgentState AvailabilityName

Time in State AgentState Now - StateStartTime
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Job Performance - Historical
The OA database items used to determine drop-down box items for the input screen are:

The OA database items used to determine the entities on the report floor are:

Service Class, Queue, 
Job (displayed only if 
multiple service classes 
and/or queues are 
selected or if the state 
Busy Other Service 
Class or Queue has 
been selected)

AgentState
SvcClassInfo

If AgentState.Mode = 1 (inbound) then
Display SvcClassInfo.SvcClassName where 
AgentState.SvcClassID = SvcClassInfo.SvcClassID
If AgentState.Mode = 2 (outbound) then
Display JobSummary.JobName where 
AgentState.JobID = JobSummary.JobID
If AgentState.Mode = 3 (aux) or 0 (unknown) then 
Display <blank>

Time in Focus AgentState If AgentState.AgentState is working or wrap-up 
Display: Now - AgentState.FocusChangeTime 
otherwise

Role (displayed only if a 
single service class is 
selected. Not displayed if 
multiple service classes 
and/or queues are 
selected nor if a single 
queue is selected)

AgentState
AgentCapSetInfo
StaticNameInfo

Display StaticNameInfo.DisplayName 
where StaticNameInfo.IDType = "AgentRole" and 
where StaticNameInfo.ID = 
AgentCapSetInfo.AgentRole 
(where AgentState.AgentLogin = 
AgentCapSetInfo.AgentLogin and <the ID of the 
selected service class> = 
AgentCapSetInfo.SvcClassID)
If there is no record in AgentCapSetInfo for this 
combination of AgentLogin and SvcClassID, display 
Blank 
Exception: the Not Administered and Unknown roles 
always appear in the table as long as the other input 
parameters are met.

Visual representation Database table Database value or calculation

Input parameter Database table Database Item

Jobs JobSummary
DialerInfo

JobSummary.JobName (DialerInfo.DialerName) 
where JobSummary.DialerID = DialerInfo.DialerID

Statistic Database table Database item or calculation

Hit Rate JobSummary [(WkPredictiveCnt / WkAttemptedCnt)] * 
100
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The OA database items used to determine the content of the data column screen tips are:

The OA database items used to determine the screen tip data for x-axis labels are:

The OA database items used to determine the screen tip data for y-axis labels are:

Number of Work Items 
Completed

JobSummary WkForwardedCnt

Nuisance Call Rate JobSummary [NuisanceCnt / (NuisanceCnt + 
WkPredictiveCnt)] * 100

Number of Telephone Numbers 
Unreachable

JobSummary WkUnreachableCnt

Maximum Number of Agents 
Subscribed

JobSummary MaxSubscribedCnt

Number of Telephone Numbers 
Loaded

JobSummary WkLoadedCnt

Screen tip label text Database table Database item or calculation

Job N/A From associated x-axis

Date N/A The date represented by the brushed column

<name of statistic being 
displayed>

N/A Value of respective column

Screen tip label text Database table Database item or calculation

Job JobInfo
JobSummary

JobName where JobInfo.JobID = 
JobSummary.JobID

Dialer JobInfo
DialerInfo
JobSummary

DialerInfo.DialerName where DialerInfo.DialerID = 
JobSummary.DialerID

Screen tip label text Database table Database item or calculation

Date N/A From associated floor y-axis label
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The OA database items and calculations used to populate the left and right walls are:

The OA database items used to determine the content of the left wall screen tip are:

The OA database items used to determine the content of the right wall screen tip are:

Floor statistic Database item or calculation

● Number of Work Items Completed
● Number of Nuisance Calls
● Number of Telephone Numbers 

Unreachable
● Number of Telephone Numbers 

Loaded

When the selected statistic for the wall is Total of Floor 
Data:
(b1+ b2+ b3+ �+ bn) where b = the value of a floor column 
for this service class/queue/agent/date, and where n = the 
number of columns on the floor for this service class/
queue/agent or date as appropriate
Note that the walls shall not display Total of Floor Data 
when Average type statistics are displayed on the floor.

● Hit Rate
● Number of Work Items Completed
● Nuisance Call Rate
● Number of Nuisance Calls
● Number of Telephone Numbers 

Unreachable
● Maximum Number of Agents 

Subscribed
● Number of Telephone Numbers 

Loaded

When the selected statistic for the wall is Average of Floor 
Data:
[(c1+c2+c3+�+cn)/ (b1+ b2+ b3+ �+ bn)] where c = is the 
numerator used to calculate the height of the floor column 
and where b = the denominator used to calculate the 
height of the floor column and where n = the number of 
columns on the floor for this service class/queue/agent or 
date as appropriate

Screen tip label text Database table Database item or calculation

Job N/A From associated x-axis label

<name of statistic being 
displayed>

N/A Value of respective bar

Screen tip label text Database table Database item or calculation

Date N/A From associated floor y-axis label

<name of statistic being 
displayed>

N/A Value of respective bar
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Job Performance - Real-time
The OA database items used to determine drop-down box items for the input screen are:

The OA database items and calculations used to populate the report floor are:

The OA database items used to determine the content of the screen tips are:

Input parameter Database table Database Item

Jobs JobSummary
DialerInfo
JobSummary

JobInfo.JobName (DialerInfo.DialerName) where 
JobSummary.JobID = JobInfo.JobID and where 
JobSummary.DialerID = DialerInfo.DialerID

Statistic 
selected

Database table Database item or calculation

Hit Rate JobSummary HitRate * 100

Average Work 
Duration

AgentJob (WkWorkDur1 + � + WkWorkDurn) / (WkForwardedCnt1 
+ � + WkForwardedCntn + WkTransferredCnt1 + � + 
WkTransferredCntn) for all �n� agents where JobID = the 
ID of this job

Average 
Wrap-Up 
Duration

AgentJob (WkWrapupDur1 + � + WkWrapupDurn) / 
(WkForwardedCnt1 + � + WkForwardedCntn+ 
WkTransferredCnt1 + � + WkTransferredCntn) for all �n� 
agents where JobID = the ID of this job

Nuisance Call 
Rate

JobSummary [NuisanceCnt / (NuisanceCnt + WkPredictiveCnt)] * 100

Screen tip label text Database table Database item or calculation

Job JobSummary JobName

Dialer JobSummary
DialerInfo

DialerInfo.DialerName where JobSummary.DialerID 
= DialerInfo.DialerID

Current State JobSummary JobStateName

In Calendar JobSummary If InCalendarInd = �1�
�Yes�

else
�No�
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Service Class and Queue Performance - Historical
The OA database items used to determine drop-down box items for the input screen are:

Number of Agents 
Subscribed

JobSummary AgentsSubscribedCnt

Telephone Numbers 
Loaded

JobSummary WkLoadedCnt

Telephone Numbers 
Unscheduled

JobSummary WkUnscheduledCnt

Telephone Numbers 
Processed

JobSummary WkProcessedCnt

Telephone Numbers 
Rescheduled

JobSummary WkScheduledCnt

Telephone Numbers 
Unreachable

JobSummary WkWunreadableCnt

<name of statistic being 
displayed>

N/A Value of respective column

Screen tip label text Database table Database item or calculation

Input parameter Database table Database Item

Service Classes SvcClassInfo SvcClassName

Queues SvcClassInfo SvcClassName (SvcClassID)
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The OA database items and calculations used to populate the report floor are:

The OA database items used to determine the content of the data column screen tips are:

Statistic 
selected

Database table Database item or calculation

Percentage of 
Work Items 
Handled Within 
Service Level

SvcClassSummary If UpperThreshold != Null
(WkOpenOnTargetCnt) / (WkOpenOnTargetCnt + 
WkOpenBehindCnt + WkOpenCriticalCnt + 
WkOpenAheadCnt + WkOpenNoGoalCnt) * 100%

else
blank

Number of Work 
Items Offered

SvcClassSummary WkArrivedCnt

Number of Work 
Items 
Completed

SvcClassSummary WkForwardedCnt + AgentSvcClass.WkTransferredCnt

Number of 
Abandoned 
Work Items

SvcClassSummary AbandBehindCnt + AbandOnTargetCnt+ AbandNoGoalCnt 
+ AbandAheadCnt + AbandCriticalCnt

Average Wait 
Time

SvcClassSummary WkInQueueDur / (WkOpenBehindCnt + 
WkOpenOnTargetCnt + WkOpenNoGoalCnt + 
WkOpenCriticalCnt + WkOpenAheadCnt)

Average Time to 
Abandon

SvcClassSummary AbandDur / (AbandBehindCnt + AbandOnTargetCnt + 
AbandNoGoalCnt + AbandAheadCnt + AbandCriticalCnt)

Screen tip label text Database table Database item or calculation

For Service Classes: 
Service Class

N/A The label of the associated Service Class or Queue

For Queues: Queue N/A The label of the associated Service Class or Queue

Date N/A The Date represented by the brushed column

<name of statistic being 
displayed>

N/A Value of respective column
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The OA database items used to determine the screen tip data for x-axis labels are:

The OA database items used to determine the screen tip data for y-axis labels are:

The OA database items and calculations used to populate the left and right walls are:

The OA database items used to determine the content of the left wall screen tip are:

Screen tip label text Database table Database item or calculation

For Service Classes: 
Service Class

N/A From associated floor x-axis label

For Queues: Queue N/A From associated floor x-axis label

For Queues: QueueID SvcClassInfo SvcClassID

Screen tip label text Database table Database item or calculation

Date N/A From associated floor y-axis label

Floor statistic Database item or calculation

● Number of Work Items Offered
● Number of Work Items Completed
● Number of Abandoned Work Items

When the selected statistic for the wall is Total of Floor 
Data:
(b1+ b2+ b3+ �+ bn) where b = the value a floor column 
for this service class or queue, and where n = the 
number of columns on the floor for this service class/
queue or date as appropriate.

● Percentage of Work Items Handled 
Within Service Level

● Number of Work Items Offered
● Number of Work Items Completed
● Number of Abandoned Work Items
● Average Wait Time
● Average Time to Abandon

When the selected statistic for the wall is Average of 
Floor Data:
[(c1+c2+c3+�+cn)/ (b1+ b2+ b3+ �+ bn)] where c = the 
numerator used to calculate the height of the floor 
column and where b = the denominator used to 
calculate the height of the floor column and where n = 
the number of columns on the floor for this service 
class/queue or date as appropriate.

Screen tip label text Database table Database item or calculation

For Service Classes: 
Service Class

N/A From associated floor x-axis label

For Queues: Queue N/A From associated floor x-axis label

<name of statistic being 
displayed>

N/A Value of respective bar
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The OA database items used to determine the content of the right wall screen tip are:

Service Class and Queue Performance - Real-time
The OA database items used to determine drop-down box items for the input screen are:

The OA database items and calculations used to populate the report floor are:

Screen tip label text Database table Database item or calculation

Date N/A From associated floor y-axis label

<name of statistic being 
displayed>

N/A Value of respective bar

Input parameter Database table Database item

Service Classes SvcClassInfo SvcClassName

Queues SvcClassInfo SvcClassName (SvcClassID)

Statistic Database table Database item or calculation

Percentage of Work 
Items Handled 
Within Service Level

SvcClassSummary If SvcGoalID != "1"
(WkOpenOnTargetCnt) / (WkOpenCriticalCnt + 
WkOpenOnTargetCnt + WkOpenBehindCnt + 
WkOpenAheadCnt + WkOpenNoGoalCnt ) * 
100%

else
blank

Number of Work 
Items in Queue

SvcClassState QueueSizeCnt

Number of Work 
Items Offered

SvcClassSummary WkArrivedCnt

Number of Work 
Items Completed

SvcClassSummary WkForwardedCnt + 
AgentSvcClass.WkTransferredCnt

Number of 
Abandoned Work 
Items

SvcClassSummary AbandBehindCnt + AbandOnTargetCnt + 
AbandNoGoalCnt + AbandAheadCnt + 
AbandCriticalCnt
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Latest Average Wait 
Time

SvcClassSummary Given that:
X = WkOpenCriticalCnt + WkOpenAheadCnt + 
WkOpenBehindCnt + WkOpenOnTargetCnt + 
WkOpenNoGoalCnt

And "n" represents the current database values 
and "n-1" represents the database values at 
the time of the previous report update,

Then:
When "n" is the first update of the report (that is, 
where there is no "n-1") or where "n" is the first 
update of the report for the current interval then:

If X(n) > 0 Then Average Wait Time = 
WkInQueueDur(n)/ X(n)

If X(n) = 0 Then display no column at all

And when "n" is not the first update of the report 
(that is, where there is an "n-1") then

If X(n) - X(n-1) > 0 Then Average Wait Time = 
[WkInQueueDur(n) - WkInQueueDur(n-1)] / 
[X(n) - X(n-1)]

If X(n) - X(n-1) = 0 then display no column at all

Average Time to 
Abandon

SvcClassSummary AbandDur / (AbandBehindCnt + AbandOnTargetCnt 
+ AbandNoGoalCnt + AbandAheadCnt + 
AbandCriticalCnt)

Percentage of 
Matched Work Items

SvcClassSummary
AgentSvcClass
AgentCapSetInfo

For Service Classes:
Display [(AgentSvcClass.WkForwardedCnt1 + 
AgentSvcClass.WkForwardedCnt2 + �+ 
AgentSvcClass.WkForwardedCntn + 
WkTransferredCnt) / 
SvcClassSummary.WkForwardedCnt] * 100

where n = number of agents who's role is 
regular relative to this service class as 
determined by obtaining the list of AgentIDs 
from AgentCapSetInfo where SvcClassID = the 
service class ID of this service class and 
AgentRole = 0 (regular)

For Queues:
Display <blank>

Statistic Database table Database item or calculation
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The OA database items used to determine the content of the screen tip are:

Service Class and Queue Status - Real-time
The OA database items used to determine drop-down box items for the input screen are:

The OA database items used to determine the content of the label screen tips are:

Screen tip label 
text

Database table Database item or calculation

For Service 
Classes: Service 
Class
For Queues: 
Queue

SvcClassInfo SvcClassName

For Queues: 
QueueID

SvcClassState SvcClassID

For Service 
Classes: Service 
Class State

SvcClassState SvcClassStateName

For Service 
Classes and 
Queues: Channel 
Type

SvcClassState
SvcClassQualInfo
ChannelInfo

ChannelInfo.ChannelName
where:
SvcClassState.SvcClassID = SvcClassInfo.SvcClassID 
and SvcClassInfo.ChannelID = ChannelInfo.ChannelID

name of statistic 
being displayed

N/A Value of respective column.

Input parameter Database table Database item

Service Classes SvcClassInfo SvcClassName (<Data Source Name>)

Queues SvcClassInfo SvcClassName (SvcClassID)

Screen tip label text Database table Database item or calculation

For Service Classes: 
Service Class

SvcClassInfo SvcClassName

For Queues: Queue SvcClassInfo SvcClassName

For Queues: QueueID SvcClassState SvcClassStateName
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For Service Classes: 
Current State

SvcClassState SvcClassStateName

For Service Classes Criti-
cal Threshold

SvcClassGoalInfo if CriticalThreshold != NULL then CriticalThreshold
else
"None"

For both Service 
Classes and Queues: 
Upper Threshold

SvcClassGoalInfo if UpperThreshold != NULL then UpperThreshold
else
"None"

For Service Classes: 
Lower Threshold

SvcClassGoalInfo if LowerThreshold != NULL then LowerThreshold
else
"None"

Screen tip label text Database table Database item or calculation
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The OA database items and calculations used to populate the floor are:

Statistic Database table Database item or calculation

Number of Work 
Items in Queue

SvcClassState QueueSizeCnt

Service Class State SvcClassState
SvcClassInfo

For Advocate-delivered service classes (that is, 
SvcClassInfo.QueueType = Advocate and 
SvcClassState.EWT != NULL):
SvcClassState.SvcClassState, where
● Unknown = a gap in the ribbon or histogram
● Agents Available = -3
● Queue Empty = -2
● Ahead of Target = -1
● On Target = 0
● Future Risk = 1
● Immediate Risk = 2
● Behind Target = 3
● Critical = 4
Note: all numbers are relative to the floor, which is 
at 0.
A ribbon�s or histogram�s color corresponds to the 
current Service Class state. States are organized 
into categories and each category is distinguished 
by its color: 
● Red = Critical, 
● Yellow = Behind Target,
● Green = On Target, Future risk, Immediate Risk
● Blue = Ahead of Target, Agents Available, and 

Queue empty.
For Non-Advocate-delivered service classes and 
Queues (that is, EWT = NULL):
● display nothing
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Oldest Wait Time SvcClassState If OldestArrivalTime != Null then
Now - OldestArrivalTime

else
blank

Latest Average Wait 
Time

SvcClassSummary Given that:
X = WkOpenCriticalCnt + WkOpenBehindCnt 
+ WkOpenOnTargetCnt + WkOpenAheadCnt 
+ WkOpenNoGoalCnt

And "n" represents the current database 
values and "n-1" represents the database 
values at the time of the previous report 
update,

Then:
When "n" is the first update of the report (that is, 
where there is no "n-1") or where "n" is the first 
update of the report for the current interval then

If X(n) > 0 Then Average Wait Time = 
WkInQueueDur(n)/ X(n)

If X(n) = 0 Then display a "gap" in the ribbon 
or histogram

And when "n" is not the first update of the report 
(that is, where there is an "n-1") then

If X(n) - X(n-1) > 0 Then Average Wait Time 
= [WkInQueueDur(n) - WkInQueueDur(n-1)] / 
[X(n) - X(n-1)]

If X(n) - X(n-1) = 0 then display a "gap" in the 
ribbon or histogram

Statistic Database table Database item or calculation
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The OA database items and calculations used to populate the left wall are:

The OA database items used to determine the content of the left wall bar screen tips are:

Statistic Database table Database value or calculation

Number of Work Items 
in Queue

SvcClassState QueueSizeCnt

Expected Wait Time SvcClassState For Service Classes:
If EWT != NULL and EWTUsed = 1 then

EWT

else

blank

For Queues:
blank

Oldest Wait Time SvcClassState For Queues:
Now - OldestArrivalTime

For Service Classes:
blank

30-Minute Average 
Wait Time

N/A [Latest AWT(1) + Latest AWT(2) + � Latest 
AWT(N)] / N
N = The total number of Latest AWT values 
generated over the 30 minute period.

Screen tip label text Database table Database item or calculation

For Service Classes: 
Service Class

N/A From associated floor label

For Queues: Queue N/A From associated floor label

<name of statistic being 
displayed>

N/A Value of respective bar
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The OA database items and calculations used to populate the right wall are:

The OA database items used to determine the content of the right wall bar screen tips are:

Visual 
representation

Database Table.Column Database value or 
calculation

Pie slice size Where AgentCapSetInfo.SvcClassID = the ID of the 
selected service class
<Role> Pie:
and where AgentCapSetInfo.AgentRole = <Role> 
according to the following:
● 0 = Regular
● 1 = Reserve
● 2 = Backup
<State> slice:
and where: 
AgentState.AgentState = <state> according to the 
following:
● Idle = 3
● AuxWork = 5
● Busy this Service Class = 1 & 2 & 7 and 

AgentState.SvcClassID = the ID of the selected service 
class

● Busy other Service Class, Queue, Job = 1 & 2 & 7 and 
AgentState.SvcClassID != the ID of the selected service 
class

Count the number 
of matching 
records

Total that appears 
beneath pie label 
in parenthesis "()".

N/A The sum of the pie 
slice sizes for a 
pie.

Screen tip label text Database table Database item or calculation

Service Class N/A Name of the selected Service Class

Agent State N/A Name of the state associated with this pie slice

Number of Agents in this 
State and Role

N/A Value of this pie slice
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Service Class and Queue Volume - Historical
The OA database items used to determine drop-down box items for the input screen are:

The OA database items used to populate the floor are:

The OA database items used to determine the screen tip data for x-axis labels are:

The OA database items used to determine the screen tip data for y-axis labels are:

The OA database items used to determine the content of the screen tip on floor columns 
are:

Input parameters Database table Database item

Service Classes SvcClassInfo SvcClassName

Queues SvcClassInfo SvcClassName (SvcClassID)

Statistic Database table Database item or calculation

Work Offered SvcClassSummary WkArrivedCnt

Work Completed SvcClassSummary WkForwardedCnt + 
AgentSvcClass.WkTransferredCnt

Screen tip label text Database table Database item or calculation

Service Class N/A From associate floor x-axis label

Queue N/A From associated floor x-axis label

Queue ID SvcClassInfo SvcClassID

Screen tip label text Database table Database item or calculation

Date N/A From associated floor y-axis label

Screen tip label text Database table Database item or calculation

Service Class N/A The name of the associated service class

Queues N/A The name of the associated queue

Date N/A The associated y-axis label
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The OA database items and calculations used to populate the left wall are:

The OA database items used to determine the content of the left wall screen tip are:

The OA database items used to determine the content of the right wall screen tip are:

Work Offered N/A Value of the New Arrivals column

Work Completed N/A WkForwardedCnt + 
AgentSvcClass.WkTransferredCnt

Screen tip label text Database table Database item or calculation

Statistic Database table Database value or calculation

Average Wait 
Time

SvcClassSummary For each selected Service Class or Queue
[(a1 + a2 + � an)] / [(b1 + b2 + � bn)]

where 

a = WkInQueueDur 

b = Sum [WkOpenBehindCnt + WkOpenNoGoalCnt + 
WkOpenOnTargetCnt + WkOpenCriticalCnt + 
WkOpenAheadCnt]

and n = the number of "y" time categories.

Screen tip label text Database table Database item or calculation

For Service Classes: 
Service Class

N/A The Service Class name of the associated floor, 
x-axis label

For Queues: Queue N/A The Queue name of the associated floor, x-axis label

Average Wait Time N/A Value of the bar

Screen tip label text Database table Database item or calculation

Date N/A From associated floor label

Average Wait Time N/A Value of respective bar
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The OA database items used to determine the entities on the right wall are:

Skill Performance - Historical
The OA database items used to determine drop-down box items for the input screen are:

The OA database items and calculations used to populate the report floor are:

Statistic Database table Database value or calculation

Average Wait 
Time

SvcClassSummary For each selected Service Class or Queue
[(a1 + a2 + � an)] / [(b1 + b2 + � bn)]

where 

a = WkInQueueDur 

b = Sum [WkOpenBehindCnt + WkOpenNoGoalCnt + 
WkOpenOnTargetCnt + WkOpenCriticalCnt + 
WkOpenAheadCnt]

where n = the number of service classes and queues on 
the x-axis.

Input Parameter Database Table Database Item

Skills CmsSkillInfo SplitName (<Data Source Name>)

Statistic Database table Database item or calculation

Number of ACD Calls CmsSkill acdcalls

Average Speed of Answer CmsSkill anstime / acdcalls

Number of Abandoned Calls CmsSkill abncalls

Average Time to Abandon CmsSkill abntime / abncalls
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The OA database items used to determine the content of the data column screen tips are:

The OA database items used to determine the screen tip data for x-axis labels are:

The OA database items used to determine the screen tip data for y-axis labels are:

The OA database items and calculations used to populate the left and right walls are:

Screen tip label text Database table Database item or calculation

Skill N/A From associated floor x-axis label

Date N/A From associated floor y-axis label

<name of statistic being 
displayed>

N/A Value of floor column

Screen tip label text Database table Database item or calculation

Skill N/A From associated floor x-axis label

Data Source N/A The data source from the input page selection

Screen tip label text Database table Database item or calculation

Date N/A From associated floor y-axis label

Floor Statistic Database Item or Calculation

● Number of ACD Calls
● Number of Abandoned Calls

When the selected statistic for the wall is Total of Floor Data:
(b1+ b2+ b3+ �+ bn) where b = the value of a floor column for 
this Skill, and where n = the number of columns on the floor for 
this Skill or date, as appropriate.

● Number of ACD Calls
● Average Speed of Answer
● Number of Abandoned Calls
● Average Time to Abandon

When the selected statistic for the wall is Average of Floor 
Data:
[(c1+c2+c3+�+cn)/ (b1+ b2+ b3+ �+ bn)] where c = is the 
numerator used to calculate the height of the floor column, and 
where b = the denominator used to calculate the height of the 
floor column, and where n = the number of columns on the floor 
for this Skill or date as appropriate.
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The OA database items used to determine the content of the left wall screen tip are:

The OA database items used to determine the content of the right wall screen tip are:

System Set Completion Codes - Historical
The OA database items used to determine the content of the drop-down lists are:

The OA database items and calculations used to populate the table are:

Screen tip label text Database table Database item or calculation

Skill N/A From associated floor x-axis label

<name of statistic being 
displayed>

N/A Value of respective bar.

Screen tip label text Database table Database item or calculation

Date N/A From associated floor y-axis label

<name of statistic being 
displayed>

N/A Value of respective bar.

Input screen Database table Database item

Jobs JobInfo
DialerInfo
SysCompCode

JobInfo.JobName (DialerInfo.DialerName) where 
SysCompCode.JobID = JobInfo.JobID and where 
SysCompCode.DialerID = DialerInfo.DialerID

Completion 
Codes to Include

StaticNameInfo DisplayName where IDType = SysCompCode

Visual Representation Database table Database value or calculation

<completion code count> SysCompCode SysCompCodeCnt summed over the report interval 
where JobID = the ID of this job and 
SysCompCodeID = the ID of this completion code

Total N/A The sum of the values in the respective column

<job name (dialer name)> JobInfo
DialerInfo
SysCompCode

JobInfo.JobName (DialerInfo.DialerName) where 
SysCompCode.JobID = JobInfo.JobID and where 
SysCompCode.DialerID = DialerInfo.DialerID
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System Set Completion Codes - Real-time
The OA database items used to determine the content of the drop-down lists are:

The OA database items and calculations used to populate the table are:

<completion code x 
name>

StaticNameInfo DisplayName where IDType = SysCompCode and 
ID = an ID of one of the selected completion codes

<all other outcome codes 
for agent x and job y>

SysCompCode Sum of all SysCompCodeCnt summed over the 
report interval where JobID = the ID of this job and 
SysCompCodeID = the ID of an unselected 
completion code

Input screen Database table Database item

Jobs JobSummary
DialerInfo

JobSummary.JobName (DialerInfo.DialerName) where 
JobSummery.DailerID = DialerInfo.DialerID

Completion 
Codes to Include

StaticNameInfo DisplayName where IDType = SysCompCode

Visual Representation Database table Database value or calculation

<completion code count> SysCompCode SysCompCodeCnt where JobID = the ID of this job 
and SysCompCodeID = the ID of this completion 
code

Total N/A The sum of the values in the respective column

<job name (dialer name)> JobSummary
DialerInfo

JobSummary.JobName (DialerInfo.DialerName) 
where JobSummary.DialerID = DialerInfo.DialerID

<completion code x 
name>

StaticNameInfo DisplayName where IDType = SysCompCode and 
ID = an ID of one of the selected completion codes

<all other outcome codes 
for agent x and job y>

SysCompCode sum of all SysCompCodeCnt where JobID = the ID 
of this job and SysCompCodeID = the ID of an 
unselected completion code
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Telephone Number States - Real-time
The OA database items used to determine the content of the drop-down lists are:

The OA database items and calculations used to populate the table are:

Input screen Database table Database item

Jobs JobSummary
DialerInfo

JobSummary.JobName (DialerInfo.DialerName) where 
JobSummery.DialerID = DialerInfo.DialerID

Telephone 
Number States 
to Include

StaticNameInfo DisplayName where IDType = PhoneNumState

Visual Representation Database table Database value or calculation

<telephone number state 
count>

PhoneNumState PhoneNumStateCnt where JobID = the ID of this 
job and PhoneNumStateID = the ID of this call state

Total N/A The sum of the values in the respective column

<job name (dialer name)> JobSummary
DialerInfo

JobSummary.JobName (DialerInfo.DialerName) 
where JobSummary.DialerID = DialerInfo.DialerID

<telephone number state x 
name>

StaticNameInfo DisplayName where IDType = PhoneNumState and 
ID = an ID of one of the selected call states

<all other telephone 
number states for job y>

PhoneNumState Sum of all PhoneNumStateCnt where JobID = the 
ID of this job and PhoneNumStateID = the ID of an 
unselected call state
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Detail reports
The following section describes related detail reports.

This section includes the following topics:

● Work Item Detail on page 241

● Segment Information Detail on page 245

● Wrap-up Codes Detail on page 250

● CMS Call Detail on page 254

● Segment Information for CMS Call Detail on page 256

● Call Work Codes Detail on page 258

Work Item Detail

The data used to populate the Channels and Agents drop-down boxes on the input page 
are determined as follows:

Input 
Element

Database Table Database Item or Calculation

Channels N/A The following items:
● Voice
● Email
● Text Chat

Agents Employee
GroupMember
WorkGroup
Channel

Display Employee.FullName (Employee.LoginName) where 
Employee.Pkey = Channel.Employee_Key and 
GroupMember.EmployeeGroup = Employee.PKey and 
GroupMember.WorkgroupGroup = Workgroup.Pkey for one of 
the selected workgroups
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The OA database items used to determine the records that comprise the Work Item Detail 
report and the content of the report columns are:

:

Report Column Database table Calculation

This record is included if 
the criteria in the 
calculation column are 
met. The value displayed 
in the Date column is the 
value contained in the 
associated Contact field.

Contact If Contact.CreateTime is within the date range 
selected in the Date Range portion of the input 
page
Then display
Contact.CreateTime

If the From text box is 
populated then this record 
is included if the criteria in 
the calculation column are 
met

Contact
MediaInteraction

If Selected Channels includes Voice then
MediaInteraction.Type = 2 (that is, voice), 
and MediaInteraction.ANI contains value in 
From box, and Contact.VDUID = 
MediaInteraction.Contact_Key

If Selected Channels includes Email then
MediaInteraction.Type = 0 (that is, email), 
and MediaInteraction.Sender contains 
value in From box, and Contact.VDUID = 
MediaInteraction.Contact_Key

If Selected Channels includes Text Chat then
MediaInteraction.Type = 1 (that is, chat), 
and MediaInteraction.UserName contains 
value in From box, and Contact.VDUID = 
MediaInteraction.Contact_Key

If the user selects more than one channel then 
these criteria are "OR'd" together.



Report calculations

Issue 1.0 August 2003 243

If the To input box is 
populated then this record 
is included if the criteria in 
the calculation column are 
met.

Contact
MediaInteraction

If Selected Channels includes Voice then
MediaInteraction.Type = 2 (that is, voice), 
and MediaInteraction.DNIS contains value 
in To box, and Contact.VDUID = 
MediaInteraction.Contact_Key

If Selected Channels includes Email then
MediaInteraction.Type = 0 (that is, email), 
and MediaInteraction.Recipient contains 
value in To box, and Contact.VDUID = 
MediaInteraction.Contact_Key

If the user selects more than one channel then 
these criteria are "OR'd" together.

If one or more values in 
the Channel drop-down 
box are selected then this 
record is included if the 
criteria in the calculation 
column are met.

Contact
MediaInteraction

If Selected Channels includes Voice then
MediaInteraction.Type = 2 (that is, voice), 
and Contact.VDUID = 
MediaInteraction.Contact_Key

If Selected Channels includes Email then
MediaInteraction.Type = 0 (that is, email), 
and Contact.VDUID = 
MediaInteraction.Contact_Key

If Selected Channels includes Text Chat then
MediaInteraction.Type = 1 (that is, chat), 
and Contact.VDUID = 
MediaInteraction.Contact_Key

If the user selects more than one channel then 
these criteria are "OR'd" together.

If one or more values in 
the Agent drop-down box 
are selected then this 
record is included if the 
criteria in the calculation 
column are met.

Contact
RoutingEvent
AgentSegment

If AgentSegment.Employee_Key = the selected 
agent PKEY value and Contact.VDUID = 
RoutingEvent.Contact_Key and 
AgentSegment.Segment_Key = 
RoutingEvent.UUID and 
AgentSegment.ParticipationRole = 0 (that is, 
Primary Agent)

Report Column Database table Calculation
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If the value in the Time in 
System drop-down boxes 
is > 0 then this record is 
included if the criteria in 
the calculation column are 
met. The value displayed 
in the Time in System 
column is the value 
contained in the 
associated Contact field.

Contact If Contact.Duration meets the input criterion 
include this record and display Contact.Duration

If the value in the Number 
of Times Handled 
pull-down box is > 0 then 
this record is included if 
the criteria in the 
calculation column are 
met. The value displayed 
in the Number of Times 
Handled column is the 
value contained in the 
associated Contact field.

Contact If Contact.Interactions meets the input criterion 
include this record and display 
Contact.Interactions

If the value in the Number 
of Times Held or 
Deferred drop-down 
boxes is > 0 then this 
record is included if the 
criteria in the calculation 
column are met. The 
value displayed in the 
Number of Times Held 
or Deferred column is the 
value contained in the 
associated 
MediaInteraction field.

Contact
RoutingEvent

If Selected Channels includes Voice then
RoutingEvent.HoldCount meets the input 
criterion, and Contact.VDUID = 
RoutingEvent.Contact_Key

If Selected Channels includes Email then
RoutingEvent.DeferCount meets the input 
criterion, and Contact.VDUID = 
RoutingEvent.Contact_Key

If Selected Channels includes Text Chat then
RoutingEvent.Web_Defer_Count meets the 
input criterion, and Contact.VDUID = 
RoutingEvent.Contact_Key

If the user selects more than one channel then 
these criteria are "OR'd" together.

Report Column Database table Calculation
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The data used to determine the content of the report heading are:

Segment Information Detail

The data used to populate the Channel and Agent drop-down boxes on the input page are 
determined as follows:

The OA database items used to determine the content of the Segment Information report 
elements are

Heading Item Database 
Table

Calculation

Number of Work Items 
Found

N/A The number of rows that make up the report

Average Time in System N/A Average of values in the Time in System column

Average Number of 
Times Handled

NA Average of values in the Number of Times Handled 
column

Average Number of 
Times Held or Deferred

N/A Average of values in the Number of Times Held or 
Deferred column

Input 
Element

Database Table Database Item or Calculation

Channel N/A The following items:
● Voice
● Email
● Text Chat

Agent Employee
GroupMember
WorkGroup
Channel

Display Employee.FullName (Employee.LoginName) where 
Employee.Pkey = Channel.Employee_Key and 
GroupMember.EmployeeGroup = Employee.PKey and 
GroupMember.WorkgroupGroup = Workgroup.Pkey for one of 
the selected workgroups

Report element Database table Database item or calculation

Work Item ID Contact VDUID

Start Time N/A start time of first segment
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Agent RoutingEvent
AgentSegment
Employee

CmsCallHistory
CmsAgentInfo

For QRepository records:
If there is a record in AgentSegment where 
AgentSegment.Segment_Key = 
RoutingEvent.UUID then

Employee.FullName where 
Employee.Pkey = 
AgentSegment.Employee_Key, and 
AgentSegment.ParticipationRole = 0, 
and AgentSegment.Segment_Key = 
RoutingEvent.UUID

else

<blank>

For Call History records:
If CmsCallHistory.AnsLogin = <blank>

<blank>

else

CmsAgentInfo.LogName 
whereCmsCallHistory.AnsLogin = 
CmsAgentInfo.LogID and 
CmsCallHistory.SourceID = 
CmsAgentInfo.SourceID

Queue or Skill RoutingEvent
Queue

CmsCallHistory
CmsSkillInfo

For QRepository records:
Queue.QueueName where 
RoutingEvent.Queue_Key = Queue.PKey

For Call History records:
if CmsCallHistory.DispSplit = -1 then

<blank>

else

CmsSkillInfo.SplitName where 
CmsCallHistory.DispSplit = 
CmsSkillInfo.Split and 
CmsCallHistory.SourceID = 
CmsSkillInfo.SourceID

Report element Database table Database item or calculation
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From Media Interaction

CmsCallHistory

For QRepository records:
If MediaInteraction.Type = 2 (that is, voice) 
then display MediaInteraction.ANI

If MediaInteraction.Type = 0 (that is, email) 
then display MediaInteraction.Sender

If MediaInteraction.Type = 1 (that is, chat) 
then display MediaInteraction.UserName

For CallHistory records:
if CmsCallHistory.Calling_Pty != NULL then 

display CmsCallHistory.Calling_Pty

else

display <blank>

To Media Interaction

CmsCallHistory

For QRepository records:
If MediaInteraction.Type = 2 (that is, voice) 
then display MediaInteraction.DNIS

If MediaInteraction.Type = 0 (that is, email) 
then display MediaInteraction.Recipient

If MediaInteraction.Type = 1 (that is, chat) 
then display <Blank>

For CallHistory records:
if CmsCallHistory.FirstVdn != NULL then 

display CmsCallHistory.FirstVdn

else

display <blank>

Report element Database table Database item or calculation
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Channel MediaInteraction For QRepository records:
If MediaInteraction.Type = 2 (that is, voice) 
then display "Voice"

If MediaInteraction.Type = 0 (that is, email) 
then display "Email"

If MediaInteraction.Type = 1 (that is, chat) 
then display "Text Chat"

For CallHistory records:
"Voice"

Duration RoutingEvent

CmsCallHistory

For QRepository records:
If MediaInteraction.Type = 2 (that is, voice)

RoutingEvent.voicetalktime + 
RoutingEvent.voiceholdtime + 
RoutingEvent.WrapTime

If MediaInteraction.Type = 0 (that is, email)

RoutingEvent.emailwritetime + 
RoutingEvent.emailinacttime + 
RoutingEvent.defertime

If MediaInteraction.Type = 1 (that is, chat)

RoutingEvent.chattalktime + 
RoutingEvent.chatholdtime + 
RoutingEvent.WrapTime 

For Call History records:
CmsCallHistory.AcwTime + 
CmsCallHistory.TalkTime

Report element Database table Database item or calculation
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Wrap-up Codes Detail

The data used to populate the Channel and Agent drop-down boxes on the input page are 
determined as follows:

The OA database items used to determine the content of the Wrap-up Codes report 
elements are:

Input 
Element

Database Table Database Item or Calculation

Channel N/A The following items:
● Voice
● Email
● Text Chat

Agent Employee
GroupMember
WorkGroup
Channel

Display Employee.FullName (Employee.LoginName) where 
Employee.Pkey = Channel.Employee_Key and 
GroupMember.EmployeeGroup = Employee.PKey and 
GroupMember.WorkgroupGroup = Workgroup.Pkey for one of 
the selected workgroups

Report element Database table Database item or calculation

Work Item ID N/A From Work Item ID element of the Segment report.

Agent N/A From the Agent column of this segment of the 
Segment report.

Duration N/A From the Duration column of this segment of the 
Segment report.
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<category codes> Contact
RoutingEvent
TaskPerformed
TaskPerformedCode
ClassificationCode

If reached from the Segment Information report:
Display ClassificationCode.Name where 

TaskPerformed.RoutingEvent_Key = 
RoutingEvent.UUID and 
TaskPerformed.Pkey = 
TaskPerformedCode.TaskPerformed_Key 
and ClassificationCode.Pkey = 
TaskPerformedCode.Code_Key and 
ClassificationCode.CodeType = 1 (that is, 
Category Code)

If reached from the Work Item Detail report:
Display ClassificationCode.Name where:

RoutingEvent.Contact_Key = Contact.VDUID 
and TaskPerformed.RoutingEvent_Key = 
RoutingEvent.UUID and 
TaskPerformed.Pkey = 
TaskPerformedCode.TaskPerformed_Key 
and ClassificationCode.Pkey = 
TaskPerformedCode.Code_Key and 
ClassificationCode.CodeType = 1 (that is, 
Category Code)

Report element Database table Database item or calculation
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<reason codes> Contact
RoutingEvent
TaskPerformed
TaskPerformedCode
ClassificationCode

If reached from the Segment Information report:
Display ClassificationCode.Name where 

TaskPerformed.RoutingEvent_Key = 
RoutingEvent.UUID and 
TaskPerformed.Pkey = 
TaskPerformedCode.TaskPerformed_Key 
and ClassificationCode.Pkey = 
TaskPerformedCode.Code_Key and 
ClassificationCode.CodeType = 3 (that is, 
Reason Code)

If reached from the Work Item Detail report:
Display ClassificationCode.Name where:

RoutingEvent.Contact_Key = Contact.VDUID 
and TaskPerformed.RoutingEvent_Key = 
RoutingEvent.UUID and 
TaskPerformed.Pkey = 
TaskPerformedCode.TaskPerformed_Key 
and ClassificationCode.Pkey = 
TaskPerformedCode.Code_Key and 
ClassificationCode.CodeType = 3 (that is, 
Reason Code)

Report element Database table Database item or calculation
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CMS Call Detail

The data used to populate the Data Source drop-down list are:

<outcome codes> Contact
RoutingEvent
TaskPerformed
TaskPerformedCode
ClassificationCode

If reached from the Segment Information report:
Display ClassificationCode.Name where 

TaskPerformed.RoutingEvent_Key = 
RoutingEvent.UUID and 
TaskPerformed.Pkey = 
TaskPerformedCode.TaskPerformed_Key 
and ClassificationCode.Pkey = 
TaskPerformedCode.Code_Key and 
ClassificationCode.CodeType = 2 (that is, 
Outcome Code)

If reached from the Work Item Detail report:
Display ClassificationCode.Name where:

RoutingEvent.Contact_Key = Contact.VDUID 
and TaskPerformed.RoutingEvent_Key = 
RoutingEvent.UUID and 
TaskPerformed.Pkey = 
TaskPerformedCode.TaskPerformed_Key 
and ClassificationCode.Pkey = 
TaskPerformedCode.Code_Key and 
ClassificationCode.CodeType = 2 (that is, 
Outcome Code)

Report element Database table Database item or calculation

Input Screen 
Element

Database Tables Database Item or Calculation

Data Sources Subsystem
Source

Subsystem.Name
where:
Subsystem.ID = Source.SubsystemID and 
Source.SourceType = 100 (ACD)
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The data used to populate the Skills, VDNs, Agents, and Call Work Codes drop-down lists 
are:

The database items used to determine the records that comprise the report and the 
content of the report columns are:

Input Screen 
Element

Database Tables Database Item or Calculation

Skills CmsSkillInfo SplitName (<Data Source Name>)

VDNs CmsVdnInfo VdnName (<Data Source Name>)

Agents CmsAgentInfo LogName (LogID)

Call Work Codes CmsCscInfo CscName (<Data Source Name>)

Report Column Database Tables Calculation1

The value displayed in the 
"Date" column is the value 
contained in the associated 
CmsCallHistory field.

CmsCallHistory If CmsCallHistory.SegStart of the first 
segment is within the date range selected 
in the "Date Range" portion of the input 
page
Then displayCmsCallHistory.SegStart

If the To input box is populated 
then this record is included if 
the criteria in the calculation 
column are met.

CmsCallHistory matches all or part of 
CmsCallHistory.FirstVdn for segment 1 of 
the call
if CmsCallHistory.FirstVdn != NULL then 
display CmsCallHistory.FirstVdn
else display <blank>

If the From input box is 
populated then this record is 
included if the criteria in the 
calculation column are met.

CmsCallHistory matches all or part of 
CmsCallHistory.Calling_Pty for segment 1 
of the call
if CmsCallHistory.Calling_Pty != NULL 
then display CmsCallHistory.Calling_Pty
else display <blank>

If the one or more values in the 
Skills pull-down are selected 
then this record is included if 
the criteria in the calculation 
column are met.

CmsCallHistory
CmsSkillInfo

matches CmsCallHistory.DispSplit

If the one or more values in the 
VDNs pull-down are selected 
then this record is included if 
the criteria in the calculation 
column are met.

CmsCallHistory
CmsVdnInfo

matches CmsCallHistory.DispVdn
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The database items used to determine the content of the report heading are:

Segment Information for CMS Call Detail

The database items used to determine the content of the report heading are:

If one or more values in the 
Agent pull-down are selected 
then this record is included if 
the criteria in the calculation 
column are met.

CmsCallHistory
CmsAgentInfo

matches CmsCallHistory.AnsLogin

If one or more values in the 
Call Work Codes pull-down 
are selected then this record is 
included if the criteria in the 
calculation column are met.

CmsCallHistory
CmsCwcInfo

matches CmsCallHistory.Cwc1 or 
CmsCallHistory.Cwc2 or 
CmsCallHistory.Cwc3 or 
CmsCallHistory.Cwc4 or 
CmsCallHistory.Cwc5 or 
CmsCallHistory.LastCwc

1. A call is included if the criteria in the calculation column are met.

Report Column Database Tables Calculation1

Heading Item Database Tables Calculation

Number of Work 
Items Found

N/A The number of rows that make up the report

Report Element Database Tables Database Item or Calculation

Skill N/A Same as Call Detail report heading

VDN N/A Same as Call Detail report heading

Agent N/A Same as Call Detail report heading

Call Work Code N/A Same as Call Detail report heading

Data Source N/A Same as Call Detail report heading

Total Wait Time N/A Total of values in the Wait Time column

Total Number of 
Times Held

N/A Total of values in the Times Held column
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The database items used to determine the content of the report elements are:

Report Element Database Tables Database Item or Calculation

Call ID CmsCallHistory CallID

Start Time CmsCallHistory CmsCallHistory.SegStart of first segment

Agent CmsCallHistory
CmsAgentInfo

If CmsCallHistory.AnsLogin = <blank> <blank>
else
CmsAgentInfo.LogName where 
CmsCallHistory.AnsLogin = CmsAgentInfo.LogID and 
CmsCallHistory.SourceID = CmsAgentInfo.SourceID

Skill CmsCallHistory
CmsSkillInfo

If CmsCallHistory.DispSplit = Null then <blank>
else
CmsSkillInfo.SplitName where CmsCallHistory.DispSplit 
= CmsSkillInfo.Split and CmsCallHistory.SourceID = 
CmsSkillInfo.SourceID

VDN CmsCallHistory
CmsVdnInfo

If CmsCallHistory.DispVdn = <blank> then <blank>
else
CmsVdnInfo.VdnName where CmsCallHistory.DispVdn 
= CmsVdnInfo.Vdn and CmsCallHistory.SourceID = 
CmsVdnInfo.SourceID

Wait Time CmsCallHistory CmsCallHistory.DispTime

Times Held CmsCallHistory CmsCallHistory.Held

Hold Time CmsCallHistory CmsCallHistory.AnsHoldTime

Talk Time CmsCallHistory CmsCallHistory.TalkTime

ACW Time CmsCallHistory CmsCallHistory.AcwTime

Duration CmsCallHistory CmsCallHistory.AcwTime + CmsCallHistory.TalkTime
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Call Work Codes Detail

The database items used to determine the content of the report heading are:

The database items used to determine the content of the report elements are:

Disposition CmsCallHistory CmsCallHistory.Disposition where the value displayed a 
string based on the value of this field according to the 
following mapping:
1 - Connected
2 - Answered
3 - Abandoned
4 - Interflowed
5 - Forced Busy
6 - Forced Disconnect
7 - Other

Data Source CmsCallHistory
Subsystem
Source

Subsystem.Name
where:
Subsystem.ID = CmsCallHistory.SourceID and 
Source.SourceType = 100 (ACD)

Report Element Database Tables Database Item or Calculation

Report Element Database Tables Database Item or Calculation

Skill N/A Same as Call Detail report heading

VDN N/A Same as Call Detail report heading

Agent N/A Same as Call Detail report heading

Call Work Code N/A Same as Call Detail report heading

Data Source N/A Same as Call Detail report heading

Report Element Database 
Tables

Database Item or Calculation

Call ID CmsCallHistory CallID

Agent CmsCallHistory
CmsAgentInfo

If CmsCallHistory.AnsLogin = <blank> <blank>
else
CmsAgentInfo.LogName where 
CmsCallHistory.AnsLogin = CmsAgentInfo.LogID 
and CmsCallHistory.SourceID = 
CmsAgentInfo.SourceID
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Skill CmsCallHistory
CmsSkillInfo

If CmsCallHistory.DispSplit = Null then <blank>
else
CmsSkillInfo.SplitName where 
CmsCallHistory.DispSplit = CmsSkillInfo.Split and 
CmsCallHistory.SourceID = CmsSkillInfo.SourceID

VDN CmsCallHistory
CmsVdnInfo

If CmsCallHistory.DispVdn = <blank> then <blank>
else
CmsVdnInfo.VdnName where 
CmsCallHistory.DispVdn = CmsVdnInfo.Vdn and 
CmsCallHistory.SourceID = CmsVdnInfo.SourceID

Duration CmsCallHistory CmsCallHistory.AcwTime + 
CmsCallHistory.TalkTime

<first call work code> display 
line only if 
CmsCallHistory.Cwc1 != Null

CmsCallHistory display: CmsCwcInfo.CwcName
where
CmsCallHistory.Cwc1 = CmsCwcInfo.Cwc and 
CmsCallHistory.SourceID = CmsVdnInfo.SourceID

<second call work code> 
display line only if 
CmsCallHistory.Cwc2 != Null

CmsCallHistory display: CmsCwcInfo.CwcName
where
CmsCallHistory.Cwc2 = CmsCwcInfo.Cwc and 
CmsCallHistory.SourceID = CmsVdnInfo.SourceID

<third call work code> 
display line only if 
CmsCallHistory.Cwc3 != Null

CmsCallHistory display: CmsCwcInfo.CwcName
where
CmsCallHistory.Cwc3 = CmsCwcInfo.Cwc and 
CmsCallHistory.SourceID = CmsVdnInfo.SourceID

<fourth call work code> 
display line only if 
CmsCallHistory.Cwc4 != Null

CmsCallHistory display: CmsCwcInfo.CwcName
where
CmsCallHistory.Cwc4 = CmsCwcInfo.Cwc and 
CmsCallHistory.SourceID = CmsVdnInfo.SourceID

<fifth call work code> display 
line only if 
CmsCallHistory.Cwc5 != Null

CmsCallHistory display: CmsCwcInfo.CwcName
where
CmsCallHistory.Cwc5 = CmsCwcInfo.Cwc and 
CmsCallHistory.SourceID = CmsVdnInfo.SourceID

<last call work code> display 
line only if 
CmsCallHistory.LastCwc != 
Null

CmsCallHistory display: CmsCwcInfo.CwcName
where
CmsCallHistory.LastCwc = CmsCwcInfo.Cwc and 
CmsCallHistory.SourceID = CmsVdnInfo.SourceID

Report Element Database 
Tables

Database Item or Calculation
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Glossary

Administration screen Screen on the right side of the OA Client interface that contains information 
about configuration settings which are selected in the navigation tree.

ADU Agent data unit

Agent A customer service representative (CSR). An agent is a person qualified to 
handle customer requests. He or she may deal with customers directly or just 
process customer requests.

Aggregated data Data that OA has aggregated or summarized. Aggregated data has the 
minimum value (least), maximum value (greatest), sum, or a combination of 
those values, for each data period. Each column in the schema can be set to 
a different aggregation behavior, as long as it contains numeric data.
Aggregation occurs at an offset after the end of each base interval. The 
default offset is 10 minutes, but the offset can be set from 10 to 25 minutes 
by modifying the system scheduled aggregation job.

Aggregation OA aggregates or summarizes data by selecting the minimum value (least), 
maximum value (greatest), or sum of a numerical measure for a particular 
data period. A data period involves one base interval. 

Aggregation job Job that aggregates data. An aggregation job summarizes data by selecting 
the minimum value (least), maximum value (greatest), sum of each data 
period, or a combination of those options. 
A system scheduled aggregation job runs at an offset after the end of a base 
interval. The default offset is 10 minutes, but the offset can be set from 10 to 
25 minutes by modifying the system scheduled aggregation job. This job 
aggregates data for that interval only.
An on-demand aggregation job can aggregate data for multiple intervals, up 
to 24 hours of data.

Aggregation recovery 
job

Job that re-aggregates and archives container data that was not successfully 
aggregated in the past 30 hours. If enabled, the aggregation recovery job 
runs every six hours and aggregate data that was not successfully 
aggregated in previous attempts.

Analytical license key The Avaya OA license key that is used for Avaya OA, Avaya IC, and 
Advanced Reporting installations.
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API Application Program Interface. An API is a set of routines that allows an 
application program to gain access to the operating system or application 
program. A developer who wants to build a program that makes requests to 
the operating system or application must use the prescribed method.

Archive The act of compressing and summarizing aggregated data into the historical 
database. While aggregation occurs every base interval, archiving occurs on 
a daily, weekly or monthly basis, with the frequency determined by your 
configuration in the Container Archives administration screen.

Archived data Aggregated data that has been stored in the historical database. The data is 
categorized into daily, weekly and monthly archives.

back-end database A database that is located on a different server than the database software.

Base interval OA lumps IC real-time data into 30-minute intervals in the Historical 
subsystem.
Also called intervals.
See also base interval data.

Base interval data Real-time data that OA has lumped into 30-minute intervals. The Real-time 
subsystem summarizes IC data into 30-minute intervals and transfers it to 
the Historical subsystem, which proceeds to aggregate the base interval data 
into containers.

CMS Standalone 
license key

The Avaya OA license key that is used for Avaya OA and CMS installations.

Container Metadata that defines how data should be sifted and stored in the historical 
database. The term "container" encompasses both the table definition as 
well as the data contained in the table.

Container aggregation 
job

Scheduled job that aggregates selected containers. You specify the 
aggregation period and select the containers in the Scheduled Jobs 
administration screen.

Container data purge 
job

Scheduled job that purge aggregated and archived data. You specify which 
data in the containers and archives to delete in the Scheduled Jobs 
administration screen.

Container filter Container definitions that you customize. A filter determines which fields of 
the base interval data are aggregated into a container. It specifies the name, 
data fields and default values for each container.
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Container limit Limit or constraint that you set on your containers. This enhances data 
calculation performance and disk usage. You can configure the maximum 
number of containers and rules in the Container Archives administration 
screen.

Container profile Includes the definition and the name of a container. Container profiles 
contain rules that detail what fields a container should have and what sort of 
data it should collect. Each container has a profile which has a filter that may 
contain from one to 100 rules.

Container rule Defines which rows of data in the historical store should be collected. Each 
container has a profile and a profile may have from one to 100 rules.
Also called filter rules or rules. 

Coordinated Universal 
TIme

Coordinated Universal Time (UTC). Formerly called Greenwich Mean Time 
(GMT). UTC reflects the time in the prime meridian and uses a 24-hour 
format. For example, it uses 14:00 to represent 2:00 p.m.
OA stores data in UTC but converts the time to the local time of the client.

CORBA Common Object Request Broker Architecture. CORBA is a way to create 
and manage distributed program objects in a network. It lets programs 
developed by different vendors or programs scattered throughout different 
servers communicate. A program in a client can request services from a 
program in a server without having to understand where the server is in a 
distributed network or what the interface to the server program is.

Current schema The existing schema that is being used. The current schema is the 
pre-migration schema. 

Daemon A program that runs continuously in the background and handles periodic 
service requests. The daemon forwards the requests to other programs or 
processes them as appropriate. 

Daily interval A 24-hour shift that OA uses for real-time statistical reporting.

Data dictionary A database about data and databases. The data dictionary holds the name, 
type, range of values, source, and authorization for access for each data 
element in the contact center's files and databases.

Data manager An interface service that resides on a server where a Real-time subsystem is 
installed. The data manager receives events, maintains real-time status 
information, summarizes data into fixed thirty-minute intervals, and forwards 
the data to the forwarders, a set of Real-time subsystem services.
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Data type Category of data. Each type is a set of data with values that have predefined 
characteristics and has a specified range of values and a specific way of 
being processed by the computer and stored by the database. 

Database check job A job that inspects the overall state of the historical database. A database 
check job fine-tunes the database by scanning the database and its error 
logs, as well as updating the statistics on tables. It also reports inconsistent 
metadata and rolls over the error log file to prevent it from growing 
unbounded. It runs daily if enabled.

Default schema Schema that is pre-configured in OA. You can revert back to the 
pre-configured default schema if you decide to discard your changes. You 
need to migrate your data, however.

Detail data Historical data that cannot be aggregated.
Detail data contains information about the work item, such as the customer 
ID, work item ID and the origination.

Detail data purge job Scheduled job that purges selected detail data. You select which detail data 
to purge in the Scheduled Jobs administration screen.

Disabled container Container that is not collecting or aggregating data.

Disabled interface 
service

Data collection service that is not running.

Disabled job A job that has been configured but is not activated to run.

Display name A meaningful name associated with a value in the database. For example, 
instead of displaying the agent ID, OA Administration Client displays the 
agent name; so it will display "John Smith" instead of "1021454540554."

EDU Electronic Data Unit

Enabled container Container that is collecting or aggregating data. 

Enabled interface 
service

Data collection service that is running.

Enabled job A job that will execute at scheduled times. See also disabled job.

Event An activity or change of state that occurs in a contact center. Examples 
include: a change in port state, an agent logging in, or a call transfer.
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Execution frequency See recurrence.

External job Custom-designed instruction set that specifies when certain processes 
should be executed. You can add an external job, whose scripts reside in the 
historical server, into OA Administration Client and schedule its execution.

Failed Data collection status that indicates database errors.

Filter See container filter.

Filter rule See container rule.

Flat file An independent data file that is not related to another file. Flat files can be 
related to other data files, but only if you program them to do so.

Forwarder An interface service that resides on CMS or Real-time subsystems. The 
forwarder transfers the data it receives to its corresponding recorder. When 
the recorder is not available, the forwarder buffers the detailed data until the 
recorder is on-line again.

FQDN Fully-qualified domain name

GMT Greenwich Mean Time. Also known as UTC (Coordinated Universal Time). 
GMT reflects the time in the prime meridian and uses a 24-hour format. For 
example, it uses 14:00 to represent 2:00 p.m.
OA stores data in UTC but converts the time to the local time of the client.

historical database Where all historical data about your contact center is stored.

historical server The server where the Historical subsystem is installed.
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Historical store Storage location where historical or long-term contact center performance 
information is stored in a database. Each historical store consists of a 
database table or a group of database tables. OA has 11 stores that 
accumulate a variety of report-related data from IC or ACD systems.
The IC historical stores are: 

● Agent service class

● Agent state

● Service class summary

● Service class state

● Display names

The ACD historical stores are:

● CMS agent summary

● CMS call work codes

● CMS skill summary

● CMS VDN summary

● CMS call history

● CMS display names

Historical subsystem Along with the source subsystem, Real-time subsystem, Report subsystem, 
and CMS subsystem, the Historical subsystem constitutes the OA data 
collection system. The Historical subsystem pertains to all OA components 
and services that involve historical data.

IC Avaya � Interaction Center.

IDL See Interface Definition language.

Incomplete Data collection status that indicates there is missing data and the container 
or archive is missing at least one base interval data.

Info store Historical store with a group of database tables that keeps track of the 
display names for the data fields.

Interface definition 
language

A language used to communicate with various software components in a 
CORBA network.
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Interface service Process that automatically collects data in the background while the system 
is up. An interface service handles periodic service requests and forwards 
the requests to other programs or processes as appropriate. The OA 
interface services include:

● Data manager

● Report data server

● Report Subsystem

● The respective forwarders and recorders for each historical store.

Interface service name The internal name that OA Administration client uses to identify, enable and 
disable the services. You cannot change the names of the services. 

Interval data See base interval data.

Java database 
connectivity

Java Database Connectivity. An application program interface (API) 
specification for connecting Java programs to a database. The API lets you 
request statements in Structured Query Language (SQL) which are then sent 
to the program that manages the database.

JDBC See Java database connectivity.

Job Instruction set that specifies when certain processes should be executed. 
The Scheduled Jobs administration screen enables you to automate certain 
tasks such as data purges and aggregation.

Migration The process by which OA alters the database tables to conform to a new 
schema.

MSMQ Microsoft Message Queue. MSMQ is a software program that allows 
programs to send messages to other programs.

Navigation tree Tree that appears on the left side of your OA Administration client interface, 
and contains various configuration tools for customizing and managing data 
collection.

No data Data collection status that indicates no data exists. OA did not find matching 
records. 

Not null Clause in a column or field that specifies that the column or field cannot 
contain a null value. You must define a default value.
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Null Special value in the database which represents an unknown value. A null 
value is not the same as blank (which is a valid character), zero (which is a 
valid number), or a zero length string.

On-demand job A job you define to execute tasks on specific data at a particular time or 
recurrence. An on-demand job is different from a system scheduled job in 
that it is limited in scope and applies to selected data. On-demand job types 
include:

● Aggregation

● Container purge

● Detail purge

● Data collection

● External

Operational license 
key

The Avaya OA license key that is used for Avaya OA and Avaya IC 
installations.

ORB Object Request Broker. ORB is the programming code in CORBA that 
mediates between a client and a distributed object. It enables clients to 
request services without having to know the location of the server in a 
network.

Parameter A piece of information, such as a file name, a coordinate, or a range of 
values, that is passed to a program by a user or another program.

Pending schema A custom-defined schema that is not implemented until migration.

PID See Process ID.

Precision Specifies the maximum total number of decimal digits that can be stored, 
both to the left and to the right of the decimal point. The precision must be a 
value from 1 to 15.

Process ID Identification number for a container delete job. You can determine the PID of 
a deleted container by looking at the Container Status screen.

Purge The deletion of selected container data or detail data.

Purge job A job that deletes selected containers and detail data from the historical 
database. A purge job is different from a system-scheduled purge job in that 
it is more focused and deletes only particular pieces of data you specify in 
the Scheduled Jobs administration screen.
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RAID Redundant Array of Inexpensive Disks

Real-time subsystem Along with the source subsystem, Historical subsystem, Report subsystem, 
and CMS subsystem, the Real-time subsystem constitutes the OA data 
collection system. The Real-time subsystem pertains to all OA components 
and services that involve real-time data.

Recorder An interface service that resides in the Historical subsystem. The recorder 
time stamps the data it receives from the forwarder and inserts the data into 
the historical database.
There are up to 11 recorders, one for each historical store. 

Recurrence The start date and end date of a job, or the number of times a job should be 
executed. For example, you can schedule a job to execute on April 3, 2002 
or once a week. Recurrence is part of the job definition.

Report subsystem The self-contained OA reporting subsystem application programming 
interface (API) that provides an environment to create reports based on the 
OA real-time data. It is a subsystem that lets you develop servlet-based 
applications for Web-based reporting and monitoring for your contact center.

Retention period The length of time OA retains data.

Rule See container rule.

Scale Specifies the maximum number of decimal digits that can be stored to the 
right of the decimal point. Scale must be a value from 0 through precision. 
Maximum storage sizes vary, based on the precision.

Schema Defines aspects of the database, such as attributes (fields) and domains and 
parameters of the attributes.

Select To select an item, click the item's name or icon. Selected items appear 
highlighted on the screen.

Service See interface service.

Service class A logical category used to measure service levels and define goals for that 
work. A particular service class can consist of any combination of interaction 
source (such as call, fax, or email), customer class (such as Platinum, Gold, 
or Silver), or activity (such as new loan or account inquiry). 

Source subsystem OA subsystem that collects all ACD and IC event data.
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SQL See Structured Query Language.

Status window Window on the results screen that lets you view the status of elements such 
as your schemas or interface services that you have set up.

Store See historical store.

String A data type contained in the column of the table which is composed of a 
sequence of characters usually representing human-readable text. The 
column must be a contiguous set of alphanumeric characters that does not 
contain numbers used for calculations. Names, addresses and error 
messages are examples of strings.

Structured Query 
Language

Structured Query Language. The standard programming language for getting 
information from and updating a database. Queries let you select, insert, 
update, find out the location of data, etc.

Subsystem A major component that constitutes the OA data collection system. The 
available subsystems are:

● Historical 

● Real-time

● Report

● CMS

● Source (ACD and IC)

Summary data Data that pertains to the performance of the contact center. While detail data 
tracks work items, summary data tracks agents and IVR systems. Summary 
data is also aggregated and, if configured, stored in containers and archives.
These historical stores contain summary data:

● Agent service class

● Agent state

● Service class summary

● Service class state

● CMS agent summary

● CMS call work codes

● CMS skill summary

● CMS VDN summary
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Summary historical 
store

A historical store that contains aggregated data. Available summary 
historical stores are:

● Agent service class

● Agent state

● Service class summary

● Service class state

● CMS agent summary

● CMS call work codes

● CMS skill summary

● CMS VDN summary

Sun ONE Web Server The new product name for the Solaris Web server, formerly iPlanet.

System scheduled 
aggregation job

A job that aggregates base interval data. This job executes on every base 
interval, that is, in 30-minute increments, if enabled.

System scheduled job A job that is executed on a system-wide level. This job applies to all the 
containers and data in the system. The following types of jobs are system 
scheduled jobs: aggregation, aggregation recovery, ACD display name 
collection, database check and database purge.
See also on-demand jobs.

System scheduled 
purge job

A job that deletes container and detail data from the historical database 
according to the data retention limits defined in the Retention Periods 
administration screen. A system-scheduled purge job is different from 
on-demand purge jobs in that it executes on the entire system and not just on 
a particular set of data, and it runs regularly, not periodically. This executes 
daily, if enabled.

Tree A way of structuring information, where sublevels are shown as branches of 
a higher level. The navigation tree in OA Administration client contains a tree 
of configuration tools. Items on a tree are also referred to as nodes.

Unicode A character set that can accommodate the alphabet of most of the world's 
languages. Unicode can handle 65,536 character combinations rather than 
just 256, and uses two bytes for each character rather than one.

UTC Coordinated Universal Time. Formerly called Greenwich Mean Time (GMT). 
UTC reflects the time in the prime meridian and uses a 24-hour format. For 
example, it uses 14:00 to represent 2:00 p.m.
OA stores data in UTC but converts the time to the local time of the client.
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Widget A graphical user interface element that lets you interact with the application. 
Examples of widgets include drop-down lists, buttons, text boxes, and radio 
buttons.

Work item Data that describes the flow of work through a business process. This data 
may include details about the agents involved with the work, the amount of 
time the item spent in various queues, and any followup calls.

Workflow The flow of work in a business process; work travels from one point to 
another so that necessary tasks can be completed on that piece of work.
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